
'About Turnpike' display

This display gives brief details about the version of the Turnpike program you are using - in particular, the 
version number, the date of issue and whether your copy has been registered.

It is called up by taking the About Turnpike option from the Help menu.



/^(tom|dick|harry)@/a
Tells Turnpike to check the From: line to see whether the message/article was from tom, dick
or harry

! Tells Turnpike to record a match when this isn't the case



/ Starts the pattern
@anycompany\.com

Tells Turnpike to look for @anycompany.com within the section it is searching (\. is written in
place of . because . on its own has special meaning)

$ Tells Turnpike that the section it's searching should end after the m of .com
/ Marks the end of the pattern
a Tells Turnpike to only search the author's address, as extracted from the From line



/ Starts the pattern
^Newsgroups:

Tells Turnpike to look for a line starting Newsgroups:
.*, Tells Turnpike to then look for an unspecified number of characters (the . stands for any 

character, the * stands for any number of these) followed by a comma (the character used to 
separate the names of the newsgroups to which an article is posted)

/ Marks the end of the pattern
h Tells Turnpike to search every line of the header

To kill cross-posted articles to n newsgroups, repeat the pattern        *,.        n-1 times. e.g.
/^Newsgroups:.*,.*,.*,/h

will kill articles cross-posted to four or more newsgroups.Be aware that if an article is cross-posted to 
newsgroups to which you subscribe, the rule will only be effective if it is has been set in all of the 
newsgroups concerned.



/ Starts the pattern
^Date: Tells Turnpike to look for a line starting Date:
\s* Tells Turnpike that this may be followed by any number of spaces or tabs
Fri, Tells Turnpike to then look for Fri,
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/ Starts the pattern
^Lines:Tells Turnpike to look for a line starting Lines:
\s* Tells Turnpike that this may be followed by any number of spaces (or tabs)
[0-5]?\d

Tells Turnpike to then look for either a single digit number in the range 0 to 9 (signified by \d) 
or a two digit number in the range 00 to 59 ([0-5}\d or [0-5][0-9] would mean a digit in the 
range 0 to 5 followed by a digit in the range 0 to 9 ie. 00 to 59; the ? after the [0-5] says that 
the first digit doesn't have to be there)

$ Tells Turnpike that there should be nothing after the 'second' digit
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/^References:
Tells Turnpike that (for a match) the line should start References:

\s*< Tells Turnpike that References: should be followed by an unspecified number of either 
spaces or tabs, then a <

[^<]*@anycompany\.com>
Tells Turnpike that this < should be followed an unspecified number of characters other than 
<, then @anycompany.com>

/h Tells Turnpike to search the whole of the header for this line



/ Starts the pattern
[A-Z][A-Z]

Tells Turnpike to look for any character in the range Capital A to Capital Z (ie. any capital 
letter), followed immediately by another capital letter - on the assumption that finding two 
capitals together probably means that everything is in capitals.

/ Marks the end of the pattern
c Tells Turnpike that the case of the letters matters

Note: Because c is the only modifier in the rule, Turnpike assumes 's' and so only searches the Subject 
line (after any Re:)



/ Starts the pattern
^Sender

Tells Turnpike to look for a line which starts Sender
[ \t]*:[ \t]*

Tells Turnpike that the word Sender may be followed by a number of either spaces (indicated 
by the space in the square brackets) or tabs (indicated by the \t) then a :, then possibly some 
more spaces or tabs (the * means 'any number of the preceding characters')

local.part@domain
Tells Turnpike that this should be followed by local.part@domain

/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/ Starts the pattern
^X-Mailer:

Tells Turnpike to look for a line starting X-Mailer:
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/ Starts the pattern
^X-Newsreader:

Tells Turnpike to look for a line starting X-Newsreader:
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/@anycompany\.com$/a
Tells Turnpike to check the From: line to see whether the message was written by anyone at 
anycompany.com

!/urgent/s
Tells Turnpike to check that the Subject: line doesn't contain the word urgent (! stands for 
'Not')

& Tells Turnpike to only record a match when both of the above are true



/@anycompany\.com$/a
Tells Turnpike to check the From: line to see whether the article was written by anyone at 
anycompany.com

!/widget/s
Tells Turnpike to check that the Subject: line doesn't contain the word widget (! stands for 
'Not')

& Tells Turnpike to only record a match when both of the above are true



/ Starts the pattern
^ Tells Turnpike that the match needs to be at the start of the section it searches
fred Tells Turnpike to look for fred
$ Tells Turnpike that the section should end immediately after the d of fred
/ Marks the end of the pattern

Note: In the absence of any modifier, Turnpike assumes u and just searches the username given in the 
Forwards Path taken from the SMTP envelope RCPT TO: line (or equivalent).



/ Starts the pattern
^ Tells Turnpike that the match needs to start from the beginning of the section it searches
fred@anycompany\.com

Tells Turnpike to look for fred@anycompany.com (\. is written in place of . because . on its 
own has special meaning)

$ Tells Turnpike that the section it's searching should end after the m of .com
/ Marks the end of the pattern
a Tells Turnpike to only search the author's address, as extracted from the From line



/ Starts the pattern
[<:] Tells Turnpike to start by looking for a < or a :
local.part@domain>

Tells Turnpike that the < or : should be followed by local.part@domain>
$ Tells Turnpike that the section it's searching should end after the >
/ Marks the end of the pattern
f Tells Turnpike to only search the SMTP envelope MAIL FROM:



/ Starts the pattern
^ Tells Turnpike that the match needs to be at the start of the section it searches
(tom|dick|harry)

Tells Turnpike to look for tom or dick or harry 
@ Tells Turnpike that the tom, dick or harry it finds should be immediately followed by an @ 
/ Marks the end of the pattern 
a Tells Turnpike to only search the author's address, as extracted from the From line



/ Starts the pattern
urgent Tells Turnpike to look for the urgent within the section it is searching
/ Marks the end of the pattern
s Tells Turnpike to only search the Subject line, starting after any Re:



/ Starts the pattern
widget Tells Turnpike to look for widget within the section it is searching
/ Marks the end of the pattern
s Tells Turnpike to only search the Subject line, starting after any Re:



Abbreviations

The following abbreviations are frequently used in mail messages and news articles:
(see also Smileys and Conventions)

AFAICS As far as I can see
AFAIK As far as I know
AFAIR As far as I recall
AIUI As I understand it
BTW By the way
FAQ (list of) Frequently asked questions
FWIW For what it's worth
FYI For your information
HAND Have a nice day
HTH Hope that helps
IANAL I am not a lawyer
IIRC If I remember correctly
IMHO In my humble opinion
ISTR I seem to remember
LOL Laughs out loud
NG Newsgroup
OTOH On the other hand
PITA Pain in the rear (i.e. a nuisance)
ROFL Roll on floor laughing
RSN Real soon now
RTFM Read the manual
SMOP Small matter of programming (i.e. a trivial task)
TIA Thanks in anticipation
TTFN Ta-ta for now
WRT With respect to
YMMV Your mileage may vary (i.e. your experience may differ)



Introduction to the Address book

Turnpike automatically provides you with an on-screen Address book as a store for all the email 
addresses you might use - together with other information about the persons concerned. It also provides 
an easy way to slot an email address from the Address book into the email message you are preparing.

You typically call up this Address book either by clicking an Address book or Look up address button on
the toolbar of your current display or by double-clicking on its book-like icon.

Turnpike automatically ensures that there's an entry in the Address book for anyone you send email to or 
anyone who sends email to you (though you can turn this feature off for individual mailboxes: see the 
Name page of the Mailbox dialog). The entries are also automatically indexed, typically under the 
person's first name, their surname and their domain - giving you a choice of 'headings' under which to find
any record you wish to pick out. You can then add additional personal information, extra index entries etc. 
(or remove some of these entries if you want). You can also add further address book entries by hand and
make other amendments if you want (see Making changes to your address book).

When you want to send email to somebody that's listed in your address book, you can do this either by 
taking the Start new email option from within your mailbox and then slotting in the address from your 
Address book or by selecting the person in your Address book and then clicking on the 'Start new email: 
To' button. Simply pick whichever route is more convenient at the time. (For more information, see 
Sending mail.)

Note: Each entry for someone in the Address book refers to a single email address, so if someone uses 
more than one email address, they will have more than one entry in your Address book. The way to 
distinguish between these entries is to give each entry a 'label' (see the description of the Person dialog). 
These labels will then be shown in the third column of the list on the main Address Book display and can 
also be used as index entries. (If no label has been set, this third column shows the person's domain 
name.)



Adding email names

Having a range of email names by which you can be addressed both increases the chances of someone 
specifying a name that the system will recognise as meaning 'for you', and potentially allows you to sort 
your mail on the basis of which email name has been used.

Assuming you have email name permission, you can set up either personal names and names like 'Sales'
that refer eg. to particular aspects of your job as email names. If your system is shared with other users 
and you have broader name permission, you can also set up email names for 'group mail'. The only 
restrictions are that each name must be made up of valid characters (not including spaces or commas) 
and that it must be unique.

To set up a new email name for yourself (or change one you currently use), call up the File menu, select 
Configure, then take Email names from the submenu that appears. When the list of current Email 
names appears, click the Create button and type the new name in the Name slot of the 'Usage of Email 
Name' dialog that appears. (The rest of this dialog is concerned with setting up names for group mail and 
can be ignored when you are simply setting up alternative email names for yourself.)

For information about the Usage of Email Name dialog, either click here
Or press F1 to call up this Help file when you have the dialog on the screen



Adding new users

This copy of Turnpike supports up to 99 users signing on at different times - but before anyone can use 
the system, they have to be recorded as a user of the system, given a sign-on name and their own 
personal 'seat' on the system.

Assuming you have suitable permission, you can add new users to your system by calling up the File 
menu, selecting the Configure option, then selecting Users from the submenu that appears.

The 'Configure Users' dialog that then appears lists the sign-on names of current users of your Turnpike 
system, together with the seat each of these users has been allocated. (If you simply see a set of details 
about yourself, you don't have the permission needed to add new users.)

To add a new user, click the Create button and record the details of the new user in the 'Edit Sign-on' 
dialog that's displayed.

Click here for further information about the 'Configure Users' dialog
Or here for information about the 'Edit Sign-on' dialog
- or simply press F1 to call up this Help file when these dialogs are on the screen



Adding newsgroups to a newsstand

The newsgroups you wish to subscribe to through a particular newsstand are added directly to that 
newsstand using buttons displayed at the bottom of the newsstand. (The steps used to set up the 
newsstand to which you want to add these newsgroups are described in the section on Setting up 
newsstands).

To add newsgroups to the newsstand, click the Add button. This displays a Newsgroup Addition dialog,
the upper part of which shows a list of the newsgroups to which you currently have access at your site - 
with (if you have News Admin permission) the alternative of switching to a list of all the newsgroups you 
can get from your Access Provider.

Select a newsgroup that you wish to include in the newsstand, then click the Add button - or simply 
double-click on the newsgroup name (for more details, click here). Finally, click the OK button to take you 
back to the newsstand. (If you've picked out any newsgroups that aren't currently subscribed to at your 
site, you will asked to confirm that you want these to be added to the list of subscribed newsgroups. 
These newsgroups will then be set to be downloaded in full, available for all to see, and with the 
downloaded articles expired after three days. You may want to change these subscription details.)

The newsgroups you selected are then added to the newsstand in the order in which you picked these 
out. If you want to change this order, you can either use the Move Up and Move Down buttons to move 
newsgroups into the new position you want for them or simply drag them there.

Note: You can change the selection of newsgroups in a newsstand at any time. Simply go back to the top 
level of the newsstand (the level at which you can see all the newsgroups) then use the buttons along the 
bottom of the newsstand to 'Add' new newsgroups, '  Remove  ' newsgroups   you no longer require, move 
newsgroups up and down the list or '  Alter  ' various aspects of the newsstand   as you require.

* New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks up 
articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, 
someone with Connect Admin permission can ask Turnpike to pick up a complete new list through the 
Configure Usenet News dialog, displayed by taking News collection from the Configure menu in 
Turnpike Connect. This is particularly important to do if you change the News server you use (eg. 
because you change Access provider) because not all News servers carry the same range of 
newsgroups.



Making changes to your Address book

To make any changes to your Address Book, you first need to bring the Address Book onto the screen (for
example, by selecting Address Book in the Window menu).

If you want to add a new person to your address book, you should then click the New person... button 
and fill in the details in the Address book entry dialog that's displayed. (If you are uncertain how to fill in 
this dialog, press F1 to call up this Help file from the dialog.)

If you want to add a distribution list (to make it easy to specify when you want to send a message to the
people on this list), you need to click the New list... button and fill in the details in the Address book entry 
dialog that's displayed. (If you are uncertain how to fill in this dialog, press F1 to call up this Help file from 
the dialog.)

If you want to change an entry for someone eg. to add details like their address and phone number, you 
need to select their entry in the address list, click the View/Alter button - then make the changes you 
require in the Address book entry dialog that's displayed. (Again, if you're not sure how to make the 
changes you require, press F1 to call up this Help file from the dialog.)

To delete an entry, simply select this entry in the address list, click the Remove entry button - then use 
the dialog that is displayed to specify whether you want to remove the entire entry or just the index entry 
under which you've selected this record (assuming that it is listed under more than one index entry: if it's 
only listed under one entry, you don't get the choice of removing just this index entry - just the entire 
record.)



Address Book External Format: Formal definition

The external form of the address book is a comma separated value (CSV) datafile, the first part of which 
is made up of 'name records' giving the details of personal entries within the address book while the 
second part is made up of distribution records containing the details of any distribution lists.

At least one blank line separates these two parts and also separates the distribution lists.

Each name record has 11 fields and is written on a single line (except where carriage returns within the 
data introduce new lines). To keep the number of fields within a name-record fixed, the lists of index-
strings and file-addresses are represented as single values with their own internal structure. This is simply
achieved by quoting the comma separated lists, thus reducing the list to a single value.

A distribution record consists of the list's name (plus other information) on one line, followed by the 
individual entries that make up the list arranged on separate lines.

The full syntax is as follows (defined using BSI Syntactic Metalanguage):

external-address-book = {name-record}, {CRLF, [distribution-record]}.

name-record =
[name-string], ",", ["auto"],
",", [label-string], ",", ["auto"],
",", [fax-number],
",", [phone-number],
",", [land-address],
",", [email-address], ",", ["hasMIME" | "useMIME"],
",", [index-list],
",", [file-list],
CRLF.

distribution-record =
[name-string],
",", [label-string],
",", ["useMIME"],
",", [index-list],
CRLF,
{email-address, [",", ["hasMIME" | "useMIME"], [",", ["cc" | "bcc"]]], CRLF}.

where:

index-list = ' " ', index-string, {",", index-string}, ' " ' | index-string.
file-list = ' " ', file-as, {",", file-as}, ' " '.
file-as = file-address, ",", ["hasMIME" | "useMIME"], ",", [recID].

name-string = value.
label-string = value.
fax-number = value.
phone-number = value.
land-address = value.
email-address = RFC822-address. ; defined in RFC822
RFC822-address = value.
file-address = RFC822-addr-spec. ; defined in RFC822
RFC822-addr-spec = inner-value.
recID = inner-value.



index-string = inner-value.

value = quoted-string | unquoted-string.

quoted-string = ' " ', {qtext | ' " " '}, ' " '.
qtext = <any CHAR excepting    ' " '>.

unquoted-string = {utext}.
utext = <any CHAR excepting ' " ', "," & CR>.

inner-value = {itext |    ' " " ' | quoted-pair}.
itext = <any CHAR excepting    ' " ', ",", "\">.
quoted-pair = "\", ("," | "\").

CHAR = <BYTE in the range 1..255>.

Notes

Within each comma separated field, leading and trailing white space (space and tab) is ignored but 
embedded white space is significant.

There is no convention in CSV files of how to handle quotes within quotes, so the convention that '  " ' 
means " has been adopted.    Similarly, the \ convention is used to escape commas in index-string and 
file-address lists.

Trailing commas may be suppressed in which case their fields are assumed to be empty.



The Address book

Introduction to the Address book

How to:
Call up the Address book
Select an entry in the Address book
Send mail to someone in the Address book
See the messages you've exchanged with someone
Add new addresses
Update entries in the Address book
Remove entries from the Address book
Record the details of a distribution list
Rebuild the Address book
Import or export addresses

The Address book display



The main Address book display

The display you see when you call up the Address book comprises:

A Selection box: through which you can pick out Address book entries either by typing one of the names 
under which the entry is indexed or by picking it out from the drop-down list of entries you've selected 
recently.

A List of all your address book entries: shown in Index entry order. The first column of the list shows 
the Index entry; the second column shows the name of the Address book entry, while the third column 
shows the label that has been given to the entry. (Note: Each entry in the Address book typically appears 
two or three times in this list - once for each index entry that is recorded for it.)

A Goto box: Clicking on a letter in this box switches the above list to the section with Index entries 
starting with this letter.

Above the display is a toolbar offering the following buttons:

Start new email to: Creates an email message to send to the person or distribution list you select in the 
Address book (see Sending mail to someone in the Address book).

Messages: Displays a list of the messages you have exchanged with the person you select (see Seeing 
correspondence).

View / Alter: Displays the details of the currently selected entry and allows you to change these (see 
Making changes to your Address book).

New Person: Adds a new entry for a person (see Making changes to your Address book).

New List: Adds an entry for a distribution list (see Making changes to your Address book).

Remove entry: Removes the currently selected entry from your Address book (see Making changes to 
your Address book).

Start new email: Creates an email message independently of the entry currently selected in the Address 
book.

For information about the dialog displayed when you take the New Person, New List or View/Alter 
options, either press F1 when this dialog is displayed on the screen or click here for information about the 
'Person' dialog - or here for information about the 'List' dialog.



Address book: List dialog

This dialog records the details of a particular distribution list to which messages are sent.

It is called up either by selecting an existing list entry in the Address book and clicking View/Alter button 
or by clicking the Address book's New List button

List name: Slot for the name by which the following combination of addresses will be identified. Simply 
type the required name.

Label: Slot for an additional label for this entry eg. a company name - if appropriate. Again, simply type 
this name.

Use MIME: Select this check box if the messages sent to this distribution list can be MIME messages ie. if
all the people listed are able to read MIME messages.

To: Slot for the email address of a main recipient of any mail messages sent to this list. Use the [+] button 
shown alongside this entry to open a fresh slot for each additional main recipient you wish to record.

cc: Similar slot for the email addresses of any recipients of Carbon copies of this mail.

bcc: Similar slot for the email addresses of any recipients of Blind carbon copies of this mail.

Index by: The keywords under which this entry is to be listed on the main Address book display - 
normally set for you from the List name and any Label you set but you can use different keywords if you 
want. Type these on separate lines.

Mail To button: Click this button to prepare a message to send to the people on this distribution list.



Address book: Person dialog

This dialog is used to set up and display the entry for someone in the Address book.

It is called up either by selecting an existing person entry in the Address book and clicking View/Alter 
button or by clicking the Address book's New person button

Person: Slot for the person's name. Simply type this name.

Label: Slot for an additional label for this entry - principally used to distinguish between different entries 
for the same person. Again, simply type the required label.

Has MIME; Use MIME: Use these check boxes to record whether the messages you send can be MIME 
messages ie. if the person concerned will be able to read MIME messages.

Email: Slot for the email address to be associated with this entry.

File as: The email address(es) under which mail from this person is filed.
Note: These addresses are used to select the messages listed when you click the Messages button - so 
if someone uses more than one email address, it's important to list all their addresses here so that you 
get a complete list of the messages you've exchanged. Use the [+] button shown alongside this entry to 
open a fresh slot for each additional address you wish to record.

Phone, Fax, Address: Slots for further 'address book' information that you may wish to record.

Index by: The names under which this entry is listed on the main Address book display - normally set for 
you from the person's name and any Label you add but you can use different keywords if you want. Type 
these on separate lines.

Messages button: Lets you call up a list of the messages you've exchanged with the selected person.

Mail To button: Click this button to prepare an email message to send to this person.



Address book: External format

The 'external' form of the address book is a CSV (comma separated value) datafile, divided into two parts:

The first part is made up of personal entries, with the data for each entry arranged on a separate line

The second part is made up of distribution lists, each spread over a number of lines.

There needs to be at least one blank line between these two parts and also between the individual 
distribution lists.

The layout of the data is described below - or you can click here for a formal definition of the syntax of this
file.

Part 1: The personal entries

Personal entries are arranged one to a line, with the different pieces of information given in the following 
order and separated by commas. The order of the information is:

* Name - as given in the Person: slot of the address book entry
* Whether this name was automatically generated (written as auto) or not (left blank)
* Label - as given in the Label: slot
* Whether this label was automatically generated (written as auto) or not (left blank)
* Fax number - as given in the Fax: slot 
* Phone number - as given in the Phone: slot 
* Land address - as given in the Address: slot 
* Email address - as given in the Email: slot 
* useMIME if MIME should be used; hasMIME if MIME is available but shouldn't in general be used; or 
blank if no MIME 
* The index entries - as listed in the Index by: box 
* The addresses under which messages are filed - as entered in the File as: slot

(Note: Automatically-generated Name and Label entries don't appear in the individual address book 
entries - just in the second and third columns of the list on the main Address book display.)

The Name, the Label, the Fax & Phone numbers and the Email address are generally written exactly as in
the corresponding address book entry, though they can be written between double quotes if you prefer. 
(Space before or after any entry is ignored.)

However, any entries that include commas, carriage returns or double quotes - such as the Land address 
- MUST be written between double quotes, and with any double quote marks within the entry written as 
double double quotes (" ").

Index entries are listed between double quotes as follows "entry1,entry2,..." - though the double quotes 
are optional where there's just one index entry.

File as addresses are also given as "entry1,entry2,..." but in this case each entry is divided into three 
sections (again separated by commas) viz. email address; useMIME or hasMIME or blank; and either a 
record number (if Turnpike has generated the external file) or a blank. (The double quotes are always 
included in this case.)

Where any of these items is blank, the comma that separates it from the next piece of information must 
still appear so that the remaining pieces of information are associated with the correct parts of the 



address book entry. But if the remaining entries are themselves all blank, the record can simply be 
finished with a carriage return: Turnpike will then automatically make the remaining items of the record 
blank.

Click here for a detailed example.

Part 2: The distribution lists

Any distribution lists are made up of:
* a blank line - to separate the list either from the list of personal entries or from a preceding distribution 
list
* a line of general information about the list
* details of the different people on the distribution list, each on a separate line

The line of general information contains the following information in the following order, separated by 
commas:

* Name - as given in the List name: slot of the address book entry
* Label - as given in the Label: slot
* useMIME if MIME is to be used, otherwise blank
* The Index entries - as listed in the Index by: box 

with the Name and the Label written either exactly as the address book entry or between double quotes 
as required, and the Index entries given as "entry1,entry2,..." (though the double quotes can be omitted if
there's just one index entry).

The lines of details about the individual people on the distribution list give the following information, again 
separated by commas:

* Email address
* useMIME if MIME should be used; hasMIME if MIME is available but shouldn't in general be used; or 
blank if no MIME 
* cc if listed in the cc slot, bcc if listed in the bcc slot or blank if listed in the To slot

(Note: These lines can be finished after the email address or after the useMIME/hasMIME entry if the 
remainder of the line is blank.)

Click here for a detailed example.



'Administer Workgroups' dialog

*** Only relevant on shared systems ***

This dialog is used by people with the appropriate permission to assign users to workgroups.

It is called up by taking the Configure option from the File menu and then selecting Workgroups from 
the submenu that appears.

The main part of the display is a list of the workgroups that have already been set up, together with the 
number of users in each of these workgroups.

* The Create button allows you to set up new workgroups.
* The Edit button allows you to change the details of an existing workgroup.
* The Remove button lets you abolish an existing workgroup.

Both the Create option and the Edit option call up a 'Edit workgroup details' dialog through which you can 
set the membership of the workgroup. For information about this second dialog, either click here - or 
press F1 to call up this Help file when the dialog is on the screen.

Note: The list of workgroups automatially includes an 'ALL' workgroup, covering all the users on the 
system. This group provides an easy way of giving everybody general permissions and newsgroup 
ratings: it has no other purpose.



Advice for new users

If you are new to the Internet, we strongly recommend that:

* You start by scanning the Turnpike Mail & News book to get an idea of the screens and menus that 
Turnpike offers and how different actions are carried out in Turnpike. (When you need detailed advice on 
the steps to take, the best place to look is in this Help file.)

* Then BEFORE YOU POST A NEWS ARTICLE TO ANY NEWSGROUP, you practise posting news 
articles by sending practice articles to one of the 'test' newsgroups (such as demon.test). No-one will 
object if you break any Internet conventions in an article that you post to one of the test newsgroups - 
indeed, you will usually get a helpful response explaining what you should have done. Get these things 
wrong in a posting to one of the 'real' newsgroups, however, and you will probably be 'flamed'.

* Then before posting to any particular newsgroup, study both the articles that other people post to this 
newsgroup and the FAQs included in that newsgroup. If you don't do this, you risk being 'flamed' either for
posting an article that is inappropriate to the newsgroup or for wasting other people's time, disk space etc.
by asking a question or making a comment that has been asked many times before.



Allocating another user to a seat

If someone else is taking over the role of someone who leaves, it is useful for the System Administrator to
arrange that the new person takes over the same seat in Turnpike - because then they will automatically 
be able to see any relevant mail that has arrived in the past. They will also be automatically allocated to 
the same workgroups.

But first it's a good idea to ensure that the seat is left 'tidy' for the new person, so we suggest that the 
System Administrator should:

1. Take Configure | Users from the File menu, select the entry for the 'old' user, make a note of the 
number of the seat they occupied - then click the Edit button and set all the details needed for the new 
person in the dialog that's displayed.

2. Log on as the new person and tidy up the system you find - exporting then deleting any personal mail 
from the mailbase, deleting personal email tags, deleting any mailboxes /newsstands that don't seem 
appropriate and updating the User Info page of the others.

3. Select the 'old' user's entry in the Address book and click the View/Alter button to display this entry in 
full. Change each entry in the dialog that's displayed to show the new person's details - but when you 
come to the File as entry, click the [+] button and add the new person's email address to the details that 
are already recorded: don't delete the old details. That way, the new person will see the messages sent to
their predecessor alongside their own messages when they click the Messages button.

4. Go into the userxxx directory corresponding to the old user's seat, use a suitable text editor to inspect / 
edit the .sig signature files (these are simply text files), then clear out all the files except for the 
TURNPIKE.INI file and any signature files that want to retain.



Allowing access to mail

*** Only relevant to shared systems ***

When a message first arrives in your In tray, it is automatically treated as private to you - to avoid 
confusion. But when you file it, you will probably want the message either to remain private or to become 
available to all your colleagues. The other option is for it to be available to a specific range of people.

Who will have access to a message when it is filed is shown on the Status bar displayed below the 
message as you read it. The information shown here has three sections to it. The first shows the owner of
the message. The second shows whether the message is to be public, private (to the owner) or governed 
by the tags listed in the third section (see Making access dependent on topic). This last option is 
described as 'Restricted'.

The access that's allowed to a message is also indicated where it is displayed in mail lists with  marking
messages that you can't read; 

 marking messages that only you can read; and 
 marking messages that only you and some others can read. If a message doesn't have any of these 

markers, it's public and can be read by anyone.

To start with, each message is given the default access details set on the   Tags   page   of the mailbox in 
which it is opened. These define both the owner of the message and whether the message should be 
private, public or set by the tags (the initial set of which are also defined on this page). (Click here for 
further information on this.)

But if you are the owner of the message or you are a member of the workgroup which owns the message,
you can switch the marking on a message from 'Private' to 'Public' or to 'Restricted' (or vice versa) simply 
by clicking the second button on the Status bar until the appropriate setting is shown. You can also 
change the ownership, either to yourself or to a workgroup you are a member of - by clicking the Owner 
button and selecting the new owner in the Select owner dialog that is displayed.



Alt groups
Among the newsgroups on offer are several 'Alternative' groups - with 'Alt' as the first part of their name. 
These groups usually developed out of newsgroups that were originally circulated among people working 
at the same site and they tend to be less formal (and their contributions more eccentric) than the 
newsgroups within the main newsgroup categories.



'Alter Usage' dialog

*** Only relevant on shared systems ***

This dialog is used both
* to record which users or workgroups can call up messages marked with a particular tag.- see Making 
access to mail dependent on topic.
* and to specify which users / workgroups can read the articles downloaded from a paticular newsgroup - 
see Restricting access to newsgroups.

The dialog features two lists - the one on the left can be switched to show either all the users of the 
system or all the workgroups that have been defined; the one on the right is shows the users and 
workgroups that will have access to messages marked with the tag that is currently being set up or edited.
The right-hand list is built up by 'adding' names from the left-hand list (using the Add and Del buttons 
between the two lists).



Alternative email names

To start with, you will have a single email name - which will usually also be your sign-on name.

In practice, however, it is often useful to have a range of alternative email names that you use.

For a start, it broadens the range of names that someone trying to contact you could use, increasing their 
chances of specifying a name that the system will recognise as meaning 'for you'.

In addition, you can set up extra mailboxes for the new email names to keep separate your different types
of email (personal, business, technical, etc.)

On a shared system, it is also useful for someone to be given the email names 'postmaster' and 'root' 
because certain types of mail are routinely sent to these email names.

If you have Email name permission, you can give yourself whatever additional names you like (provided 
no-one else is already using these names) - but on a shared system, you may need to discuss the names
you want with your system administrator.

Click here for instructions on setting up alternative email names
Or here if you want to find out about associating a particular email name with a mailbox



Alternative forms of enclosure
Very occasionally, an item within a message may be offered in a number of alternative forms. For 
example, the text of a MIME message may be offered in both plain and enriched forms, or you may be 
offered a choice of ways of picking up an external body.

Wherever possible, this is shown as a horizontal bar with the different forms of the enclosure offered as 
buttons.
Otherwise, you are offered a Select button with the number of alternatives shown alongside. Clicking this 
button calls up a dialog listing the alternatives, from which you can select the version you require.



Alternative keystrokes

Turnpike is intended to be driven using Windows range of point, click and drag techniques, but many 
actions can be carried out using keystrokes instead.

In particular, the space bar may be used to step a window-full at a time through unread mail messages 
and news articles and Ctrl G may be used to step from item to item in a digest.

Turnpike lets you call up Windows 95-style 'Context' menus and dialogs by pointing to the item you are 
interested in and clicking the right mouse button. You may well find that these offer a quicker and easier 
route to several of the actions you wish to carry out.

Windows alternative keystrokes can also be used. To select a menu, hold down the Alt key and press the 
character underlined in the menu. Then, to pick an option from the menu, type the underlined character in
the option you require.

For example, holding down Alt and pressing F will access the File menu.
Pressing I will then access the Import.option in that menu.

Some options can be accessed directly by the special key combinations shown in the menus.

For example, when reading a message, holding down Ctrl and pressing F will invoke the Find routine,
while Ctrl P will launch the Print dialog.

Other useful keystrokes include:

Ctrl F4 to close a window (e.g. when wishing to post a message)
Ctrl F6 (and Shift Ctrl F6) to cycle through the different mailboxes, newsstands etc. on the Turnpike 
desktop.
The Tab or Arrow keys to move between Edit boxes in a dialog.



Archiving messages/articles

If you would like to archive older mail messages outside of the Turnpike mailbase, the way to do this is to 
export these messages. This copies the messages you select into a text file which you can store 
wherever you like.

You can then delete these messages from your mailbase, with the security of knowing that you have them
safely stored on disk in a form which you can re-import into Turnpike if necessary. (Exporting messages 
does not automatically delete them from the mailbase.)

Similar steps can be used to archive old news articles.



Article menu

Open newsgroup
Close newsgroup

Open article
Followup article
Reply by email
Forward article
Cancel article
Start news thread
Start new email

Break Thread
Rejoin Thread
Expand Tree
Collapse Tree
Expand all Trees
Collapse all Trees



Article menu: Break thread
Lets you break off a section of a discussion thread so that you can hide away the section of this thread 
that you are not interested in.

For more information, see Breaking threads.

See also: Rejoin thread



Article menu/Newsstand button: Close newsgroup
Takes you out of the current newsgroup and back to the list of newsgroups. See Opening/Closing 
newsgroups.

See also: Open newsgroup



Article menu: Collapse Tree
Closes up the current discussion thread so that all you see is the title of the discussion thread and the 
number of articles in that thread.

For more information, see Expanding/Collapsing trees.

See also: Collapse all Trees and Expand Tree



Article menu: Collapse all Trees
Returns the display of the current newsgroup to a list of discussion threads.

For more information, see Expanding/Collapsing trees.

See also: Collapse Tree



Article menu: Expand tree
Expands the discussion thread you've selected, allowing you to see the individual articles that have been 
contributed to the discussion and how these follow on from each other.

For more information, see Expanding/Collapsing trees.

See also: Expand all Trees and Collapse Tree



Article menu: Expand all Trees
Expands all the discussion threads in the newsgroup you are looking at.

For more information, see Expanding/Collapsing trees.

See also: Expand Tree



Article menu: Followup article
Lets you prepare and post a 'Follow-up' to the current article.

For further information, see Responding to news articles.

See also: Reply by email and Start news thread



Article menu/Newsstand button: Open newsgroup
Takes you into the newsgroup you've selected and shows you a list of the discussions currently taking 
place in that newsgroup. See Opening/Closing newsgroups.

See also: Close newsgroup



Article menu: Rejoin thread
Re-unites a divided-off section of a discussion thread with its 'parent'.

For more information, see Breaking threads.

See also: Break thread



Article menu: Start news thread
Lets you prepare and post an article which will start a new discussion within the current newsgroup.

For more information, see Starting a news thread.

See also: Followup article



Article/Message menu: Cancel article
Sends a message cancelling the article you have selected.

For further information, see Cancelling news articles.



Message menu: Forward "as is"
Opens a new email containing the message you've selected for forwarding to someone else.
Note that you cannot add any text of your own to the email with this option.

For further information, Click here.



Article/Message menu: Forward article/message
Opens a new email message containing a copy of the message/article you've selected ready to forward 
on to a friend.

For further information, see Forwarding mail or Forwarding a news article as appropriate.



Article/Message menu: Open article/message
Opens the message/article you've selected so that you can read it.

For further information, see Reading your mail or Reading news articles as appropriate.



Message menu: Reject message
Attempts to return the selected message to its sender with a notice that delivery to you failed. Also gives 
you the opportunity to delete the message. Normally used to reject unwanted 'junk' mail.

For further information, Click here.



Article/Message menu / Mailbox button: Reply option
Lets you prepare and post an email message in reply to the message/article that you currently have either
selected or open on the screen.

For further information, see either Sending mail or Responding to news articles as appropriate.

See also: Followup article (News)



Article/Message menu / Mailbox button: Start new email
Lets you prepare and post an email message to anyone you wish.

For further information, see Sending mail.



Attribution & Forwarding text

Attribution text is the text used to introduce quotations from a message or article that you are replying to. 
Forwarding text is the text used to introduce messages that you forward to someone else.

Turnpike automatically sets suitable forms of text for each of these, incorporating such things as the 
author of the original message, their email address and the Message ID. But if you would prefer a 
different style of introduction for either of these, you can record the form of introductory text you want on 
the Standard text page of the Mailbox / Newsstand dialog called up when you either set up or alter the 
mailbox or newsstand you want to affect.

Note: Items such as the author's name and their email address are included in these texts by putting 
special markers where you want these to appear. The markers are:

%p for the person's name
%a for the email address
%o for the person's organization (news articles only: left blank where you are replying to or 
forwarding a mail message)
%s for the subject of the message
%m for the message ID
%d for the date when the message was posted
%t for the time it was posted
%g for the newsgroup in which the article is being read (left blank where you are replying to or 
forwarding a mail message)
%l for the number of lines (news articles only: left blank where you are replying to or forwarding a mail
message)
while %n can be used to start a new line

If you want to include a % in your text, you will need to write this as %%.



Backing up your Turnpike files

As in any program, it is a good idea for the person who has the role of system administrator to keep back-
up copies of important files. In Turnpike, the files to back up are:

From the Turnpike directory: TURNPIKE.USR
CALLS.TPK
The .INI files
Any .ACC file that has been modified
Any .MDM file that has been modified
Any .CST file that has been modified

From the Mail directory: MSPOOL
MAILBASE
ADDRBOOK

From the News directory: NSPOOL
NEWSBASE

plus the whole of each user's directory (which have names of the form USERxxx).

Other files don't need to be backed-up because they can, if necessary, be recovered either by re-installing
Turnpike or, in the case of the additional files in the News directory, by re-building the Newsbase.



Binaries

A number of 'Alternative' newsgroups have names including the word 'Binary' or 'Binaries'.

This indicates that the 'articles' in that newsgroup don't simply include text but other types of file - 
particularly graphics. Indeed, the articles themselves are usually referred to as 'Binaries'.

There are two points to note about such articles.

Firstly, they take up a lot of disk space. Indeed, your System Administrator may well ban you from 
subscribing to these groups for this reason alone (though they may also ban particular groups on the 
grounds of the type of material that is contributed to those groups!).

Secondly, you can't simply open a binary and see their contents. They need to be decoded first: see 
'Reading' binaries. Similarly, if you want to contribute a graphic (or other such file) to one of these 
newsgroups, you will need to encode it first: see Posting a picture.

The reason for this special handling is simply that Usenet News was originally set up to handle 7-bit text.



Breaking threads

With some of the more complex discussion threads, you may find that you are interested in one branch of 
this discussion but not in another.

To help you ignore the part you aren't interested in, Turnpike lets you break discussion threads into two or
more parts which can then be treated as separate threads and classed as Interesting or Not interesting as
you require.

Note: The effect of breaking a thread is purely local to your own system.

To break a thread, select the article at which you want to make the break, then take the Break thread 
option in the Classify menu. (The piece you break off is then marked  to show that it is a 'User-defined' 
thread.)

To join the parts together again, select the 'user-defined' part of the thread, then take Rejoin thread 
from the Classify menu.

Note: After a thread has been rejoined, it will be marked Interesting if either of the parts was classed 
Interesting, or Not interesting if one part was classed as Not interesting and the other was neutral. You 
may want to adjust this classification.



Browsing
To browse a newsgroup is to download just the header of each article. This saves a considerable amount 
of disk space while still allowing you to see whether there is anything of interest to you. If you spot an 
article you do want to read, you can request it to be downloaded the next time you go on-line to the 
Internet (see Requesting missing articles).

Also, you can set kill rules to accept certain types of articles in full, even though only the headers of other
messages are downloaded.

If you would like a particular newsgroup to be browsed, then assuming you have News Admin permission,
you can arrange this by selecting Configure from the File menu, taking the Newsgroups option - then 
setting the Type of this newsgroup to Browse in the Newsgroup Subscriptions dialog that's displayed.



Call costs
Turnpike automatically records the time, duration, destination and cost of calls made by each user of 
Connect, and provides a variety of tools for working with the log that is produced.

For further information call up Help from the Connect program and search for 'Call costs'.



Calling up the Address book

The general way in which to call up your Address book is either to double-click its icon (if this is visible on 
the Turnpike screen) or to select it from the list of windows given in the Window menu.

But if you are currently working in a Mailbox or you are in the process of preparing a mail message, you 
can call up your Address book by clicking the Address book button included in the toolbar.



Cancelling news articles

If you change your mind about posting an article or you want to make a change to it, the best thing to do 
is to pull it out of your Out tray before it is sent.

But to cancel the article in this way you need to pull it out of your Out tray before you next connect to your
Access provider, otherwise the article will have already been sent to the newsgroup. Note: If you are 
already connected to your Access provider, you may still be able to pull your article because Turnpike 
arranges that anything you post stays in the Out tray for at least a minute to give you a chance to change 
your mind or edit it before it is sent - but you will need to be quick.

If you find that the article has already been sent, you have the option of following it up with a message 
containing the instruction to Cancel the article. If the article has already appeared in the newsgroup, then 
you can send this message by selecting the article and then taking the Cancel article option from the 
Article menu. If it hasn't yet appeared in the newsgroup, call up the Mailroom view of everything that's 
gone in or out, select the article in this list (the newsgroup to which you sent the article will be listed as the
recipient), then select Cancel article from the Message menu.

In either case, Turnpike will then open a special message for you to post, to which (by convention) you 
need to add the reason why you want the article cancelled. (This explanation is needed because not all 
news servers process such messages automatically: in some cases, real people get to decide whether 
your article is cancelled or not.)

But note: there's no guarantee that your Cancel message will be processed and in any case your original 
article may be read before the Cancel message takes effect. All the Cancel message can do is minimise 
the number of people who do read your article. In the light of that, it may be better to simply take 
responsibility for the article you've posted and follow it up with a correction or an apology if appropriate - 
though you may then get flamed for making too much noise.

Note: You can, of course, only cancel your own articles (posted from the site at which you are currently 
working), though on a shared system someone with suitable administrative powers can cancel articles by 
any user working at their site.



Cancelling your subscription to a newsgroup

To cancel the subscription to a particular newsgroup and stop articles being downloaded from that group, 
this newsgroup needs to be removed from the list of subscribed newsgroups that Turnpike keeps for you. 
The newsgroup also needs to be removed from any newsstands in which it is selected.

To remove the newsgroup from the list of subscribed newsgroups, someone with News Admin permission 
needs to take the Configure option from the File menu, then select Newsgroups from the sub-menu that 
appears to display the Newsgroups Subscriptions dialog. You then need just need to select the 
newsgroup in the list of subscribed groups and click the Unsubscribe button.

However, in general all anyone need do when they decide they no longer want to follow a newsgroup is 
remove this newsgroup from their newsstand (using the Remove button offered when the list of 
newsgroups in the newsstand is being displayed). If this means that no-one is now following this 
newsgroup, then the next time someone with News Admin permission logs on, Turnpike will display a 
message asking if it should unsubscribe from this newsgroup: clicking the Yes button will remove it from 
the list of subscribed newsgroups. (If you say No to this offer, the message will continue to appear each 
time someone with News Admin permission appears until such time as someone either opts to 
unsubscribe it or adds it to a newsstand.)

A similar thing happens when a newsgroup is removed from the list of subscribed newsgroups but not 
from the newsstands in which it appears. When anybody with News Admin permission who has this 
newsgroup in their newsstand logs on, they will see a message advising them that their newsstand 
includes a newsgroup which is not in the list of subscribed newsgroups and offering to add it to the list. If 
you 'say' No, the newsgroup will be automatically deleted from the newsstand. (If you don't have News 
Admin permission, the newsgroup is simply removed anyway.)

Note: If you want to retain any of the articles that you've already downloaded from the newsgroup, be 
sure to export these first - including ones you have marked to be kept. Otherwise, these articles will 
disappear the next time that the News is expired.



Carbon copies
If an email message is sent as a carbon copy (specified through a CC: line in its header), every recipient 
can see who else has been sent copies.

If blind carbon copy is used (specified through a BCC: line in the header), none of the recipients can see 
who else has been sent copies.



Changing newsgroup subscription details

When a newsgroup is first added to the list of newsgroups subscribed to at your site, it is set to be 
downloaded in full and for the articles to stay on your disk for three days before being automatically 
expired. It is also made available for anyone who uses your system to read.

If you have News Admin permission, you can change all these settings. To do this, you need to take the 
Configure option from the File menu, then select Newsgroups from the sub-menu that appears to 
display the Newsgroup Subscriptions dialog.

* To stop the newsgroup being downloaded in full, select the newsgroup in the top part of the dialog, then 
switch the Type setting to browsed in the lower part of the dialog.
* To change the length of time the articles will stay on your disk, select the newsgroup in the top part of 
the dialog, then set the Expiry time you require in the lower part of the dialog.
* To restrict who can access the newsgroup, select the newsgroup in the top part of the dialog, then click 
the Access button and select the people who are to have access to this newsgroup in the dialog that's 
displayed.

IMPORTANT: After changing either the Type or the Expiry time (or any of the other settings recorded in 
the lower part of the Newsgroup Subscriptions dialog), be sure to click the Apply button. Otherwise the 
settings you've made will be lost if you then either leave the dialog or move on to a different newsgroup.

Click here for further information about the Newsgroup Subscriptions dialog or press F1 to call up this 
Help file when you have this dialog on the screen.



Changing the header on a message

The header part of any message you prepare is to a great extent set up for you, using information taken 
from the 'User Info page' of the mailbox or newsstand in which the message is being prepared.

With the mailbox/newsstand personality set up for the type of message you want to prepare, the most you
need to set is the subject of the message and the email address / newsgroup you want to send it to in the 
slots provided at the top of the display.

Occasionally, however, you may need to give a special reply-to address or to add to the list of addresses 
to which the message is to be sent. When you have special requirements like this, click the Edit header 
button above the message. This displays a dialog with slots for each of the common header lines that you
might want to set.

This dialog also includes an 'Other' area in which you can type any additional header lines you require. 
Type any such lines as simple text.

Click here for details of the Mail Header dialog
Or here for details of the News Header dialog



Classify menu

For both messages and articles:
Mark as Read
Mark as Unread

For discussion threads:
Class as Interesting
Class Uninteresting
Declassify

For individual articles:
Kill article
Keep article
Cancel Keep
Request article
Cancel request



Classify menu: Cancel Keep
Cancels an earlier request to keep the selected news article. The article will then be expired in the usual 
way.

See also: Keep article



Classify menu: Cancel Request
Cancels an earlier request to download the selected article.

See also: Request article



Classify menu / Newsstand button: Class Uninteresting

Marks the discussion thread you've selected as 'Not Interesting'. The thread is then marked .

When the newsgroup is next re-threaded, this thread will be listed at the bottom of the newsgroup 
alongside other threads you've marked as not interesting.

For further information, see Picking out interesting articles.

See also: Class as Interesting and Declassify



Classify menu / Newsstand button: Class as Interesting

Marks the discussion thread you've selected as 'Interesting'. The thread is then marked .

When the newsgroup is next re-threaded, this thread will be listed at the top of the newsgroup alongside 
other threads you've marked as interesting (assuming there are further articles to read on this topic: see 
Picking out interesting articles).

See also: Class as Uninteresting and Declassify



Classify menu: Declassify
Puts a discussion thread back to its default status of 'neutral' - ie. neither Interesting nor Not interesting.

When the newsgroup is next re-threaded, this thread will be listed below any Interesting threads but 
above any threads you've marked as 'Not Interesting'.

See also: Class as Interesting and Class Uninteresting



Classify menu: Keep article

Tells Turnpike to keep the selected article past its alloted expiry date. The article is then marked  to 
show that it isn't to be deleted.

Greyed out if you haven't been given Keep article permission.

See Keeping articles past their expiry date.

See also: Cancel Keep



Classify menu: Kill...
Calls up a dialog through which you can opt either simply to 'kill' the current article or to also use it as a 
model for articles that you don't want to download in future.

Greyed out if you haven't been given Kill article permission.

See Killing articles



Classify menu: Mark as Read
Marks the messages/articles you've selected as read even though you haven't read them.

For more information, see Switching between Read and Unread.

See also: Mark as Unread



Classify menu: Mark as Unread
Marks a message/article you've read as 'Unread' so that it will continue to be drawn to your attention.

For more information, see Switching between Read and Unread.

See also: Mark as Read



Classify menu / Newsstand button: Request article
Asks for an article which is either not available or of which only the header is available to be downloaded 
in full the next time that you go on-line. The article is marked  to show that you are waiting for it.

For more information, see Requesting missing articles.

See also: Cancel request



Clearing out unwanted articles

Where a newsgroup contains discussions that you feel are just cluttering up the display, it is usually 
sufficient to move these to the bottom of the newsgroup by marking these threads as 'Uninteresting' (see 
Marking threads as interesting). Threads that you mark as Uninteresting remain on your disk but are 
moved out of sight to the bottom of the list when the newsgroup is next re-threaded.

However, it could be that you are short of space on your 'Newsbase' disk and could usefully use the 
space being occupied by these unwanted articles eg. for further articles. In this case, the answer may be 
to 'kill' these articles.

Killing an article removes it from the Newsbase (except for its header which is kept until the article was 
originally marked to expire). The space it occupied can then either be recovered by re-building the 
Newsbase or simply left to be used for articles that are downloaded the next time you go on-line.

Click here for information on killing articles.



'Colour Selection' dialog

This dialog lets you select the colour used either for text or as a background. (The type of text or 
background for which the colour is to be used is itself part of the dialog.)

It is called up either by taking the Alter option from the Colours page of the Mailbox or Newsstand dialog 
(for making permanent changes) or by taking the Colour option from the Options menu (for making 
temporary changes that will be lost when the current window is closed).

The dialog offers both a 'palette' of 'Basic' colours from which to pick and, on the right, a complete colour 
spectrum from which to select a 'custom' colour if you wish. If you want, you can add the colours you pick 
out from the colour spectrum to an additional palette of 'Custom' colours.

To use a colour from a palette, you simply need to click on the colour in the palette.

To pick a custom colour from the spectrum, you click on the colour you want in the spectrum, then set its 
'luminosity' (the amount of white/black you want in the colour) by clicking on the sample bar to the right of 
the spectrum.

You can then add this custom colour to the Custom palette by clicking the Add to Custom Colors button.

(If you want the new colour to replace an existing colour in the Custom palette, select the entry in the 
Custom palette before setting up the new colour. The 'old' colour will be replaced by the new one when 
you click the Add to Custom Colors button.)

IMPORTANT: Text is only ever displayed using the 'Solid' part of the colour you select. So when setting 
the colour for text, be sure to check the 'Solid' part of the sample shown in the dialog because this is 
what will be used.



People who use Compuserve have addresses of the form 12345,678      

The equivalent Internet address is 12345.678@compuserve.com



'Configure Users' dialog

This dialog is available to the person who acts as system administrator and to anyone with 'Alter Users' 
permission:
* To add new users to the system
* To remove users who no longer use the system, and
* To allow a user who has forgotten their password back into the system by giving them a new password.

It is called up by taking the Configure option from the File menu and then selecting Users from the sub-
menu that appears.

The main part of the display is a list of the users that currently have 'seats' on your Turnpike system, 
together with the number of their seat and details of when they last signed on.

Clicking the Create button calls up a fresh copy of the Edit sign-on dialog, through which to record the 
sign-on name, password, full name etc. of a new user.

Selecting a user, then clicking the Edit button allows you to change their sign-on name, password etc. by 
editing the details shown in the Edit sign-on dialog that's displayed.

Selecting a user, then clicking the Remove button removes this user from the system, freeing their seat 
for someone else to use. (For details of what then happens to any mail they still have in the mailbase, see
Removing users.

For information on the 'Edit sign-on' dialog, either click here or press F1 to call up this Help file when the 
dialog is on the screen.



Configuring Turnpike

Introduction

How to:
Configure Turnpike for a different access provider, modem etc.
Add new users to a shared system
(plus what to do when you need to remove a user from such a system)
Set a password
Set up workgroups
Set permissions
Set where news and mail is stored



Configuring the connection

All aspects of the connection that Turnpike makes with the Internet:
* The Access provider used
* The number on which you dial in on
* The modem used and the speed at which it runs
* Which port on the PC it is connected to
* ...
are set from Turnpike Connect. These things cannot be set from the main Turnpike program.

For information on these, either consult the Turnpike Connect book or load that program and call up its 
own Help file.



Configuring Turnpike: Introduction

There are several areas of Turnpike which can be configured to suit your needs.

Some aspects of the system are set from the main Turnpike program; others are set from Turnpike 
Connect. Several are principally for use on systems with several users such as you might find in a 
company, but they can also be valuable on a 'home' system - particularly where you have different 
members of the same family all using the same system.

The aspects that can be set from the main Turnpike program are:
* The range of people who can use the system, and the sign-on names they use
* The grouping of these users into workgroups
* The range of email names recognised by your system
* Who can use these email names in their mail, and
* Where mail messages that use these names are routed

The aspects that are set using the Turnpike Connect program are:
* The details of the actual connection itself - such as which access provider you use, which number you 
use to dial them up, the type of modem you have etc. etc.
* Where mail and news are sent to and received from on the Internet.
* What timezone you work in.

Note: On a shared system, you won't necessarily be allowed to set all these different options yourself. 
What each user can and can't set is controlled through a series of permissions. What permissions you 
have is up to whoever has the job of system administrator.



Introduction to Turnpike
Using Turnpike Help

Signing on
Reading/Sending Mail
Reading/Posting News
Preparing News / Mail

The Address book
Configuring Turnpike

Leaving Turnpike

Troubleshooting
Backing-up, moving and upgrading Turnpike

Click on a topic or use the Search button to view the index.

If you want to find out which version of Turnpike you are using,
take the About Turnpike option from the Help menu.



Context menus
Turnpike lets you call up Windows 95-style 'Context' menus and dialogs by pointing to the item you are 
interested in and clicking the right mouse button. You may well find that these offer a quicker and easier 
route to several of the actions you wish to carry out.



Controlling access on an individual basis

*** Only relevant on shared systems ***

Each newsgroup (or mailing list treated as a newsgroup) that is subscribed to at a site is normally 
available to any user at that site - but in some cases, you may wish to restrict access to a particular 
newsgroup to a named list of users.

The way this is done is through the 'news tag' that is associated with each newsgroup that is subscribed 
to. This tag is automatically applied both to the newsgroup itself and to any item that is either contributed 
to the newsgroup or sent in response to an article that appears in the newsgroup.

Like the tags that you can apply to mail messages, each news tag can either be made Public - allowing 
any user to follow the newsgroup and see any contributions that are made to the discussion - or it can be 
made Private to a list of named users or workgroups .

Initially each newsgroup that is subscribed to is automatically marked Public, making it available to any 
user. But if it's necessary to restrict access to a particular newsgroup, someone with News Admin 
permission can do this through the Newsgroup Subscriptions dialog (called up by taking the Configure | 
Newsgroups option from the File menu) Just select the newsgroup in the list of subscribed newsgroups 
shown at the top of this dialog then click the Access button shown alongside.

In the Usage dialog that's then displayed, select (ie. check) Limit newsgroup access at the top of the 
dialog, then set up the list of users / workgroups that you want to be able to see the newsgroup (including 
yourself if so required) by selecting these in the left-hand list in the lower part of the display and adding 
them to the list on the right.

Note: Access to newsgroups specifically allowed through the news tags takes precedence over access 
controlled from lists of newsgroup ratings. It's therefore possible to use these news tags to allow someone
to follow a particular newsgroup that would otherwise be hidden on the basis of its rating - by ensuring 
that they are on the list of people that have access to the newsgroup. However, you will then need to 
ensure that every-one else that wants access to this newsgroup is also on the list, because otherwise 
they will be barred - regardless of the personal ratings levels.



Controlling access through ratings

Concern over the propagation of dubious and possibly even illegal material through the Usenet 
newsgroups has led to the introduction of services for rating newsgroups on the basis of the amount of 
bad language, nudity and other potentially offensive material they contain.

Each of these rating services identifies categories of items which might be offensive and grades the 
different levels to which these categories may appear 0, 1, 2, ... between innocuous and highly offensive. 
These gradings and any other associated service information are recorded in a '.RAT' file on your 
machine (that is, a file with the filetype extension .RAT).

Meanwhile, at the news server, each newsgroup is given a 'rating' under each of the various rating 
services supported by that news server by an independent third party such as the recently-announced 
Safety Net organisation. These ratings are then downloaded alongside the list of newsgroups - and can 
be inspected through the Newsgroup Subscriptions dialog (or associated Newsgroup Subscription dialog) 
and the Newsgroup Addition dialog

To use these ratings to filter the newsgroups seen within Turnpike, you simply need to:
* Establish which ratings services are supported by your news server, then select the general details that 
are to apply ie. which ratings service or services you are going to use and what the default ratings levels 
should be for users of your system.
* Then set any special maximum levels that are needed for particular users.

The result of this is then that each user - including ones with News Admin permission - will only be able 
see newsgroups that have been rated less than or equal to the maximum levels recorded for that user.

For detailed instructions, follow the links above.



Converting a mailing list into a newsgroup

One of the options Turnpike offers is to have a mailing list handled like a newsgroup, allowing the mail 
from this list to be threaded and expired in the same way as the articles contributed to a newsgroup.

This is automatically arranged when you follow the standard procedure for subscribing to a new mailing 
list. It can also be arranged for mailing lists that you already subscribe to (assuming you have 'List 
subscribe' permission) and by using much the same steps. The only difference is that you need to avoid 
sending a subscription message to the list's administrator.

In other words, you select Configure from the File menu, then take the Email routeing option from the 
sub-menu that appears to display Turnpike's 'Email routeing to seats' dialog. Then click the Add button on
the 'Mailing lists' page of this dialog and then fill in the name, address etc. of the list in the 'Mailing list 
details' dialog that is then displayed and click OK. Just don't click the Send email button (or if you do, 
abandon any subscription message that Turnpike prepares for you to send).

You should then be able to add the mailing list to one of your newsstands in exactly the same way that 
you might add a newsgroup to the newsstand (see Setting up newsstands).

Click here for further information about the dialogs that are displayed.

Note: If you want mail you've already received from this mailing list to appear in the mailing list 
'newsgroup':

1. Export the mail
2. Delete it from your mailbox and empty the Waste basket
3. Then go into your Mailbox and import it as mail.

When the mail messages are re-imported, then assuming that the correct details have been set about the 
mailing list, Turnpike will spot that these items come from the mailing list and place them in the mailing list
newsgroup. (If the information that's been set about the mailing list isn't quite right, check the details set in
the Mailing list details dialog, then if necessary study the information on Custom Mailing List Rules given 
in this Help file.)



A Cross-posted article is one which has been set to appear two or more newsgroups (as distinct from 
an article which has been separately posted to a number of different newsgroups). The names of the 
newsgroups in which the article appears are listed one after another on the Newsgroups line of the article 
header, separated by commas.

With a cross-posted article, there is only one copy of the article, which once it has been read in one 
newsgroup is automatically marked as read in the other newsgroups in which it appears. Where an article
has been posted separately to a number of different newsgroups, you get multiple copies of the same 
article and there is no way of telling that you have already read the article until you open it. Such multiple 
posting is known as spamming and is very much frowned upon.



Custom Kill rules

IMPORTANT: Custom Kill rules aren't simple to define but fortunately they are only needed when it 
isn't possible to specify the articles you want killed through the other slots offered in the News Article Kill 
Rule dialog. If you definitely do need a Custom rule and the examples at the bottom of this Help page and
the other advice given doesn't enable you to work out the rule you need, we suggest you consult a 
suitable expert.

A Custom Kill rule lets you tell Turnpike how to identify a particular class of article you want to kill by 
giving it a 'pattern' to match against the headers of articles posted to the newsgroup.

Custom rules generally take the form:

/ pattern    / modifier

where the modifier (generally) specifies the part of the header that should be searched. (As you might 
expect, if you can tell Turnpike a particular part of the header to match the pattern against, the search will 
be quicker than if you ask it to match the pattern against the whole header of each article.)

In the case of Kill rules, the possible modifiers are:

h search every header line
s search the Subject: header line after "Re:" etc.
a search the author's address as extracted from the From: header line (starting after any angle 

brackets)
c the case of the characters (upper or lower) matters in matching the pattern 

(If no modifier is given or only c, then s is assumed, ie. just the Subject line is searched. You should also 
note that any header lines that have been 'wrapped' or 'folded' onto 2 or more physical lines are 
automatically 'unfolded' before they are searched: you don't have to allow for this wrapping/folding in your
rule.)

The pattern that you want Turnpike to look for needs to be expressed in the form of a 'regular expression' 
written using (fairly) standard UNIX syntax.

Regular expressions are not easy to specify. Unless you are expert in defining regular expressions, the 
best thing to do is to study the following examples, and pick out the one that most closely mirrors the type 
of rule you want to specify. (Note: If you would like a detailed explanation of any specific example, just 
click on it.)

If you can easily see how you need to modify the rule you pick out, all well and good. If you are unsure 
how to adapt this rule or you don't get the required result, study the section of this Help file on Defining 
Custom Rules. If you need further help, consult an expert!

Example Custom Kill rules:
To kill any article from fred@anycompany.com

/^fred@anycompany\.com$/a

To kill articles from anybody at anycompany.com
/@anycompany\.com$/a

To kill any article with "widget" in the subject
/widget/s



To kill articles from anybody at anycompany.com unless these have "widget" in the subject
/@anycompany\.com$/a & !/widget/s

To kill articles from tom, dick and harry
/^(tom|dick|harry)@/a

To kill articles, except those from tom, dick and harry
!/^(tom|dick|harry)@/a

To kill any article from a thread started by anybody at anycompany.com
/^References:\s*<[^<]*@anycompany\.com>/h

To kill articles with an X-Newsreader header (Note: This rule won't have any effect where Group access 
and a News Overview database are used)

/^X-Newsreader:/h

To kill crossposted articles
/^Newsgroups:.*,/h

To kill articles from people who shout
/[A-Z][A-Z]/c

To kill articles that were posted on a Friday
/^Date:\s*Fri,/h

To kill articles under 60 lines long (ie. between 1 and 59 lines long)
/^Lines:\s*[0-5]?\d$/h

Note: If you want to kill articles over a certain length, simply set the maximum length you want in the 
'Longer than' slot in the News Article Kill Rule dialog.



Custom Mail rules

The Addressed to, Sent from and Subject slots of the Distributing mail to mailboxes dialog and the 
Distributing mail to seats dialog let you set the criteria on which you are most likely to want to select the 
mail that is to be put into a particular mailbox or directed to a particular seat. But occasionally you may 
want to select the mail on some other criterion - in which case, you will need to set up the appropriate 
'custom rule' in the Custom rule slot of this dialog.

IMPORTANT: Custom Mail rules aren't simple to define but fortunately they are only needed when it isn't 
possible to specify the messages you want to select/reject on the basis of either their subject, their author 
or the email name to which the mail is addressed. If you definitely do need a Custom rule and the 
examples at the bottom of this Help page and the other advice given doesn't enable you to work out the 
rule you need, we suggest you consult a suitable expert.

A Custom Mail rule lets you tell Turnpike how to identify mail messages that you want to go into the 
mailbox you are setting up by giving it a 'pattern' to match against the headers and SMTP envelope of the
mail messages you receive.

Custom rules generally take the form:

/ pattern  / modifier

where the modifier (generally) specifies the part of the header that should be searched. (As you might 
expect, if you can tell Turnpike which part of the header it needs to match the pattern against, the process
of allocating mail to different mailboxes/seats will be quicker than if you ask it to match the pattern against
the whole header of each message.) There's also the possibility of searching the MAIL FROM and RCPT 
TO information given in the SMTP envelope of mail delivered by SMTP. (If the message was collected 
from a POP mailbox, Turnpike will use equivalent details constructed from information in the message 
header.)

The possible modifiers are:

h search every header line
s search just the Subject: header line after "Re:" etc.
a search the author's address, as extracted from the From: header line (starting after any angle 

brackets)
f search the 'Reverse Path' as taken from SMTP envelope MAIL FROM: (or equivalent information 

taken from the header)
t search the 'Forward Path' as taken from SMTP envelope RCPT TO: (or equivalent information taken 

from the header)
u search the username that results from taking the 'local part' of the Forward Path given by the SMTP 

envelope RCPT TO: and stripping it of any !host or %host parts
c the case of the characters (upper or lower) matters in matching the pattern 

(If no modifier is given or only c, then u is assumed, ie. just the username extracted from the SMTP 
envelope is searched. Also, the f modifier is principally of use in sorting mail that has come from a mailing
list. You should also note that any header lines that have been 'wrapped' or 'folded' onto 2 or more 
physical lines are automatically 'unfolded' before they are searched: you don't have to allow for this 
wrapping/folding in your rule.)

The pattern that you want Turnpike to look for needs to be expressed in the form of a regular expression 
written using (fairly) standard UNIX syntax.

Regular expressions are not easy to specify. Unless you are expert in defining regular expressions, the 
best thing to do is to study the following examples, and pick out the one that most closely mirrors the type 



of rule you want to specify. (Note: If you would like a detailed explanation of any specific example, just 
click on it.)

If you can easily see how you need to modify the rule you pick out, all well and good. If you are unsure 
how to adapt this rule or you don't get the required result, study the section of this Help file on Defining 
Custom Rules. If you need further help, consult an expert!

Example Custom Mail rules:
All mail addressed to fred

/^fred$/

All mail from fred@anycompany.com
/^fred@anycompany\.com$/a

All mail from anybody at anycompany.com
/@anycompany\.com$/a

All mail with "urgent" in the subject
/urgent/s

All mail from anycompany.com unless it has "urgent" in the subject
/@anycompany\.com$/a & !/urgent/s

All mail from Tom, Dick or Harry
/^(tom|dick|harry)@/a

All mail, except that from Tom, Dick or Harry
!/^(tom|dick|harry)@/a

All mail with an X-Mailer header
/^X-Mailer:/h



Custom Mailing list rules

IMPORTANT: Custom Mailing List rules aren't simple to define but fortunately you only need to get 
involved in the detail of these rules if you find that mail from the mailing list isn't directed to the mailing list 
by the default rule that Turnpike generates for you (see Email routeing: Mailing lists). If you find the 
following discussion difficult to follow, we suggest you consult a suitable expert.

A custom mailing list rule lets you tell Turnpike how to identify mail messages that come from a particular 
mailing list by giving it a 'pattern' to match against the header and SMTP envelope.

Custom rules generally take the form:

/ pattern    / modifier

where the modifier (generally) specifies the part of the header that should be searched. (As you might 
expect, if you can tell Turnpike which part of the header it needs to match the pattern against, the process
of allocating mail to different mailboxes will be quicker than if you ask it to match the pattern against the 
whole header of each message.) There's also the possibility of searching the MAIL FROM and RCPT TO 
information given in the SMTP envelope of mail delivered by SMTP. (If the message was collected from a 
POP mailbox, Turnpike will use equivalent details constructed from information in the message header.)

In the case of Mailing list rules, the possible modifiers are:

h search every header line
s search just the Subject: header line after "Re:" etc.
a search the author's address, as extracted from the From: header line (starting after any angle 

brackets)
f search the 'Reverse Path' as taken from SMTP envelope MAIL FROM: (or equivalent information 

taken from the header)
t search the 'Forward Path' as taken from SMTP envelope RCPT TO: (or equivalent information taken 

from the header)
u search the username that results from taking the 'local part' of the Forward Path given by the SMTP 

envelope RCPT TO: and stripping it of any !host or %host parts
c the case of the characters (upper or lower) matters in matching the pattern 

(If no modifier is given or only c, then u is assumed, ie. just the username extracted from the SMTP 
envelope is searched. You should also note that any header lines that have been 'wrapped' or 'folded' 
onto 2 or more physical lines are automatically 'unfolded' before they are searched: you don't have to 
allow for this wrapping/folding in your rule.)

The pattern that you want Turnpike to look for needs to be expressed in the form of a regular expression 
written using (fairly) standard UNIX syntax.

Regular expressions are not easy to specify but that's not the only problem. You also need to understand 
something about how mailing lists operate in order to be able to identify what Turnpike should look for. To 
assist, Turnpike automatically generates a 'default rule' which will work in many cases but by no means 
all.

To get any further, you need to study the following 'Discussion'. If you are unsure about what rule you 
need after reading that or you don't get the required result, study the section of this Help file on Defining 
Custom Rules. If you need further help, consult an expert!

Discussion:
Mailing lists are controlled by a Mailing List Manager (MLM).    The Mailing List Manager may be a person 



or a robot.    Messages are submitted to the list using a submission address whereas messages to 
subscribe etc. are sent to the control address.

Detecting mail from a mailing list is difficult as there are no standards governing the form of mailing list 
headers. The default rule Turnpike generates looks for any occurrence of the mailing list submission 
address in any of the following header fields: To:, Cc:, Bcc:, Resent-To:, Resent-Cc:, Resent-Bcc:.    
This usually works since these headers are usually retained from the author's original submission, ie. they
are not removed or replaced by the mailing list manager when the message is distributed to the list's 
subscribers.

However, this default rule can fail where:

1 A message you receive from the mailing list was initially sent to the control address rather than to the 
submission address.

2 The mailing list manager removes the original To: fields etc. when redistributing the message.

If the standard rule fails, you may be able to use one of the following approaches to identify the 
messages:

Look at the header of a sample message from the mailing list and see if it contains a Return-Path: line of 
the form

Return-Path: <local.part@domain>
or

Return-Path: <@something:local.part@domain>

where the local.part will probably bear some resemblance to the list name, eg. owner-list or list-errors or 
list-request.

Note: There will always be a Return-Path line in mail received by SMTP because it is automatically 
created from the SMTP envelope MAIL FROM, but it won't necessarily be present in mail received by 
POP because this doesn't have an SMTP envelope. A suitable Return-Path line may, however, have been
added by the SMTP server that delivered the message to your POP mailbox.

If you find a suitable Return-Path line, the custom rule to try is:

/[<:]  local  .  part  @  domain  >$/f  

where the local.part and the domain are those given in the Return-Path line. (Note: Any '.'s in the 
local.part or the domain need to be preceded by \ because . on its own has a special meaning.)

Alternatively, see if the mailing list manager adds its own Sender: line to the header.

If so the following rule can be used.

/^Sender[ \t]*:[ \t]*  local  .  part  @  domain  /h  

where local.part and domain are the ones given in the mailing list manager's Sender line. (Note: Again, 
any '.'s in the local.part or the domain need to be preceded by \ because . on its own has a special 
meaning.)

If these other approaches fail, try cancelling your current subscription, setting up a special email name for 
yourself (assuming you have the appropriate permission to do this), then re-subscribing under that name 



and making this name the key factor by setting it in the 'Addressed to' slot of the Mailing List Routing Rule
dialog.

Note: You will need to ensure that your special email name is used in both the 'From' line and the 'Reply-
to' line of your subscription message you send. (Click the 'Edit mail header' button shown above the 
message before you post it to ensure that the From and Reply-To line are set as you want.)

You should also note that even this won't work in all cases because some mailing list managers take the 
address on the 'Sender' line (which you can't change) as the address to which the mailing list mail should 
be sent.



Custom Rules: Formal syntax

A custom rule specifies one or more regular expressions to match against the relevant part of a message 
header. These matches are combined by the logical connectives and (&), or (|), not (!) and parentheses.

The format of each rule is as follows (expressed in BSI syntactic metalanguage):

rule = term, ["|", rule].
term = factor, ["&", term].
factor = "!", factor |

"(", rule, ")" |
"/", regular expression, "/" {modifier}.

modifier = "h" | "s" | "a" | "f" | "t" | "u" | "c".

Notes:
The regular expressions need to be expressed using the (fairly) standard UNIX syntax (see Regular 
expressions) and enclosed in "/" characters. To put "/" into the regular expression, you need to escape it 
with "\/".

The modifiers restrict how and where the regular expression is applied as follows:
h search every header line (Note: Any 'folded' lines are automatically 'unfolded' before they are 

searched) 
s search just the Subject: line after "Re:" etc.
a search the author's address, as extracted from the From line (starting after any angle brackets)
f search the 'Reverse Path' as taken from SMTP envelope MAIL FROM: (or equivalent information 

taken from the header) - mail messages only
t search the 'Forward Path' as taken from SMTP envelope RCPT TO: (or equivalent information taken 

from the header) - mail messages only
u search the username that results from taking the 'local part' of the Forward Path given by the SMTP 

envelope RCPT TO: and stripping it of any !host or %host parts - mail messages only
c the case of the characters (upper or lower) matters in matching the pattern 

Individual regular expressions plus modifiers may be further combined into patterns using & (and), | (or), !
(not) and parentheses.

White space - spaces and tabs - may occur anywhere except within the regular expression where spaces 
and tabs stand for themselves.



Cut and Paste editing
'Cut and Paste' describes the technique used to copy or move a section of text from one place to another 
within your messages.

To copy a section of text, mark out this text then either take the Copy option from the Edit menu or 
press Ctrl + C. Then place the cursor where you want insert the copy and either take the Paste option 
from the Edit menu or press Ctrl + V.

To move a section of text, mark out this text then either take the Cut option from the Edit menu or press 
Ctrl + X. Then place the cursor where you now want insert this text and either take the Paste option from 
the Edit menu or press Ctrl + V.

To delete a section of text, mark out this text then either take the Cut option or use one of the Delete 
keys.

Note: Copy, Cut and Paste are also available for editing text slots within dialogs - but note that in general 
you need to use Shift + Ctrl + C, X, V to select these actions (though in some instances Ctrl + C, X, V will 
work as well).



Cut lines
Lines starting with two or more dashes which are conventionally used to mark divisions between sections 
of messages - for example, between the main text and the signature.



Setting the way dates are shown

Among the information shown in mailboxes and mail lists is the date and time each message was sent or, 
if you pull the first divider across, the date and time the message arrived.

These dates and times can be expressed in several different ways, covering:
* The order of the date, the time and the day of the week (if included)
* The order of the day, the month and the year
* Whether to include the time and/or the day of the week
* Whether to express the month as text or as a number
* Whether to express the time using a 24-hr clock or a 12-hr one

So Turnpike provides a Date format dialog through which you can set how you would like the dates to be 
displayed on mail messages both in mailboxes and in the various mail lists you produce. One 'page' of 
this dialog sets the format to be used for 'Sent' dates; the other (similar) page sets for the format for 
'Arrived' dates.

If, when you look at a mailbox or a mail list, you decide would like to change how these dates are 
displayed, just call up the Options menu, take the Date format option, select the appropriate page of the 
dialog and make the choices outlined above. Each page of the dialog also includes an Example date 
shown in the format currently selected (so that you can instantly see the effect of the choices you make).



Dead letter mail

Dead letter mail is email that has been addressed using an email name that doesn't appear in the list of 
email names used on your system. The person who wrote the message may, for example, have used an 
email name that is no longer used eg. because the person concerned has left the company.

Where there's just one user of the system, all such mail automatically goes to that user, but where there 
are several users, someone needs to take responsibility for ensuring that this mail is directed to the right 
person. Indeed, Turnpike insists that at least one person is nominated to receive this mail.

Turnpike is initially set up to direct any such mail to the person who installed Turnpike (who is normally 
also the system administrator). But anyone with Email Admin permission can shift the responsibility for 
dead letter mail to another user by taking the Configure option from the File menu, selecting Email 
routeing from the sub-menu that appears to display Turnpike's Email routeing dialog, then switching to 
the Dead Letters page of this dialog. The Add and Del buttons on this page can then be used together 
with the list of users/workgroups on the left-hand side of the display to set up the required list of Dead 
letter recipients.

Note: The person (or people) nominated to receive dead letter mail automatically get an extra 'dead letter'
option on the Rules page of their mailboxes to allow them to specify which mailbox (or mailboxes) they 
want this mail put in. (If they set up more than one mailbox as a 'dead letter' mailbox, the dead letters will 
be sorted among these mailboxes following the mailboxes' rules, while any dead letters that aren't 
accepted by any particular mailbox will initially appear in all the 'dead letter' mailboxes. If, however, they 
don't make any of their mailboxes a dead letter mailbox, the dead letters will simply put into their default 
mailbox alongside other mail that isn't allocated to a particular mailbox.)

Also, if more than one person is nominated to receive this mail, any dead letter will initially appear in each
person's 'dead letter' mailbox but the moment someone processes it, it will disappear from everybody 
else's mailbox - just as with any other form of group mail.



Decoding encoded text

If part (or all) of an email message or a news article you open appears to be encoded, then in general 
either:
1. Some or all of the text of the message has had ROT13 encoding applied to it - usually to conceal 
material of dubious taste from people who might be offended by it.
2. The message contains a file which has been 'uuencoded' in order to allow this to be sent as text 
(though not using one of the standard formats that Turnpike automatically recognises and presents as a 
file). In this case, the encoded section will be introduced by a note giving the filename and the encoder 
that has been used.

Where text has been encoded using ROT-13 (looks like gobbledygook when displayed): just select the 
text that has been encoded, then take the ROT-13 option from the Edit menu.

This in fact applies ROT-13 encoding to the selected text but because the encoding simply advances 
each letter 13 places through the alphabet (changing a to n, b to o etc.), encoding the text again 
advances each letter another 13 places (n to a, o to b etc.) which takes it back to its original position - 
thus decoding it. (Indeed, if you mistake some other text encoding for ROT-13, simply applying ROT-13 
encoding again will restore the original encoding.)

Where something within a message or article has been uuencoded: simply take the Decode option from 
the File menu.

Note: If the file that was uuencoded was at all large, it may have been split over a number of messages 
(marked eg. [1/12], [2/12] etc.). Where this has happened, close the current message, select all the 
messages in the sequence, then take the Decode option.

Click here to find out about encoding parts of your own messages and postings.



Default mailbox
The default mailbox is the mailbox that Turnpike initially sets up for you. Any mail which isn't selected for 
inclusion in one of your other mailboxes is automatically put into your default mailbox.

It also acts as the 'seed' for the way in which your newsstands and your other mailboxes are configured 
with regard to the User information given in message headers; the signature and attribution text used in 
messages you prepare; and the fonts & colours used to display and print messages you both send and 
receive. Changing the print font (say) used in your default mailbox automatically changes this in all your 
newsstands and mailboxes, except where you've specifically set a different print font. So if there's a 
particular font (or whatever) that you want to use across all your mailboxes and newsstands, the place to 
set this is in the default mailbox.



Defining Custom Rules

Custom rules can be used in various areas of Turnpike to specify which messages or articles you want 
Turnpike to pick out.

However, Custom rules aren't easy to define, so the first thing to do is to check that actually need a 
Custom rule - ie. that you can't tell Turnpike which messages or articles to pick out through the standard 
options offered in the Distributing Mail to Mailboxes dialog; the Distributing Mail to Seats dialog; the News 
Article Kill Rule dialog; or the Mailing List Routing Rule dialog as appropriate.

Then because it is always easier to work from examples, you should study the examples given in the 
section on Custom Mail rules; Custom Kill rules; or Custom Mailing List rules as appropriate and see if 
you can't find an example that you can adapt to suit your requirements.

It's only when that fails that you need the following information...

(If you simply wish to see the formal syntax for Custom rules, click here.)

The basic form of a Custom rule is:

/ regular-expression / modifier

where the regular-expression gives the pattern that Turnpike needs to look for (expressed using (fairly) 
standard UNIX syntax), and the modifier defines how the pattern should be applied, typically in terms of 
the part of the message header that should be searched. (Details of the modifiers that can be used in 
each case are given in the appropriate 'Custom rule' section: see above.)

The pattern is compared against individual header lines, taken one by one from the headers of the 
messages being filtered. In general, the comparison is made against the whole of the header line, but if 
the modifier specifies that just the author's address is searched, the pattern you give is just compared 
with the section of the From: header line after any angle bracket. Similarly, if just the Subject line is 
searched, the pattern is only compared with the section after any Re: that may be included in this line.

The required regular expression is most easily constructed if you think of it as defining the sequence of 
characters, tabs, spaces etc. that you want Turnpike to look for.

Where you want Turnpike to look for a letter, a digit or a space, you just need to put this character at the 
relevant point in your regular expression. For example, if you want it to look for an a, you simply need to 
insert an a in your regular expression. If this a should be followed by an n, you simply need to follow the a
in the regular expression by an n - and so on, up to as many characters as you need. So you want 
Turnpike to look for a particular name, word or phrase, the regular expression you need is just this name, 
word or phrase.

Punctuation marks or other symbols, however, can't always be simply inserted in the regular expression 
because some of these have special meanings in regular expressions. The characters with special 
meanings are:

/    |    ^    $    *    +    ?    .    \    -    (    )    [    ]

When you want Turnpike to look for one of these characters, you need to precede the character with a \ . 
The prime example of this is where you want Turnpike to look for a particular email address such as 
anybody@turnpike.com. This has to be written as anybody@turnpike\.com because . on its own has a
special meaning.



If the section you want Turnpike to match includes any tabs, these need to written as \t. Note: The full 
syntax for regular expressions also specifies character combinations for carriage return, line feed and 
form feed but you won't need to use these even where the header line you are interested in has been 
either wrapped or 'folded' onto 2 or more physical lines because Turnpike automatically 'unfolds' any such
lines before searching these.

Rather than specify a particular character at some point in your regular expression, you may want the 
pattern to match any one of a number of different characters. If there are no restrictions on what this 
character should be, the way to write this is as a . (this is the special meaning that . has). But if only 
certain characters are acceptable, you need to give a list of the possible characters within a pair of square
brackets. For example, [ab] tells Turnpike to accept either an a or a b, while [ \t] tells it to accept either a 
space or a tab. (Note the space before the \t within the brackets.)

However, if a range of characters is acceptable, like any letter between m and t or any digit between 2 
and 8, you don't have to list every character but instead you can write this as [m-t] or [2-8] (the 
commonest examples are of course [a-z] or [A-Z] for any letter and [0-9] for any digit). If it's easier to 
specify what a character mustn't be, then you can specify this by preceding the list of characters with a ^ 
as in [^ab], [^m-t] or [^2-8].

As well as specifying individual characters, you may also want to specify for example 'one or more' of a 
particular character. This is done by following the character by +, * or ? as follows:

+ One or more of the preceding character
* Zero or more of the preceding character
? Either zero or one of the preceding character

For example to specify one or more spaces or tabs, you write [ \t]+

(Requirements like 'two or more' are specified by using characters marked with the above symbols in 
combination with further copies of the same character. For example if you wanted to specify a one- or 
two-digit number, you would use [0-9][0-9]? (or [0-9]?[0-9]) - the ? specifying that there should be either 
one or none of the character that precedes it.)

Another thing you may want to specify is a number of alternatives for a section of the pattern. For 
example, you might want Turnpike to pick out mail from either tom or dick or harry@turnpike.com. To 
put such a set of alternatives into the regular expression, you write the patterns for the different options 
one after another with | characters between them and then put them in parentheses to group them. Thus 
our 'tom or dick or harry' example is expressed as (tom|dick|harry)@turnpike\.com.

(Should you need the same one of these alternatives to be matched elsewhere in the header line that's 
being searched, you can specify this as \n where n is the number of the grouping (in case you have more 
than one of these in the expression). For example, if (tom|dick|harry) was the second grouping in a 
regular expression, you could specify that you wanted the same one of tom, dick or harry later in the 
pattern by putting \2 at the relevant point in the regular expression.)

The other thing you can specify through the regular expression is whether the matched section should be 
at the start or the end of the header line that is searched (or perhaps both). If the match needs to be from 
the beginning the section, start your regular expression with a ^. If the section that's being searched 
needs to finish after the last character picked out by the pattern, finish your regular expression with a $. 
For example, ^Lines    will pick out a header line that starts Lines, while \.com$ will pick out a header line
that finishes .com. 

Last but not least, as well as writing individual rules of the form / regular-expression / modifier, you can 
also write combined rules. The basic options are:



To say both rule1 and rule2 must be true, you need:
/expression1/modifier1 & /expression2/modifier2

To say rule1 or rule2 must be true, you need:
 /expression1/modifier1 | /expression2/modifier2

To say 'not this rule', you need:
 !/expression/modifier

These can themselves be further combined using &, | and parentheses for grouping, to set up criteria 
such as:

/expression1/modifier1 & !/expression2/modifer2

(ie. rule1 but not rule2) - to whatever level of complexity you require.



Deleting sections of text

To delete a section of text from the message you are preparing, highlight this text then either

* Press Del to delete it, or
* Simply type whatever you want to replace it by, or
* Select Cut from the Edit menu (or press Ctrl + X) to move it to the Windows clipboard.

(The advantage of the last method is that you can readily recover the text or move it to some other part of 
your message - up to such time as you use the Copy and Cut options to copy or move other text to this 
clipboard.)



Deleting unwanted mail

The mail you receive should in general be filed so that if, at some future date, you want to retrieve it - you 
can.

However, if your mail includes any items that you really don't want to keep, you can throw these away 
either by selecting them, then clicking the Delete Message button on the toolbar or by dragging them to 
your Waste basket.

Note: Items you throw away are only actually deleted when you leave Turnpike - or if you click the Empty 
button shown when you go into the Waste basket. In fact, any items in the Waste basket that are 
'mirrored' from a POP mailbox are only deleted when you next pick up mail from this mailbox (because it's
only at that point that these messages get deleted from the POP mailbox). Up to that point, you can 
recover any items you have thrown away by accident by displaying the contents of the Waste basket and 
then dragging the item to the appropriate mailbox.



Digests
A news article or an item from a mailing list can be made up of a series of 'Digest messages'. Such an 
article is known as a Digest.

This format is most frequently used for FAQs and other such articles which cover a number of separate 
points.

When you open such an article, Turnpike will present the Digest messages as separate sections, each 
with its own toolbar. These toolbars include 'Next' and 'Previous' buttons to give you a quick route from 
enclosure to enclosure (or you can use Ctrl G to step to the next section). They also include Hide and 
View buttons to let you open and close Digest messages as you require.

There's currently no automatic facility for generating digests within Turnpike.



Discussion threads

Many of the articles that appear in a newsgroup have been contributed in response to articles that were 
previously contributed to that newsgroup. These articles themselves generate responses from other 
readers and so on.

Taken together, the original article plus all the different 'Follow-up' articles posted in response represent a 
discussion on the topic of the original article.

There's a convention whereby any 'Follow-up' article includes the details of the article to which it is a reply
in a 'References' line in its header - plus, where appropriate, the details of the article to which that was a 
reply and so on. Where this convention has been correctly followed (and this is something that Turnpike 
automatically ensures when you tell it you want to post a Follow-up article), it is possible to follow the 
'thread' of the discussion from the one that started the discussion through all the different replies.

Following a thread in this way enables you to make sense of all the different contributions that have been 
made on the topic. So before you go into a newsgroup, Turnpike automatically looks at the headers of all 
the articles that have been contributed to that newsgroup and works out all the different discussion 
threads they represent so that you can follow any discussion thread that you wish. It also provides special
'Next' and 'Previous' options by which you can work either up or down through the different articles that 
have been contributed.

Note: As you might imagine, very few discussions comprise a simple sequence of one article replied to by
another which is in turn replied to the next. Usually a number of people reply to any individual article and 
their articles are themselves replied to by one or more people. As a result, the overall discussion becomes
more like a tree, with each branch of the tree follows one thread of the overall discussion. This is reflected
both in the way Turnpike shows the sequence of articles and in the options you select when you want to 
see the articles that make up the different discussions listed for any group - Expand tree and Expand all 
trees (with corresponding Collapse tree and Collapse all trees options when you no longer want to see 
the discussions in such detail).

In general the links in the tree are shown as solid lines, but where there wasn't a specific References line,
the connection to the previous article is more tentative and so is shown as a broken line.



Displaying the header

Each message or article you receive has at its top a number of lines of system administration details 
which record such things as the message's ID number and the route the message took, alongside more 
useful information such as who the message is from and when it was sent.

There's usually no need to know much of the information included in this 'header', so Turnpike normally 
just shows the main part of any message or article you open on the screen, together with a few basic 
details such as the author, the subject and the date which it filters out from the header. Turnpike also 
automatically shows if the message / article has been copied to other people or cross-posted to other 
newsgroups or if there are special reply-to / follow-up instructions.

But you can, if you want, display the full header at the start of the message you are reading by selecting 
the Display Header option from the Options menu. (Selecting this option again will turn off the display.)

Note: If you opt to display the header on one message and then step on to another message using either 
'Next unread', 'Next/Previous in group' or the 'Search' procedure, then the header of the new message will
also be shown. But if you close the current message then open another, the display will automatically 
revert to the standard 'header-free' form.



Displaying the contents of a mailbox

The way to display the contents of a mailbox is simply to double-click its icon (if this is visible on the 
Turnpike screen) or to select it from the list of windows given in the Window menu.

You can then double-click on individual messages to read them, or carry out a range of other actions.

Note: If you would like the dates of the different items to be displayed in a different date format, you can 
change this: see Setting the way dates are shown.



'Distributing mail to mailboxes' dialog

This dialog lets you set up the rules governing the type of mail that you want in the mailbox you are 
setting up. It is called up by taking either the Add option or the Alter option from the Rules page of the 
Mailbox dialog.

Each use of this dialog sets one rule.

The top part of the dialog lets you set whether the rule is to Accept or Reject messages. The second part 
of the dialog lets you set precisely what you want to accept or reject.

There are three main aspects of a message that you will be interested in:
* The email name to which it was addressed
* The email address of the person who sent it
* The Subject line of the message

For these, you just need to select the appropriate option within the dialog, then enter the appropriate text 
for Turnpike to match.

If you want Turnpike to select on some other aspect of the message header, you can specify this by 
selecting the 'Custom rule' option and setting up the appropriate rule - though be warned: this is highly 
'techie' stuff.



'Distributing mail to seats' dialog

*** Only important on shared systems ***

This dialog lets someone with Email Admin permission specify that a particular type of mail needs to be 
routed either to or away from a specific user (or users), against the normal run of how such mail is 
distributed.

It is called up by taking either the Add option or the Alter option from the Rules page of the Email 
Routeing dialog.

Each use of this dialog sets one rule.

The top part of the dialog is used to record which users are affected by the rule that's being set. To set 
this, click the Edit button, then use the Add and Del buttons within Destination dialog that is displayed to 
set up a list of the individuals / workgroups that are to be affected.

The next section of the Distributing mail to seats dialog is used to set whether these users are to Accept 
or to Reject the specified messages.

There are three main aspects of a message that you will be interested in:
* The email name to which it was addressed
* The email address of the person who sent it
* The Subject line of the message

For these, you just need to select the appropriate option within the dialog, then enter the appropriate text 
for Turnpike to match.

If you want Turnpike to select on some other aspect of the message header, you can specify this by 
selecting the 'Custom rule' option and setting up the appropriate rule - though be warned: this is highly 
'techie' stuff.



List name Stamp collectors 
Label SE England
use/hasMIME blank
index list Stamps

List

Entry in 'To' slot
Email address Penny Black <penny@rainbow.co.uk>
useMIME blank
cc/bcc blank

Entry in 'cc' slot
Email address julieb@firstday.co.uk
useMIME blank
cc/bcc cc

Entry in 'bcc' slot
Email address "A.N.Other" <nowhere@to.be.seen>
useMIME useMIME
cc/bcc bcc

Record (with actual carriage returns marked CRLF):
CRLF
Stamp collectors, SE England, , "Stamps, List"CRLF
Penny Black <penny@rainbow.co.uk>CRLF
julieb@firstday.co.uk, ,ccCRLF
" " "A.N.Other" " <nowhere@to.be.seen>, useMIME, bccCRLF



Distribution lists
A distribution list is simply a list of the email addresses of the people who should receive copies of 
particular mail messages - divided into main recipients, recipients of carbon copies and recipients of 
'blind' carbon copies. Turnpike lets you store these details as a single entry in your Address book to give 
you a quick way of picking out all their details at once. For information, click here.



Email distribution

*** Only important on shared systems ***

Turnpike automatically arranges that mail addressed using any of the email names used at your site is 
delivered to the person or persons that own that email name, while mail addressed using any other name 
is given to whoever is currently nominated to handle dead letter mail.

If this is how the mail should be delivered, nothing needs to be done. But the option exists for people with 
Email Admin permission to arrange for certain types of mail to be delivered specially.

To arrange this, you need to take the Configure option from the File menu, then select Email routeing 
from the sub-menu that appears. When the Email Routeing dialog appears, you need to click on the 
Rules tab to display the Rules page of this dialog.

Then for each special rule that you want Turnpike to apply, you need to click the Add button and use the 
Distributing mail to seats dialog that is displayed to both specify the type of mail that is to be handled 
specially and the user or users to whom this mail is to be delivered.

The rules you set up are added to the list on the Rules page of the Email Routeing dialog. If you set up 
several rules, you may need to use the Move Up and Move Down buttons to put these into the correct 
order, because Turnpike acts on the first rule that applies. So if, for example, you want mail from Peter 
Smith to go to Joe Bloggs except when it's on a particular topic, you need the rule about the topic above 
the rule about mail from Peter Smith so that it's not ignored.

If you need to change or delete any of the rules you set up, select the rule then click Alter or Remove as 
appropriate.



Download options for news

The volume of articles contributed to newsgroups - both in number and in size - is such that the contents 
of even just a few newsgroups can take a long time to copy down the phone-line to your disk and take up 
quite a lot of disk space. Moreover, much of what you download could be articles on topics that you aren't 
actually interested in.

To help you make best use of your disk space (and minimise your phone bill), Turnpike offers the choice 
for each newsgroup of:
* Downloading the articles in full
* 'Browsing' the group - whereby just the header of each article is downloaded.

Turnpike will also filter newsgroups that you download in full against any set of Kill rules that you set up 
for the group. If an article is excluded by any of these Kill rules, just its header will be downloaded.

If you expect to find the majority of articles in this group interesting, you should obviously opt to download 
this newsgroup in full - but if the group discusses topics which are only of marginal interest, it is better to 
browse the group. Then Turnpike will just download the headers of the articles contributed to this group, 
which saves a considerable amount of disk space while still allowing you to see whether there is anything 
of interest to you. If you spot an article you do want to read, you can request it to be downloaded the next 
time you go on-line to the Internet (see Requesting missing articles). Also, you can specify kill rules to 
accept automatically certain types of articles in full, even though only the headers of other messages are 
downloaded.

Note: It is possible for articles to appear in full in newsgroups that you have set to browse and for just the 
header of an article to appear in a newsgroup that you read in full. Click on the relevant topic for an 
explanation.



Downloaded email not found
Turnpike takes special care to ensure that email is filed safely after being downloaded. If you see an 
email message reported as downloaded by Connect, but you cannot find it in any of the mailboxes on 
your system, check the following points:

* A long email (e.g. containing a picture) that has been sent to you in separate parts will, whenever 
possible, be reassembled into a single email by Turnpike once the final part has arrived. So, for 
example, 8 messages seen arriving in Connect could collapse into a single email in your In tray.

* If a mailing list to which you are subscribed has been setup as a newsgroup, you will see messages 
arriving as email in Connect but being counted as news in Turnpike. If duplicate messages are sent to
you in person as well as to the mailing list, Turnpike may recognise the duplication and send the 
spare email to the Waste basket (where it can be inspected) rather than to a mailbox.



Dragging
Dragging is a standard Windows technique.

To drag an item, you simply move the mouse pointer to the item, hold down the mouse button and then 
move the pointer to the part of the screen to which you want to take the item.



'Edit Email Tags' dialog

This dialog is used to modify the range of tags in use on your system - either by adding new tags, 
removing tags you no longer require or changing either the name or the access details of existing tags.

It is called up by taking the Configure option from the File menu, then selecting Email tags from the 
submenu that appears.

The main part of the dialog is a list of the tags that have been set up so far:
* To add a new tag to this list, click the New tag button
* To change either the name or access details of a tag, select this tag in the list (eg. using the Find options
at the top of the dialog) then click the Edit button
* To remove a tag you no longer require, select the tag as above then click the Remove button

(Note: Restoring a tag that you remove by accident would not be not an easy task, so Turnpike will only 
let you remove tags that are no longer applied to any messages.)

Both clicking the New tag button and clicking the Edit button call up a further dialog through which the 
details of the tag is set. Click here for information on this further dialog.



'Edit Sign-on Details' dialog

This dialog lets you set or change the details of the user associated with a particular seat on your system.

The basic (non-administrator) version of this dialog is called up by taking the 'Configure Users' 
option from the File menu and has the following entries:

Sign on: Slot for the user's sign-on name.

Full name: Slot for the user's full name.

Password: Slot for the user's password. The current password (including no password) is shown as a 
sequence of asterisks here. A new password can be simply typed over the current password: This will 
also be shown as a sequence of asterisks.

Enable Sign-on dialog: Selecting this option causes a Sign-on dialog to be shown when either the main 
Turnpike program or the Connect program is run from this machine. It is automatically selected when any 
password is set. It should also be selected where more than one person uses the same system so that 
the users can sign on individually and so get to see their own personal mailboxes and newsstands. (For 
more information, see Enabling the sign-on dialog).

Last use: When this user last signed on (if they have done).

Seat #: The number of the 'seat' this user occupies (for information only: which seat someone occupies 
makes no difference to the actions they can take).

Use default ratings: Shows whether which newsgroups this user sees is governed by the default set of 
ratings or a special set.

Ratings: Click this button to show the details of the ratings applied to this user - and, if you have Ratings 
Admin permission, to change these.

The full version is called up by first taking the 'Configure Users' option from the File menu, then 
clicking the Edit button within the Configure Users dialog. This has additional slots for:

Also Email name: If this check box is selected, the user has their sign-on name as one of their email 
names; clear the box if you don't want the sign-on name to be also used as an email name.

Notes: Slot for any additional information about the user that you might wish to record eg. which 
department they work in.

Administrator,etc.: The different administrative tasks that the user will have permission to carry out 
without reference to the system administrator.



'Edit Tag' / 'Make New Tag' dialog

This dialog lets you set both the name of a tag and the type of tag it is. It is called up either by taking the 
New tag option within the Tag Selection dialog or by taking either the Edit or the New tag option from the 
Edit Email Tags dialog.

If you are the sole user of your system, you just need to set the name of the tag.

On a shared system, you also need to set the Type of Tag. In general terms, 'Private' tags are for personal
use; 'Group' tags are for use by a workgroup; while 'Public' tags are for general use - and you simply need
to select the appropriate option for the tag you are setting up. But there may be instances in which you 
may wish to give other users or workgroups access to mail marked with a particular tag, so the dialog also
includes an Access button which calls up an Alter usage dialog through which you can set up a list of 
other users.

Click here for further information on Public, Private and Group tags.



'Edit Workgroup Details' dialog

*** Only relevant on shared systems ***

This dialog lets you set the name and the membership of a workgroup. It is called up by clicking either the
Create button or the Edit button within the Administer workgroups dialog.

The name of the workgroup is set in the Name slot at the top of the dialog.

The list of the users who are to be members of this workgroup is built up in the list of Current members 
(the right-hand of the two lists) by 'adding' names from the left-hand list of All users (using the Add and 
Del buttons between the two lists).

The Administrator,etc options shown at the bottom of the dialog represent the different administrative 
tasks that members of this workgroup will have permission to carry out by virtue of their membership of 
this workgroup.

If the ALL workgroup is being edited, the dialog also includes a Ratings button through which you can 
see - and, if you have Ratings Admin permission, set - the default ratings controlling which newsgroups 
users of your system will normally be able to see.



Edit menu

Undo
Redo
Cut
Copy
Paste
Select All
Delete
Find
Replace
ROT-13

Note: For general information about editing messages, see Preparing News/Mail.



Edit menu: Copy
Works with Cut and Paste to provide the actions needed for 'Cut & Paste' editing - that is, copying or 
moving sections of text either from one place to another within a message or between one message and 
another.

Copy simply copies the currently selected text to the clipboard.

Quick keystroke: Ctrl + C

See also: Cut and Paste



Edit menu: Cut
Works with Copy and Paste to provide the actions needed for 'Cut & Paste' editing - that is, copying or 
moving sections of text either from one place to another within a message or between one message and 
another.

Cut deletes the currently selected text and copies it to the clipboard.

Quick keystroke: Ctrl + X

See also: Copy and Paste



Edit menu: Delete
Deletes the currently selected text.

Quick keystroke: Del

See also: Cut



Edit menu: Find
Lets you move directly to a specific word or phrase within the message you are working on. See Find and 
Replace.

Quick keystroke: Ctrl + F

See also: Replace



Edit menu: Paste
Works with Cut and Copy to provide the actions needed for 'Cut & Paste' editing - that is, copying or 
moving sections of text either from one place to another within your messages or between one message 
and another.

Paste inserts the current contents of the clipboard at the position of the cursor.

Quick keystroke: Ctrl + V

See also: Cut and Copy



Edit menu: ROT-13
Applies ROT-13 encoding to the selected text. This advances each letter by 13 (replacing a by n, b by o 
etc.)

For further information, see Encoding messages

Note: A second application of ROT13 encoding decodes encoded text.



Edit menu: Redo
Redoes the 'Undo' you've just made.

Repeated use works back through any sequence of 'Undo's you've made.

Quick keystroke: Ctrl + A

See also: Undo



Edit menu: Replace
Lets you replace instances of a particular word or phrase with another throughout the message you are 
currently working on. See Find and Replace.

See also: Find



Edit menu: Select all
Selects the whole text of the message/article you are currently working on.



Edit menu: Undo
Undoes your last editing action (typing, deleting etc.).

Repeated use works back through all the different edits you've made.

Quick keystroke: Ctrl + Z

See also: Redo



Editing tags

Tags are markers that can be added to mail messages to allow them to be picked out in lists of items of 
mail on particular topics. On shared systems, they can also be used to give access to items of mail to 
selected groups of users (see Allowing access to mail).

To change either the name of one of your tags or the range of users who have access to mail marked with
this tag, select the Configure option from the File menu, then take the Email tags option from the 
submenu that appears to display the Edit email tags dialog.

This dialog gives a list of all the tags that have been set up, together with buttons for editing or removing 
these tags - or for setting up new tags. Simply select the tag you want to change from this list (for 
example by using the   Find   option   at the top of the dialog), then click the Edit button.

This displays the Edit tag dialog - which is just like the Make New Tag dialog used to set up the tag in the 
first place. Here you can change the name of the tag (by editing the current name) - and the type of tag, if 
appropriate (see Allowing access to mail).

If that's all you want to change, simply click OK - but if you want to change or extend the list of people 
who will be able to see messages marked with this tag, you should click the Access button and use the 
Alter Usage dialog to amend this list.



Preparing News/Mail

Introduction

How to ...
Start preparing a mail message
Start preparing a news article
Move sections of text around
Delete sections of text
Replace words and phrases
Undo/Redo changes
Show/Set margins and tabs
Use a different signature
Save your current signature
Make changes to the message header
Print the message you've prepared
Preview before printing
Include a file stored on disk
Include a copy of a message you've received
Encode your message

Buttons & menus:
Buttons
File
Edit
Signature
Options
Window
Help



Editor toolbar

Look up address (Mail messages)
Lets you pull in any email addresses you need from your Address book. For more information, see Taking
addresses from the Address book

Address book (News articles)
Calls up your Address book.

Post
Click this button when you have finished preparing the mail message / news article you are working on to 
send it to the recipients you've specified for it.

Abandon
Click this button if you decide you don't after all want to post the mail message / news article you've been 
preparing. It will be sent to the Waste basket and will be lost when you exit Turnpike.

Insert file
Lets you insert a file into the mail message or news article that you are preparing. For further information, 
see Including files.

Change signature
Lets you replace the signature currently on the bottom of the message / article you are preparing by one 
of the other signatures that you have stored on disk. For more information, see Signatures.

Start new email
Sets up a new email message for you to send. (Click here if you would like further information on Sending
mail.)

Edit mail/news header
Displays a dialog through which you can set aspects of the Header of the message you are currently 
preparing. When you are preparing a Mail message, the aspects you can set are the ones appropriate to 
Mail messages. When you are preparing a News article, the aspects you can set are the ones appropriate
to News articles.
If you want to know more about these dialogs, either click here for information about the Mail Header 
dialog or here for information about the News Header dialog - or press F1 to call up this Help file when the
appropriate dialog is on the screen.

Newsgroup selection (News articles)
(Disabled in this version)



Editor: Undo/Redo changes

To undo the last change you made to the message you are preparing, take the Undo option at the top of 
the Edit menu (or press Ctrl + Z). To undo the change you made before that, just repeat this process - and
so on through all the changes you've made.

To redo the undo you've just made, take the Redo option immediately below the Undo option (or press 
Ctrl + A). Taking this option many times will reverse a sequence of 'undo's.



'Email Names' dialog

This dialog is called up by taking the Configure option from the File menu, then selecting Email names 
from the submenu that appears.

The main part of the display is a list of the names currently being used as email names.This will usually 
be a mixture of sign-on names, workgroup names and any additional email names that have been set up. 
(The names are listed on the left; the 'origin' of each name is shown to the right.)

Assuming you have the appropriate permission:
* The Create button will let you set up further Email names, at least for yourself.
* The Edit button will let you change the details of additional Email names that have already been set up 
(either the name itself or, on a shared system, the range of people who can use this name)
* The Remove button will let you remove additional Email names

Both editing an existing email name and creating a new email name call up a further 'Usage of email 
name' dialog. For information about this dialog, either click here or press F1 to call up this Help file when 
the dialog is on the screen.

Note: You can't remove a sign-on name or a workgroup name from this list of email names or change 
how it is used. To change or remove these, you need to take the Users or the Workgroups option from the
Configure menu and make the changes you want in the dialogs these options display (assuming you have
the appropriate permission).



Email addresses

Email addresses on the Internet are made up of a 'Local part' followed by @ and then the 'Domain name' 
of the site through which they access the Internet.

The Local part is usually just an 'Email name' (though it may be more complex than that if the recipient 
uses a service like MCIMail or Compuserve which has a gateway onto the Internet).

The Domain name will have two or more parts to it, separated by dots, showing how the site fits into the 
Internet's Domain structure.

The last section of this name is the top level domain to which the site belongs. This represents either the 
type of organization to which the site belongs (eg. com for commercial company, edu for educational 
establishment) or the country in which it is located eg. uk for the UK. (In this latter case, the immediately 
preceding section of the name then shows the type of organization.)

The rest of the address (again working from the end) gives the name of the organization, plus where 
appropriate, the name of a particular division within that organization. So for example, the people at 
Turnpike have addresses of the form name@Turnpike.com (because it's a company), while people 
working in the Biophysics Department of Oxford University in England have addresses of the form 
name@biop.ox.ac.uk.

Your main source of correct email addresses will be the messages sent to you, which you will be able to 
copy either directly from the messages or from the Address Book Turnpike maintains for you. Your other 
main source will probably be business cards and office stationery.

If you don't know the email address to use for someone, the best thing to do is usually to ring them and 
ask. But do be sure to get their full email address - not the email address used around their office network
- and to get the form of this address for use on the Internet (though if someone does give you their 
Compuserve address (for example), you may be able to translate this into an Internet address).



If you are collecting email by POP3 and choose the Mirror option, any email that you delete or file in 
Turnpike will be deleted from the server next time you connect to your Access provider. When you do this,
Connect may report a number of messages being deleted. This is not a cause for concern - the messages
are those you have dealt with (either by filing or by deleting on your own machine) and not new ones.

If you have Mailing Lists setup as newsgroups, you may be surprised to see a large number of messages 
being deleted from the server in this way. Such mail has never entered your Turnpike mailbox, so all 
these messages are being deleted from the server to ensure that it continues to be an accurate mirror of 
the contents of your Turnpike mailbox.



Email names
An email name is simply the 'name' used before the @ in an email address to identify the person or group
of persons to whom the email message is being sent.

These names can include digits and some punctuation marks but can't include spaces or commas.

Some Internet Service Providers give users several email names and some, such as Demon, allow users 
to make up an unlimited number of names. For example, a Demon customer called Thomas B Smith 
could use the names tbsmith, tomsmith, tom, thomas etc. - but these need to be recorded in Turnpike 
first: see Adding Email Names.

They are usually written using only lower case letters (because some systems require this). They also 
need to be different from the names used by any other user on your system.



Email routeing: Mailing lists

The Mailing lists page of the 'Email routeing to seats' dialog is available to anyone with List Subscribe 
permission to record the mailing lists that you subscribe to and to add, alter or remove further lists as 
required.

It is called up by taking the Configure option from the File menu, then selecting Email routeing from the 
sub-menu that appears.

To subscribe to a new mailing list, click the Add button.

This displays the 'Mailing list details' dialog, for you to fill in the details of the mailing list to which you 
want to subscribe.

The main details you need to supply - the name of the list, its email address and the type of list it is - 
should be clear from the information you have about the mailing list. (The type of list should be clear from 
the control address you are told to use: a Listserv list will have the word listserv in this address; a 
Majordomo list will have majordomo in the address.)

In most cases, the only other thing you need to do in this dialog is click the Send email button to request 
that the relevant subscription message is sent. (This message will appear when you leave the Email 
routeing dialog, for you to check that the message has the form required by the mailing list, then click the 
Post button.)

However, particularly if the list doesn't use either Listserv or Majordomo, you may need to set special 
rules about how messages from the mailing list are identified. Where this is the case, you will need to 
select the Special routeing rules option towards the bottom of the dialog, then click the Alter button. 
This displays a 'Mailing list routeing rule' dialog in which you can set any special rules about the 
headers the mailing list's messages will have.

Often this involves setting up a 'Custom' rule which isn't easy - so to help you, Turnpike automatically fills 
in the Custom slot with the most likely form of rule you'll need. If you find that this rule doesn't give the 
required results, click here for information on setting up an appropriate custom rule.



Enabling the sign-on dialog

If you are the sole user of Turnpike on your PC, there's no doubt about which set of mailboxes and 
newsstands need to be displayed and so no need for you to 'sign on'. If, however, your system is shared 
with other people, you need to be able to tell Turnpike which user is about to use the system so that the 
correct set of mailboxes and newsstands are displayed.

The way this is done is by 'enabling the sign-on dialog' for each and every user of the system. If this 
dialog isn't enabled, anyone who runs Turnpike on your machine will effectively sign-on as you and use 
your files This dialog also needs to be enabled if you want to protect your files against anyone else 
reading them by setting a password.

To enable the sign-on dialog, take the Configure option from the File menu, then select Users from the 
sub-menu that appears.

The dialog that you then see depends on the range of permissions you have - in particular, whether you 
have 'Alter Users' permission.

If you have this permission, you'll see a list of the users on the system, from which you need to pick out 
the entry for yourself then click the Edit button to call up the Edit sign-on details dialog. You then just 
need to select the Enable sign-on option in this dialog.

If you don't have Alter Users permission, then you go straight to a personal version of the Edit sign-on 
details dialog in which again you just need to select the Enable sign-on option.

Note: If you ever find that you go straight into someone else's system, then the way to get to your files is 
to call up their Edit sign-on dialog as described above, select the Enable sign-on option, then exit from 
Turnpike. The sign-on dialog will appear when you re-load, allowing you to sign-on as yourself. (If the user
concerned has Alter Users permission, it won't be instantly obvious which user you have signed on as - 
but you can work it out from the Last use dates shown in the Configure Users dialog. Pick the user with 
the most recent Last use date.)



Encoding messages

There are two main types of material that may be encoded for inclusion in messages sent over the 
Internet
1. Binary information that has to be encoded to enable it to be transmitted over the network.
2. Plain text that is encoded to hide it from prying eyes.

Turnpike takes care of the encoding needed for binary information by automatically encoding any non-text
files that you insert into a message: see Including files stored on disk.

If you want to hide your messages from prying eyes, you will normally need to acquire special software to 
do this. But if you're simply interested in hiding them from casual observers, you could use the ROT-13 
encoding provided within Turnpike. This is the encoding used in some of the more humorous newsgroups 
to hide material of dubious taste from people who might be offended by it. It simply advances each letter 
by 13 through the alphabet (a to n, b to o etc.) which is enough to convert a message into gobbledygook. 
It is also very simple to decode: all you have to do is apply the encoding again. This advances each letter 
another 13 (n to a, o to b etc.) which takes it back to its original position - thus decoding it.

To apply ROT-13 encoding to part or all of a message, simply select the text and then take the ROT-13 
option from the Edit menu.

Click here to find out how to decode encoded material included in news articles and mail messages.



Name Harry Worthington
auto? No - so blank
Label Home
auto? No - so blank
fax (blank)
phone 01234 123456
land address 27 Cedar View

Overdare
Nice
NI45 8TX

email address Harry Worthington <harry@angel.co.uk>
use/hasMIME useMIME
index list Harry

Worthington
Angel

file-as list harry@angel.co.uk

Record (with actual carriage returns marked CRLF):
Harry Worthington, , Home, , , 01234 123456, "27 Cedar ViewCRLF
OverdareCRLF
NiceCRLF
NI45 8TX",Harry Worthington <harry@angel.co.uk>, useMIME, "Harry, Worthington, Angel", 
"harry@angel.co.uk, useMIME, ,"CRLF



Expanding/Collapsing trees

The discussions that are currently going on within a newsgroup can be shown in two ways:
* As the Subject plus details of the number of articles in this discussion (in the second column) and the 
number of unread articles (in the third), or
* As a list of individual articles presented in a tree-like structure that shows how the articles follow on from 
each other.

The first form of display makes it easy to pick out the discussions you are interested in; the second lets 
you see the details of the articles. So when you go into a newsgroup, you first see a list of discussion 
titles - the idea being that you then select the ones you want to see in more detail and 'Expand' these, 
then 'Collapse' them back down to just the discussion title when you've finished with them.

The options used to Expand and Collapse discussions are in the Article menu. These let you Expand and 
Collapse either individual discussions or all the discussions in the newsgroup. Alternatively you can switch
between Expanded and Collapsed by double-clicking on the thread's 'Total articles' box (the one in the 
second column of the display).



Expiring News

The process of 'Expiring News' clears your system of news articles that have been on your disk for longer 
than their prescribed 'Expiry time'.

News is expired from the Turnpike Connect program. Indeed the Connect program is normally set up to 
expire News as one of the first things it does when this program is run - though it is possible to prompt it 
to expire News at other times as well.

For further information, see either the Connect book or run Turnpike Connect and call up its own Help file.



Expiry

News articles are only kept for a limited amount of time, after which they are erased from the newsbase. 
The date on which a news article is due to be erased is known as its Expiry Date, while the process of 
erasing those articles which have passed their Expiry Date is known as 'Expiring the News'.

The time articles stay on your disk is principally set as part of the newsgroup subscription details. The 
default is for articles to remain on your disk for three days, but you can set a different expiry time for any 
of the newsgroups you subscribe to in the Newsgroup Subscriptions dialog.

However there are two reasons why an article may remain on your disk longer than the expiry time set for
the newsgroup.

The first is that the article has been marked to be kept - either by taking the Keep article option from the 
Article menu or through the Auto Keep option being set among the newsgroup subscription details. (This 
Auto Keep option arranges that every article is automatically marked to be kept as it is added to the 
newsgroup. To see whether this option has been set, take the Configure | Newsgroups option from the 
File menu (assuming you have the appropriate permission to do this), select the group in the list of 
subscribed newsgroups then look at the details shown for this newsgroup in the lower part of the dialog.)

To remove Keep markers, select the articles - either individually or in groups (using Shift-click and Ctrl-
click) - and take the Cancel keep option from the Article menu (again assuming you have the appropriate 
permission). Simply turning off the Auto Keep option doesn't remove the Keep marker from articles that 
have already been downloaded.

The other possibility is that the article has an explicit expiry time set in its header. (This option is intended 
for use in FAQs which are useful to keep on your disk, but it is occasionally used vexatiously.) The way to 
get rid of such an article is to kill it.



Exporting mail messages

Exporting either individual mail messages or the whole of your mailbase saves these messages in a text 
file in Berkeley Unix Mailbox format. (For Soup users, this is equivalent to 'm' format of .MSG file but with 
CRLF line endings rather than LF line endings - ie. you'll be able to work with the files from Soup after 
replacing all the CRLF line endings by LFs.)

In this form, the messages can be read using a standard text editor or word processor. They may also be 
able to be read by other Mail reader programs, or re-imported into Turnpike if required. (It can therefore 
be used as a way of archiving 'old' messages outside of the Turnpike mailbase.)

To export messages, you just need to display the message(s) you want to export, for example by calling 
up a Mail list containing these messages, then select the messages you want to export and take the 
Export option from the File menu. Turnpike then displays a File Selector through which you set where 
you want the exported messages to be stored.

Note: The messages you export remain in your mailbase. Separate action is needed to delete them from 
there.



Exporting news articles

Exporting either individual news articles or the whole of your newsbase saves these articles in a text file in
the 'Batch format' defined in RFC 1036. (For Soup users, this is equivalent to 'u' format of .MSG file but 
with CRLF line endings rather than LF line endings - ie. you'll be able to work with the files from Soup 
after replacing all the CRLF line endings by LFs.)

In this form, the articles can be read using a standard text editor or word processor. They may also be 
able to be read by other News reader programs, or re-imported into Turnpike if required. (It can therefore 
be used as a way of 'archiving' articles of particular interest.)

To export articles, you just need to go into the newsstand containing the article(s) you want to export, 
select these articles and take the Export option from the File menu. Turnpike then displays a File 
Selector through which you set where you want the exported articles to be stored.
 



External bodies
Messages you receive may include horizontal bars that, instead of representing a file (see Extracting files 
from mail messages), are described as representing a link to an 'External body'.

The option employed here has been to include details of how a file may be fetched over the Internet, 
rather than the file itself.

The horizontal bar will usually include a Fetch button which will arrange for the file to be collected by 
some suitable method. Alternatively, the details shown in the bar should give you enough information 
about the file in order to arrange to collect it yourself.



Extracting files from messages

Where a file has been included in a message in one of the standard forms that Turnpike recognises, this 
is shown within the message as a horizontal bar containing an icon and one or more buttons. Forwarded 
messages, digest messages and references to external bodies are shown within similar horizontal bars.

Included in the bar is a brief description of the type of item that is represented, perhaps together with a 
brief note of the type of application that produced the file.

With some types of file, you can call up the file directly within Turnpike - by clicking the Inspect or View 
button offered among the buttons included in the horizontal bar. Simple text files, for instance, can always 
be viewed in this way. Note: The file will be opened using whichever application is associated with files of 
this filetype extension on your system (or if none, you will be able to choose one). If you want to see 
which application will be used to view the file (assuming there is a default for this type of file) or to use a 
different application, click the Viewer button.

Otherwise, you will need to save a copy of the file on disk by clicking the Save button, then using the File 
Selector that appears to pick out where you want to store this file and the name you want to store it under.
You will then be able to work with this file using whichever of your application programs is suggested by 
the details shown about it. (If it's a big file, you may then wish to save the space it is occupying on your 
hard disk by taking the Remove attachment option offered within the horizontal bar.)

If the file isn't in one of the forms Turnpike automatically recognises, what you will see instead is a note 
about the file and the Encoder that has been used to encode it, followed by a sequence of unintelligible 
characters. If the file is at all large, this sequence of characters may be split over a number of separate 
messages. To do anything with such a file, you need to extract it from the message and save it to disk.

If the file is contained within a single mail message, just select the message or open it, then take Decode 
from the File menu and use the File Selector this displays to pick out where you want to store the file. The
file will then be stored on your disk in its original format, from where you can process it using whichever of
your applications seems appropriate.

If the file is split over a number of messages (marked for example [1/6], [2/6], [3/6] etc.), you need to 
select these messages as a group (using Shift click and Ctrl click), then take the Decode option.

Notes: (i) The Decode option can also be used to extract files in bulk from a number of mail messages or 
news articles. Just select all the messages/articles containing files that you would like to extract, then take
Decode from the File menu. Any uuencoded and Base64 encoded files within the selected messages will 
then be extracted from these messages and saved as individual files on your disk.
(ii) If you want to see the 'uuencoded' form of a file that Turnpike has parcelled up into a horizontal bar, 
call up the Options menu and select Display 'raw' text.



FAQs
FAQs are articles which are regularly re-posted to a newsgroup in order to provide answers to a range of 
'Frequently Asked Questions' (hence the name).

You are strongly recommended to read any FAQs included in a newsgroup before you post any article to 
that newsgroup, so that you can avoid being flamed by other users for wasting other people's time, disk 
space etc. etc. by asking a question which is answered in the FAQ.

Note: When you first subscribe to a newsgroup, you won't necessarily pick up copies of all the FAQs that 
are posted to that group immediately - just the ones that have been posted (or re-posted) to the 
newsgroup in the last few days. But over a couple of weeks you should build up a full collection, though 
you should continue to keep an eye out for updates.

Many of the FAQs related to Demon are posted to the demon.answers newsgroup.



'File Paths' dialog

This dialog lists the location of:
* Your personal Turnpike files (the Server path)
* The Mail received and sent from your machine (the Email path)
* The Usenet News copied to your system (the News path)

It is displayed by clicking the Paths button within the Sign-on dialog.

If any of these have been moved, click the adjacent Browse button, then use the File Selector that's 
shown to pick out the new location for these files.



File Save dialogs

Several actions within Turnpike involve saving a file on disk.

Where appropriate, Turnpike offers a standard Windows File Save dialog for you to use to pick out where 
the file should be stored. This dialog will be automatically set up to show what is being saved in its title 
and, where appropriate, to set the required filetype extension.

Simply use the right-hand file selector to set the appropriate directory, then type the required filename in 
the File Name slot - in the usual way.



File or path selectors

Several actions within Turnpike require you to pick out a file or a directory to work with.

In each case, Turnpike offers a standard Windows File Selector dialog for you to use to pick out the file or 
path that is required. This dialog will be automatically set up to show what is needed in its title and, where 
appropriate, to select files with the required filetype extension (though you also have the option of setting 
the list of files to All files if required).

Simply use the right-hand file selector to set the directory, then the left-hand file selector to select the 
specific file or path that's required - in the usual way.



File menu

New newsstand
New mailbox
New mail list
Alter newsstand
Alter mailbox
Print
Print Preview
Print Setup
Insert file
Decode
Export
Import
Configure
Exit



File menu: Alter mailbox
Lets you :
* Add or change the categories of mail that are included in a mailbox
* Change the mailbox's name
* Change the standard signature etc. used in messages prepared from the mailbox
* Set the fonts and colours used when working in this mailbox

Just select the mailbox you want to alter, take this Alter mailbox option and make the changes you 
require through the Mailbox dialog that appears.

Click here for information about the Mailbox dialog.



File menu: Alter newsstand
Lets you:

* Change the newsstand's name
* Change the standard signature etc. used in articles and mail messages prepared from this newsstand
* Set the fonts and colours used when working in this newsstand

Just select the newsstand you want to alter, take this Alter newsstand option and make the changes you
require through the Newsstand dialog that appears.

Note: To change the range or order of newsgroups in a newsstand, use the buttons at the bottom of the 
newsstand itself. (See Adding newsgroups)

Click here for information about the Newsstand dialog.



File menu: Configure
Calls up a submenu containing the following Configuration options:
* Users
* Workgroups
* Email names
* Email routeing
* Newsgroups
* Email Tags

Note: The options available to you to take depend on the range of permissions you have been given.



File menu: Configure Email names
Allows you to set up additional Email names either for yourself or, on a shared system, for mail that is to 
be made available to a group of users, such as the members of a particular workgroup - provided you 
have the appropriate permission.

Greyed out if you don't have Email Names or Alter Names permission.

Click here for further information about additional email names
Or here for details of the dialog through which this information is set
(or press F1 to call up this Help file when you have this dialog on the screen)



File menu: Configure Email routeing
Calls up an Email routeing to seats dialog through which someone with the appropriate permission can:

* Set up the details of the mailing lists that are subscribed to
* Set up special rules about how incoming mail is distributed on a shared system
* Specify which user(s) on a shared system get to handle dead letter mail

Greyed out if you don't have Email Admin or List Subscribe pemission.



File menu: Configure Email tags
Calls up a dialog through which you can change the name of any of your tags or, on a shared system, set 
which other users are allowed to access mail with these tags.

Click here for information about the dialog that is displayed
- or press F1 to call up this Help file when the dialog is on the screen



File menu: Configure Newsgroups
Allows you to view (and amend) the list of newsgroups you subscribe to and to set (or change) such 
details as the Expiry time for articles in a particular group, whether these articles should be picked up in 
full or just browsed, and who can access each newsgroup - assuming you have the appropriate 
permission.

Greyed out if you don't have News Admin permission.

Click here for further information about the dialog in which the subscription details are set
(or press F1 to call up this Help file when you have this dialog on the screen)



File menu: Configure Users
Used to inspect and change sign-on details such as password etc. On a shared system, it is also used by 
the system administrator - or by someone with Alter Users permission - to add new users (by allocating 
them to a 'seat' on the system).

Click here for information about the dialog through which this information is set



File menu: Configure Workgroups
*** Only relevant on shared systems ***

Used by the system administrator - or by someone with the appropriate permission - to define 
'Workgroups' of users all able to see certain types of mail such as sales enquiries, customer support 
enquiries etc.

Greyed out if you don't have Alter Workgroups permission.

Click here for further information about the Workgroups dialog
(or press F1 to call up this Help file when you have this dialog on the screen)



File menu: Decode
Used to extract uuencoded and Base64 encoded files from either mail messages or news articles.

Can be used both within a message to extract files contained within that message and to extract files from
a number of messages / articles selected as a group.

For further information, see 'Extracting files from messages'.



File menu: Exit
Exits from Turnpike.



File menu: Export
Lets you save either individual mail messages / news articles or the whole of your current mailbase / 
newsbase / address book in a form that can be used by a range of other programs. In particular, the files 
created are simple text files which can be viewed within any text editor or word processor.

For further information, see Exporting mail messages, Exporting news articles or Importing or Exporting 
addresses as appropriate.



File menu: Import
Lets you transfer to Turnpike news articles, mail messages and email addresses that have been built-up 
using other software.

Also allows you to re-import messages etc. that you have previously exported.

For further information, see 'Importing mail and news' or Importing or exporting addresses, as appropriate



File menu / Editor button: Insert file
Lets you insert a file into the mail message or news article that you are preparing.

For further information, see Including files.



File menu: New mail list
This starts the Mail List Setup Wizard to create a new mail list.



File menu: New mailbox
This starts the Mailbox Setup Wizard to create a new mailbox.

You set up further mailboxes into which your mail can be sorted. By doing this, you can separate business
correspondence (for example) from personal mail, sales enquiries or club notices.

For further information, see Setting up further mailboxes.

See also: Alter mailbox



File menu: New newsstand
This starts the Newsstand Setup Wizard to create a new newsstand.

You set up newsstands for newsgroups. By setting up more than one newsstand, you can separate out 
the newsgroups you take in support of your work (for example), from ones you take purely for recreation, 
ones about Internet issues, ones about computer systems etc.

For further information, see 'Setting up newsstands'.

See also: Alter newsstand



File menu: Print
Prints one or more copies of the currently selected mail message or news article - using your current 
printer set-up.

When you take this option, a dialog appears through which you can set the number of copies and the 
range of pages. This dialog also includes a Print setup button through which you can change the printer 
and type of paper that's used - or you can set these things up in advance by taking the Print setup option
from the File menu.

Quick keystroke: Ctrl + P

See also: Print Preview and Print setup



File menu: Print Preview
Shows you (as closely as possible) on the screen how the message you are currently working on would 
look it if you printed it on your current printer setup.

Within the Preview display, you can show different pages and zoom in on parts of the message you are 
particularly interested in. For more information, see 'Previewing before you print'.

See also: Print and Print setup



File menu: Print Setup
Lets you set the printer and paper that will be used if you choose to print - or preview - any mail 
messages or news articles.

When you take this option, a version of the standard Windows Print Setup dialog is displayed, through 
which you can set the printer and the type of paper that's to be used.



Filing mail

When you have finished with a message in a mailbox, you can 'file' it either by clicking the File message 
button or by dragging it to a suitable mail list.

The difference between these two methods is in the tags that the message is stored under. When you 
click the File message button, the message is simply stored under the tags that have so far been applied 
to it. But when you drag a message to a mail list, it is also stored under the tag(s) associated with this 
mail list, allowing you to both categorise the messages and file them in one easy movement. (Suppose, 
for example, that you wanted to categorise messages as either Project X, Project Y or Project Z. All you 
need to do is set these up as tags, then call up a mail list for each of these tags, minimise these lists (so 
that they appear as icons) - then simply drag the messages to the appropriate icon for filing.)

The message is stored in your mailbase, along with the messages you've sent and any news articles 
you've posted (in fact, it's been there all along ! ) - filed not only under the tags that have been applied but
also under the email addresses it was sent from and to. So when you want to see the message again, 
you can either:

* Go into the Address book, select the sender or the receiver of the message and click the Messages 
button. The message will then appear in a list of all the messages sent to or received from this person 
(arranged in date order, with the newest at the top).

* Open up the Mailroom view (by double-clicking on its 'filing cabinet' icon or by selecting it from the 
Window menu). This shows you a list of everything that has been sent or received (arranged in similar 
date order).

* Or if you have tagged the message with its topic, you can find it by taking the New mail list option from 
the File menu, and use the Mail     List     Setup     Wizard   to produce a list of all the messages that have been 
marked with this tag, again in the same date order.

Click here for information about tagging messages
Or here for information about calling up lists of filed mail.



Finding and Replacing text

The Editor's Find & Replace facilities let you locate particular words or phrases within the message you 
are working on and, if appropriate, replace them by another.

To find a particular word or phrase, take the Find option from the Edit menu. When the dialog appears,
type in the word or phrase you want to find, select Whole word/Case matching if appropriate, set the 
direction of the search from the current cursor position, then click the Find next button.

To replace a particular word or phrase by another, position the cursor above the point at which you 
want the first change to be made, then take the Replace option from the Edit menu. When the dialog 
appears, type in the word or phrase you want to replace and the one you want to replace it by, select 
Whole word/Case matching if appropriate, then either click the Replace All button or click the Find next 
button to process each instance individually.



'Find' dialog

Taking the Find option from the Edit menu displays a standard Windows Find dialog through which to set 
the details of the word or phrase you want to look for.

Simply enter the required word or phrase in the Find What slot, set the Match options and the Direction 
in which you want Turnpike to search (Up or Down through the text) - then click the Find next button.



Finding entries in lists
Where a dialog includes a list and a Find slot, you can use the Find slot to pick out entries from the list:

* Either by starting to type the name of the required entry in the Find slot. The list will then automatically 
scroll to the appropriate part of the list.

* Or by giving a pattern for the name you require in the Find slot and then using the Find first / Find next 
buttons to work through the possible matches until you find the one you want.

The usual form for this pattern is * followed by the group of characters you want Turnpike to search for. 
The * means 'match any number of characters' so *astrology (for example) means match any name 
including the text astrology.

In addition, you can use multiple * characters. For example, *aut*ant could be used to pick out a 
newsgroup called alt.autos.antique.



Flaming
To be 'flamed' is to be on the receiving end of extremely cutting and sometimes quite personal remarks 
either posted to a newsgroup or sent to you directly as email.

The usual ways in which you can bring this on yourself are by posting an article to an inappropriate 
newsgroup, posting an article requesting information that is given in the appropriate FAQ or posting the 
same article to several newsgroups, particularly where this article advertises your services.



Followup-to: poster
If the author of an article in a newsgroup wants replies by email rather than through the newsgroup, this is
conventionally signalled both through a note in the article and by adding the line Followup-to: poster to 
the header of the article.

To add this line to an article you are preparing in Turnpike, click the Edit News Header button above the 
article then simply type poster in the Followup-To slot of the dialog that is displayed.

Note: If an article you reply to has Followup-to: poster set, you'll be automatically prompted if you start 
to reply to this through the newsgroup and given the option to switch to replying by email instead.



Font dialog

This dialog lets you select the combination of font, font size and font style used either when printing mail 
messages / articles or for displaying text on the screen.

For making temporary changes to the current window it is called up when taking the Font option from the 
Options menu.
For making permanent changes it is called up when taking one of the Alter options from the Fonts page 
of the Mailbox or Newsstand dialog.

Simply select the Font, then the Style and Size of this font you require from the set of three lists in the 
dialog.

The dialog also includes a sample piece of text so that you can see the effect of the selection you've 
made.

Note: If you choose a proportionally-spaced (PS) font for the screen, you won't a consistent number of 
characters per line in the messages / articles you prepare. Instead some lines will contain many more 
characters than others. In particular, some lines may contain more than 80 characters. This is fine where 
you know that the person reading the message uses a similar font to display their messages, but if you 
don't know that, it is better to use a fixed-pitch font which will give you a consistent approx. 72 characters 
per line with the default margins Turnpike sets.



The font used to print in

The font used to print a mail message or a news article is set through the mailbox or newsstand from 
which the message / article is printed.

If you want to set a specific font for messages / articles printed from a particular mailbox / newsstand, you
need to set this on the Fonts page of the appropriate Mailbox / Newsstand dialog.

But if you simply want to use a different font for everything you print, the place to set this is the Fonts 
page of your Default mailbox - because the font set there is used to print messages from all your 
mailboxes and newsstands unless you've specifically set a different font to be used.

To set this font, go into the mailbox or newsstand you want to affect, then take the appropriate Alter 
option from the File menu. When the dialog is displayed, switch to the Fonts page, then click the Alter 
button alongside the 'Font used when printing' entry and select the required font from the Font dialog that 
is then displayed.

Click here for more information about the Fonts page of the Mailbox/Newsstand dialog
Or here for information about the Font dialog
- or press F1 to call up this Help file when you have the dialog on the screen.

For further information about altering a mailbox or newsstand, see Setting up mailboxes or Setting up 
Newsstands as appropriate.



Fonts/colours not saved
The Font and Colour functions in the Options menu are intended only for temporary changes that will be 
lost when the current window is closed.

To make permanent changes, right-click the mailbox or newsstand concerned and select Properties (or 
left-click it and then take Alter Mailbox or Alter Newsstand from the File menu). Then choose the 
Colours or Fonts tab to set up the changes you would like.



Forward "as is"
This option in the Messages menu allows you to forward an email to one or more people without adding 
any extra text. The only change will be that Resent from: headers are added (which many other mailers 
ignore).

Note    It is generally better to use the standard Forward message option, as you can then add some 
details to explain why the email was sent on. However, Forward "as is" can be useful when forwarding 
email to people who don't use Turnpike and who might have trouble with MIME enclosures.



Forwarded messages

When you forward a message, the original message is:
either: Inserted into a MIME message in the form of an in-line enclosure
or: Inserted as plain text between a pair of matching Cut lines (if the MIME option is turned off)
or Simply merged into, or quoted within, the new message

Alternatively you can use Forward "as is" from the Messages menu to send the message on without any 
additions or changes.

When you receive a message that has been forwarded to you as an in-line enclosure in a MIME 
message, Turnpike will give the original message its own section within the main message, complete with 
its own toolbar. This toolbar not only contains brief details of the message that's been forwarded but also 
offers a range of buttons for forwarding, replying etc. (The equivalent buttons on the main toolbar are set 
up to forward the whole message, reply to the forwarder etc.)

This makes the original message so easy to pick out, work with etc. that Turnpike will also set up such a 
section wherever possible for non-MIME messages that contain forwarded messages. However, it can 
only do this where the message has been inserted between a matching pair of cut lines.



Forwarding a news article

There are two ways of forwarding a copy of a news article to someone.

The first is to select the article, then take the Forward article option from the Article menu. This creates a
new mail message complete with a copy of the news article you've selected.

Alternatively, if you've already started preparing the message you want to send, you need to arrange that 
you can see both the newsgroup and your mail message on the screen at once, then drag the news 
article from the newsgroup into your mail message.

Whichever route you choose, the news article will be shown in the message as a horizontal bar on which 
there will be buttons offering a choice of further actions. These include a Merge into text button, which 
simply merges the article into your own message, and a Quote message button which will insert the 
article as a quotation (with the usual > symbol at the start of each line).

There's also a Treat as file option to take if you want to forward the article exactly (byte for byte) as it 
came to you - for example to your Access provider's technical support department. The standard form in 
which articles are forwarded keeps the text of the article intact (including the header if required) but may 
alter how it is encoded. The Treat as file option keeps the encoding as well.

Note: The introductory line inserted for you at the top and the signature inserted for you at the bottom are 
just text which you can change simply by editing in the normal way. You can also arrange for your own 
style of messages to be inserted. Click here for information on setting the format of the introductory text - 
or here for information on setting your own style of signature.



Forwarding mail

To forward a mail message to someone else, you simply need to select it, then click the Forward 
Message button on the Mailbox toolbar (or take the equivalent option from the Message menu). This 
takes you into Turnpike's Editor with a new message set up ready to forward a copy of the message you 
received (shown as an icon within a horizontal bar).

There are then four main options for how the message is forwarded.

1. You can send it as an 'in-line enclosure' within a MIME message.

This is very much the best option if the person you are forwarding the message to uses Turnpike or some 
other MIME complaint mail reader because it makes it easy for them to reply to the author of the original 
message (rather then to you) or to forward the message to someone else, etc. See Forwarded messages.
Indeed, this is such an advantage that Turnpike selects it by default.

(If you are not sure whether the person you're sending the message to has MIME, simply clear the Send 
MIME message option at the top of your message. Then the forwarded message will be marked out by a 
pair of matching cut lines, which will allow the same forwarding and reply options as the MIME option if 
the recipient does use Turnpike.)

2. You can merge the message you're forwarding into the text of your own message - by clicking the 
Merge into text button within the horizontal bar.

This is useful if you want to annotate the message you are forwarding.

3. You can include the message as a quotation - by clicking the Quote message button within the 
horizontal bar.

This will highlight the forwarded message as a quotation (with the usual > markers and special colour). 
This is a useful aid to clarity, especially if you are forwarding several messages.

4. You can send the message as a file - by clicking the Treat as file button within the horizontal bar.

This is the option to take if you want to forward the message exactly (byte for byte) as it came to you - for 
example, to your Access provider's technical support department. The other options keep the text of the 
message intact (including the header if required) but may alter how it is encoded. The Treat as file option 
keeps the encoding as well.

In each case, the subject will be filled in on your message for you, and your signature will be added at the 
bottom. So once you've chosen how the message is to be forwarded, all you normally have to do is:
* Insert a brief note at the beginning of the message
* Fill in the email address it needs to be sent to - eg. from the Address book 
* And then click the Post button.

Note: The introductory line inserted for you at the top and the signature inserted for you at the bottom are 
just text which you can change simply by editing in the normal way. You can also arrange for your own 
style of messages to be inserted. Click here for information on setting the format of the introductory text - 
or here for information on setting your own style of signature.

See also Forward "as is".



Forwarding messages completely unchanged

The standard procedures for forwarding mail messages and forwarding news articles inserts the 
message/article you received into a new message which is re-encoded, before being sent on.

This is fine in most cases but there may be times when it is important to retain the original encoding - for 
example, where you want to forward an email message or a news article to your Access provider exactly 
as it came to you as evidence of a problem.

To do this, take the standard Forward message / Forward article option but when the new message 
opens with the forwarded message shown as a horizontal bar, click the Treat as file button on this bar. 
The message will then be forwarded exactly as it came to you.

You then just need to add any explanation you think is required, address the message and post it in the 
usual way. The person receiving the message will be able to 'save' this file on disk in exactly the form it 
was sent to you.

If you wish to just forward the message without any additional text from yourself, you can use Forward "as
is" from the Message menu.



Full Name dialog

This dialog may be displayed when you first run Turnpike. It asks for your Full name so that this can be 
included in messages.

Simply fill in the name you want Turnpike to use.

Note: This name can be changed later through the Edit sign-on dialog. 



Full articles in Browse groups

If a newsgroup that you've marked as "browse" contains articles that have been downloaded in full, there 
are four possibilities to consider.

First, are you sure that the newsgroup is marked as "browse" ?

To record a newsgroup as a browse group, you not only need to select the newsgroup in the list of 
newsgroup subscriptions and select the Browse check box, but you also need to click the Apply button 
before you either go on to another newsgroup or leave the dialog.

It's also possible that, if your newsbase was damaged or corrupted at any stage, the fact that you've 
opted to browse the group may have been lost when the newsbase was re-built.

Before going any further, call up the list of newsgroup subscriptions again (eg. by taking Configure | 
Newsgroups from the File menu) and check that the Browse option is selected for this newsgroup 
(assuming you have News Admin permission).

Second, have you set a kill rule to accept certain articles?

Any articles which meet the conditions of such a rule will be downloaded in full.

Third, have the full articles been cross-posted to newsgroups which aren't browsed ?

Such articles are fetched in their entirety.

Finally, did you stop, switch the newsgroup to "browse", then restart the last news download ?

This doesn't stop the current set of articles being downloaded in full because Connect's list of things to 
fetch has already been set up.

To avoid getting these articles in full, you need to rebuild the news database before you restart news 
collection (assuming you have Rebuild Files permission). This will keep any user-generated requests to 
fetch articles in full, but discard the automatically-generated ones.



Group Mail

*** Only of interest on shared systems ***

'Group mail' is based on group email names.

These are simply email names with several users rather than just one. Within a company, you might well 
have names like 'Sales' and 'Support' set up as group email names with the members of your Sales team 
as users of the Sales email name and the members of your Support department as users of the Support 
email name.

All the people listed as using a group email name - either in their own right or through a workgroup they 
are members of - can write mail messages using the group email name. In addition, any item of mail that 
arrives addressed using this group email name initially appears in the mailbox of every member of the 
group, but disappears again from everyone else's mailbox the moment someone starts to read it so that 
there is no chance of two people answering the same message. (The message will, however, re-appear if 
it is marked Unread again.)

Assuming you have Alter Names permission, you can set up group email names by taking Configure | 
Email names from the File menu in very much the same way as you set up additional email names for 
yourself. The only difference is that when you display the 'Usage' dialog, you don't just type in the email 
name you wish to set up. You also use the Add and Del buttons to set up the list of users or workgroups 
that will be able to use this name in their messages.

For further information on setting up the list of users, either click here or press F1 to call up this Help file 
when you have the Usage of Email Names dialog on the screen.



Header-only articles

There are two main reasons why just the header of an article may be downloaded, rather than the 
complete article.

1. The article is in a newsgroup which Turnpike has been set to 'browse'.

A Browse group is, by definition, a 'header-only' group - though full articles can be included    if, for 
example, the article has been cross-posted to a newsgroup that is downloaded in full.

2. Kill criteria are being applied to the group 

The basic principle where kill criteria are applied is that you should get the whole of most articles but only 
the header of those articles which are picked out by these criteria (so that you can still see what the article
was about in case you wish to request the full article).

To arrange this, Turnpike will first fetch the headers of the articles, examine them to see which articles 
should be killed, and only then fetch the required bodies. So if you look at the newsgroup while the 
articles are being collected, or if the news collection session does not complete for some reason, 
then some articles will contain headers but no bodies. In the fullness of time the bodies will be collected 
without further intervention by you.

The standard type of kill criteria are rules such as "nothing else by that person" or "nothing over 100 
lines". If you have Kill Article permission, you can check on the rules that are applied to the newsgroup 
you are working in by taking Kill option from the Classify menu, then clicking the Review rules button. 
Less obviously, killing a thread also sets up kill criteria - because it is not possible to determine whether 
an article belongs to a thread until the header has been fetched and the reference lines inspected.



Help menu

Index
Using Help
Show Hints & Tips
About Turnpike



Help menu: About Turnpike
Displays brief details about the version of the Turnpike program you are using - in particular, its version 
number and its date of issue.

If you want to find out about using Turnpike or about using Turnpike's Help, click on the Contents button 
at the top of this Help screen, then click on the topic that interests you in the list of topics displayed.



Help menu: Index
Calls up the Contents page of this Help file, from where you can access information on any aspect of 
Turnpike you like.



Help menu: Show Hints & Tips
Switching this option between unticked and ticked displays a sequence of (useful, we hope) tips about 
using Turnpike.

If this option is left ticked when you leave the Turnpike program, then the next tip will be automatically 
displayed the next time the Turnpike program is loaded.



Help menu: Using Help
Calls up a special Help file that describes using Windows Help systems such as this one.

Note: You can get Help on using Help from the Help file you are using at the moment - by clicking on the 
Contents button at the top of this display and then clicking on Using Turnpike Help.



How to:
      Tag messages with their topic
      Tag messages through the mailbox
      View all the mail that has been sent or received
      View mail exchanged on a particular topic
      View mail exchanged with a particular correspondent      
      View just the mail you've sent or received
      Edit tags



How to:
      Follow-up an article (Respond through the newsgroup)      
      Send an email message to the author
      Start a new discussion thread
      Prepare the text of your article
      Change the header on your article
      Post a picture
      Encode your article
      Use a different signature
      Stop the article being sent
      Call up articles you have posted



How to:
      Set up mailboxes for particular types of mail
      Set the email name,signature etc. used
      Set the colours and fonts used
      Change the details of a mailbox
      Remove a mailbox
      Set up additional email names



How to:
      Set up Group mail
      Make mail public/private
      Make access dependent on topic
      Set the access through the mailbox
      Change the access to a tag
      Change the owner of a piece of mail      



How to:
      Display the contents of a mailbox
      Set the way dates are shown
      Open a mail message
      Open the next unread message
      Search for a message
      See the header of a message you've received      
      Decode an encoded message
      Extract a file from a mail message
      File a message
      Forward it
      Print it
      Throw away unwanted mail
      Mark as Read/Unread
      See messages you've filed



How to:
      Select a newsstand
      Open/close newsgroups
      See the individual articles within a newsgroup
      Read a news article that catches your eye
      Work through the unread articles in a newsgroup      
      Follow the thread of a discussion
      Search for an article
      Request missing articles
      Decode encoded articles
      Extract a file from a news article
      'Read' binaries
      See the header of an article
      Mark as Read or Unread
      Forward an article to a friend



How to:
      Keep articles past their expiry date      
      Export articles
      Print articles



How to:
      Save the current newsbase
      Import news articles from another source      
      Rebuild your newsbase
      Expire the newsbase



How to:
      Export messages from your current mailbase      
      Import mail messages from another source
      Rebuild your mailbase



How to:
      Send a reply
      Send a new message
      Prepare the text of your message
      Take the address from your address book
      Send multiple copies
      Include files in your message
      Send a message you've prepared using your word processor...
      Send a MIME message
      Change the header
      Use a different signature
      Stop a message being sent
      See messages you've posted



How to:
      Set up a newsstand
      Select the newsgroups to subscribe to
      Set the email name, signature etc. used
      Set the colours and fonts
      Change the details of a newsstand
      Remove a newsstand
      Set the Expiry time on a newsgroup
      Restrict access to a newsgroup
      Cancel the subscription to a newsgroup
      Set up a new newsgroup



How to:
      Mark threads as interesting
      Break off the interesting part of a thread      
      Clear out unwanted articles



How to:
      Subscribe to a mailing list
      Set up a mailing list as a newsgroup
      Convert an existing mailing list to a newsgroup      
      Run a mailing list



Importing mail and news

If you have a newsbase or, more importantly, a mailbase that you have built-up using other software, you 
can transfer this to Turnpike very easily - as long as it is stored in one of the following formats:

* Mail: Berkeley Unix Mailbox format or Soup 'm' format .MSG file

* News: Batch format (as defined by RFC 1036), 'Snews' database format or Soup 'u' format .MSG file

Individual news articles held as ASCII files can also be imported into your newsbase.

Note: Turnpike can't import other formats of Soup .MSG files ( 'M', 'b' or 'B' ). You should also note that to 
import a mailbase or a newsbase that has been built up using Turnpike, whether your own or someone 
else's, this mailbase/newsbase first has to be exported as described in the sections on Exporting 
mail/news messages. Neither a Mailbase file nor a MSpool file can be imported directly into another 
Turnpike mailbase; nor can a Newsbase file or a NSpool file be imported into the newsbase.

To import mail
Simply go into (any one of) your Turnpike mailbox(es), then use the Import option from the File menu and
the File Selector this displays to import (one by one) each current or archived mail file you require.

Note: Any 'Incoming' messages you import (ie. ones sent to you) will be placed in your mailbox(es) - 
distributed according to the rules that you've set up for your mailboxes, and marked with the default tag(s)
of the mailbox into which they are inserted. Any 'Outgoing' messages you import (ie. ones that you have 
sent) will be tagged with the default tag(s) of the mailbox from which you called up the Import option, then
filed in your mailbase.

To import news
Before you import any news articles, you must first set up one or more newsstands covering the 
newsgroups from which you will be importing news.

When you have done this, go into (any one of) your newsstand(s), then use the Import option from the 
File menu and the File Selector this displays to import (one by one) the appropriate news files.

The articles will be placed in their newsgroups and can be read by going into the newsstand that covers 
the appropriate newsgroup. Note: kill rules are ignored when you import news.

If you forget to include a newsgroup in any newsstand, the articles from this group won't be imported. To 
put this right, just alter a newsstand to add the missing newsgroup(s) and then import the appropriate file 
again.



Importing or exporting addresses

You can, if you want, produce a text version of your Turnpike Address book - in the form of a CSV 
(Comma Separated Value) datafile. It is also possible to import the addresses from either a previously-
exported Address book or a CSV datafile that has been set up with the same format.

The steps used are very simple.

To export your Address book, just select your Address book, take the Export option from the File menu 
and use the dialog that's displayed to pick out where you want the exported file to be stored.

To import addresses, select your Address book, take the Import option from the File menu, and use the 
dialog that's displayed to pick out the file containing the addresses you want to import.

The CSV file produced starts with the individual 'Person' address book entries, arranged one per line. 
This is followed by the details of any distribution lists you've set up, separated from each other and from 
the list of 'Person' entries by single blank lines. (Click here if you need full technical details of the structure
of this file.)



Including files stored on disk

One of the options with both a mail message and a news article is to include a file that you have stored on
disk. This file will typically contain either text or application data, but where you are sending a MIME 
message, you can also include video, audio and image files.

If you've started to prepare the message, just position the cursor where you want the file to appear then 
click the Insert file button (or take the equivalent option from the File menu). Alternatively, if you can 
display the Windows File Manager on the screen at the same time as Turnpike, you can drag the 
appropriate file either into an existing message or to your mailbox, whereupon Turnpike will create a 
message for you - including the file.

(Note: This dragging technique can also be used to include copies of mail messages and news articles in 
mail message, but there are better ways of both forwarding mail and forwarding news articles.)

The file you insert is represented by a horizontal bar containing a brief description of the file you have 
inserted, perhaps together with one or more buttons.

If the file you are inserting contains ASCII text, there will typically be an Inspect button to use if you want 
to look at the file you've inserted and a Merge into text button. Clicking the Merge into text inserts the 
text fully into the message. You will then be able to edit this text etc. exactly as if you had typed it within 
the message.

With other types of file (including files containing compressed ASCII), the options you are offered depend 
on whether you will be sending a standard mail message/news article or a MIME message. If the Send 
MIME option isn't selected, the file is simply set to be 'uuencoded' for transmission over the Internet. But if
the Send MIME message option is selected, the bar will include a Properties button through which you 
can specify the type of file that's being sent.

The purpose of recording the type of file is to allow the correct viewing application to be chosen where the
file is received and, in the main, Turnpike will identify the type of file for you - automatically picking out 
files as image, audio etc. and recording the appropriate sub-type (eg. JPEG, TIFF, GIF etc.). But if 
Turnpike fails to identify the type of file (or you know there's something better to specify), you can change 
these details by clicking the Properties button and making the required settings in the Properties dialog.

The different way the files are handled makes it important to ensure that the Send MIME option is set 
correctly - but only when you 'post' the message. Up to that point, you can switch between a standard 
mail message and a MIME message and the way the file is set to be handled will just change to match , 
because the encoding is only actually done when the message is posted.

Note: Before inserting a file, it's worth thinking whether there's a more convenient format you can put it 
into first. In particular, it's worth putting text into ASCII so that it can be inserted directly - and just as 
importantly, doesn't require decoding before it can be read at the other end. 



Inspecting newsgroup ratings

Ratings for all the different newsgroups are (or will be) set by independent third-parties and distributed 
alongside the list of newsgroups available from the news server you use.

If you would like to see how any particular newsgroup is rated, either make as if to add new newsgroups 
to one of your newsstands, then pick out the newsgroup in which you are interested in the Newsgroup 
Addition dialog and click the Ratings button.

Alternatively, if you have News Admin permission, you can find out by calling up the Newsgroup 
Subscriptions dialog, selecting the newsgroup in either that dialog or in the associated Newsgroup 
Subscription dialog and clicking the Ratings button offered there.

Whichever route you take, you will see a dialog showing the names of the newsgroup ratings services 
that are currently in use, together with details of the rating that the newsgroup has been given under each
of the different categories covered by each ratings service.

Note: By the very nature of the ratings system (and of the additional access controls Turnpike offers), you
can only see the ratings of newsgroups that you are allowed to see.



Introduction

Welcome to Turnpike.

The Turnpike software is in two parts: the main Turnpike program which provides off-line processing of 
email messages and Usenet news; and Turnpike Connect which is used to go on-line to the Internet to 
send and receive mail and news, and to use such things as Telnet, FTP and the various information 
services that the Internet provides.

You are currently using the main Turnpike program. Its main screen provides a framework on which can 
be displayed:
* One or more 'Mailboxes' for mail messages you've received
* One or more 'Newsstands', showing Usenet newsgroups you've subscribed to
* An address book, containing the email addresses you use
* Lists of messages sent and received (including the Mailroom view of all the mail in your mailbase)
plus an Out tray and a Waste basket.

Each of these items can be either open as a window on the Turnpike screen or shown minimised as an 
icon.

From this screen, you can:
* Inspect your Mailboxes to see what mail you've received
* Prepare email messages to send
* Call up lists of email messages that have been exchanged either with a particular person or on a 
particular topic
* Follow discussions in the newsgroups you subscribe to
* Prepare your own contributions to these newsgroups
* Inspect and update your address book

You can also carry out a range of 'configuration' tasks, such as setting up (and modifying) additional 
mailboxes, setting up (and modifying) newsstands; and extending the range of 'email names' by which 
you can be addressed.

Whatever you want to do - and whichever part of the program you are using - if you need instructions, 
simply press F1 to call up this Help file. Or if you want to know about a particular option, press Shift F1 
then click on the item you're interested in. (Click here for more information about using this Help file.)



Keeping news articles past their expiry date

The articles you download are normally set to 'expire' after a certain time to avoid filling up your disk with 
'old' articles. (The length of time articles from any newsgroup remain on your disk is specified as part of 
the definition of the newsgroup.)

If there's an article you want to keep past its expiry date and you have Keep articles permission, you can 
tell Turnpike that you want to keep this by selecting the article and then taking the Keep article option in 
the Classify menu.

The article isn't then erased from your newsbase when its expiry date comes up, but is kept within the 
newsgroup until you either cancel the instruction to keep the article (by taking Cancel Keep from the 
Classify menu) or stop subscribing to the newsgroup.

Note: It is also possible to arrange that future contributions to a particular newsgroup will automatically be
marked to be kept - by selecting the Auto Keep option for this newsgroup within the Newsgroup 
Subscriptions dialog. If there are any articles you don't want to keep after all, then you can clear the Keep 
marker against these articles using the Cancel Keep option described above. Clearing the Auto Keep 
option within the Newsgroup Subscriptions dialog only affects articles downloaded after you have made 
this setting.



"A serious problem has occurred in the Turnpike program"

The Turnpike program has encountered a situation where it was about to terminate with a General 
Protection Fault.

But instead of doing that it writes a report file in your Turnpike directory which contains diagnostic 
information.    You are also encouraged to type in a description of the events leading up to the problem 
(the description box will scroll if you fill it up) - this is added to the report and may help us to pinpoint the 
problem.

The file: PROBLEM.TXT should later be sent by email (if possible) to problems@turnpike.com so that 
we can investigate.

In some circumstances you can choose to Continue the program.
If this does not cause the problem dialog to reappear then it will be best to close down and restart anyway
at the first convenient opportunity.
This will give you the best chance of not losing any work or needing to rebuild your mail or news 
databases.

If it was not possible to continue, or the problem occurs again then you have to press Terminate.
You may in this case need to rebuild the databases next time you run Connect, if prompted to do so.



Kill Rules dialog

This dialog is used to display the Kill rules that are applied to the newsgroup you are currently working in 
and to let you make any changes to the rules that you require.

It is called up by taking the Kill option from the Classify menu and clicking the Review button in the dialog
that's displayed.

* The Add button in the dialog lets you set up a new rule (using the News article kill rule dialog).

* The Alter button lets you modify an existing rule (again using the News article kill rule dialog).

* The Remove button lets you remove rules that you no longer require.

* The Move Up and Move Down buttons let you re-order the rules, in the light of the fact that whether a 
particular article is retained or killed depends on whether the first rule Turnpike finds (starting from the top 
of the list) that fits the article says to Accept (ie. don't kill) or to Reject (ie. kill) it.

Note: In general, you need any rules that Accept articles above any rules that Reject them.



Kill rules

Kill rules allow you to minimise the amount of your disk space that is taken up by articles you have no 
interest in reading. If an article is picked out as unwanted by one of the kill rules that are applied in the 
newsgroup in which it appears, just its header is downloaded - which is enough to allow you to ask for the
article to be downloaded in full if it turns out that the article is wanted after all. The article is also marked

 and isn't brought to your attention in any way eg. by including it in counts of unread articles.

Kill rules are set up by someone with Kill Articles permission taking the Kill option from the Classify menu.
This calls up a dialog offering a range of Kill options from simply killing the current article to setting up a 
'Custom' Kill rule to be applied to the newsgroup you are working in.

(Each Kill rule is associated with a particular newsgroup to allow you set up separate sets of rules for 
each newsgroup (and indeed to have newsgroups which aren't filtered at all). Special permission is 
needed to set up these rules because, on a shared system, any article that's killed by a Kill rule is killed 
for every other user of the system as well.)

The dialog also contains a Review option which you can use to see the rules that have been set up so far
and to make any amendments that you require.

Most rules specify a type of article that is to be rejected (ie. not downloaded in full), but it is also possible 
to set up rules that specify that particular articles should be accepted (ie. downloaded in full) even though 
other rules would reject them. So as with other sets of rules (eg. the ones controlling which items of mail 
are put into a mailbox), you need to remember that Turnpike will act on the first rule that fits the article it is
considering and ensure that the rules appear in the correct order for the result you require.

Click here for further information on setting up Kill rules

Note: Filtering a newsgroup against Kill rules can increase the time taken to download articles from a 
group because it takes time to inspect each article's header. So while it is possible to set up a set of Kill 
rules for each newsgroup you subscribe to, it is probably best to restrict the groups for which you set up 
rules to just the ones that you want filtered in this way. Normally there's no need to set up kill rules for a 
newsgroup that is browsed, because only the headers of the articles are downloaded anyway. However, 
you can set up a kill rule to accept certain types of articles in a browse group (e.g. those with the subject 
Announce) - articles meeting the conditions of such rules will be downloaded in full.



Killing articles

Killing an article removes it from your disk, freeing the space it occupied for other articles.

To kill an article, you need to select the article, then take the Kill option included in the Classify menu.

What you then see is a 'menu' of Kill options - because depending on how you feel about the article and 
others like it, you may want to:
* Simply kill this one article
* Kill all the articles in the same thread - including any further contributions to this thread
* Specify that you don't want any future articles on the same topic or by the same author to be 
downloaded to your disk.

The top two options in the dialog just refer to the specific article you've selected. Kill article removes all 
but the header of the selected article from your newsbase (the article is then shown marked ). 
Remove article goes one stage further and removes the header as well.

The next option - Kill thread - doesn't just kill the selected article but all the articles in the same thread 
(which is then marked Uninteresting to stop it being drawn to your attention.) It also sets up a Kill 
rule.which will stop any articles that continue this thread from being downloaded. (This rule will be 
automatically dropped from the list when the thread finishes.)

The next three options let you specify that you don't want any similar articles that appear in future to be 
downloaded to your disk. The two main things you can say you don't want are articles with either the 
same author (Kill author) or the same subject as the current article (Kill subject), but if you require a 
more subtle rule, you can specify this by taking the Custom option and setting the rule you require in the 
News article kill rule dialog that's then displayed.

The main Kill dialog also includes a Review option which calls up a list of the rules that are currently in 
place for this newsgroup and make any amendments that are needed.

Any further articles that are posted to this group that have these same characteristics won't be 
downloaded in full. Only the header will be downloaded.

Note: The Kill option is restricted to users with Kill Articles permission because kills articles not just for 
you but, on a shared system, for all your colleagues as well. So it's best if only a limited number of users 
can Kill articles. It's also advisable for the person doing the killing to seek the agreement of their 
colleagues first.



Leaving Turnpike

To leave Turnpike, simply take the Exit option from the File menu.



Leaving a user on the system

If you decide to keep someone who leaves as a user on the system, all the System Administrator really 
needs to do is ensure that they can access that person's mail files if necessary - by changing the 
password to something they know.

To change the password, take the Configure | Users option from the File menu, select the 'ex-user', click
Edit and set the new password in the Password slot of the dialog that's displayed.

It may also be a good idea to take Configure | Email names from the File menu, make a note of the 
email names they were using and then arrange that any mail that arrives addressed to any of these 
names is directed to another user to deal with. 



This is the last page of the Mail List Setup Wizard.

You can move backwards and forwards through the wizard pages to check or change the details you 
have entered using the Back and Next buttons.

When you press Finish here the new mail list will be created and displayed.



On this page of the Mail List Setup Wizard you need to choose an address     book     entry   which will be used 
to control the contents of the new mail list.

The mail list will include either all correspondence with a particular person or, on a shared system, all your
own corresponence.
If this is not what you intended go Back to the previous page and revise your choice there.

Either way you need to select here one address book entry which identifies the person concerned.

All you need to do is locate and select the correct address book entry.    Use the Selection box, or Goto 
A-Z at the bottom, to find the entry for a particular name or email address.

You can also View the selected entry in detail (and while doing so you can even change some details if 
you wish).

The File as part of the selected address book entry contains usually one, but sometimes more than one, 
email address for that person.    All messages with a matching email address for the author or any 
recipients will be included in the new mail list.

Press Next after you have selected the required address book entry.

Note: If your address book is completely empty, or does not contain an entry for the person required you 
will not be able to complete the specification of this mail list.
In this case you need to Cancel here.    Then start again after adding the appropriate address book entry.



On this page of the Mail List Setup Wizard you need to choose one or more tags which will be used to 
control the contents of the new mail list.

The mail list will include all mail messages or news articles which are tagged with all of the tags that you 
choose here.
If this is not what you intended go Back to the previous page and revise your choice there.

Note: Contributed news articles will have been tagged with the newsgroup name automatically.

Normally you will make either a list of tagged mail, by choosing one or more email tags, or a list of articles
contributed to a particular newsgroup, by choosing the corresponding news tag.

The top section initially shows all the Tags available.    You can limit which types of tag are shown using 
the check boxes underneath.
For example if you want to make a list of tagged mail messages, you can hide all the news tags by 
unchecking News.
There may be a lot of tags available and you can use the Find box and buttons to help locate the tag(s) 
you want, using wildcard matching if required.

Select each tag you want in turn and Add it to the Tags applied box at the bottom.    You can also use 
Remove if you make a mistake.

If there are no existing tags which identify the topic you are interested in, you can create a New tag... 
here and Add that to the Tags applied.
This will result in an empty mail list initially, which is useful for setting new tags on the relevant messages:
see Tagging     Messages     with     their     topic  .
Any messages which get suitably tagged in future, by whatever means, will then appear in this mail list 
automatically.

Click Next after you have Added all the tags you need.

Note: Once the new mail list has been created you cannot change the tags which it is based on.    You 
would need to Shut the list, then create a new one again with the right tags.



On the first page of the Mail List Setup Wizard you need to decide what type of mail list you want to 
create, then select the appropriate one of the three options shown.

Click here for a detailed description of the types of mail list available, and their uses.

There are five types of list that you might want to produce:

* A list of all the messages on a particular topic (or topics)
* A list of all the articles contributed to a particular newsgroup

For either of these types select mail tags.

* A list of all the messages that you personally have sent or received
* A list of all messages exchanged with a particular person

For either of these types select correspondence with a particular person.

* A list of all the messages that have been sent or received at your site

If you want this type of list select a mailroom view.

Further notes:

The list for particular topic(s) relies on messages having been suitably tagged according to topic - see 
Tagging messages .

The list of messages for you personally is only relevant in a shared system.    You will also need an 
address book entry for yourself in order to construct such a list.



MIME

MIME stands for 'Multipurpose Internet Mail Extensions'. What it does is extend the basic mail message 
format to allow such things as graphics, video and voice messages to be sent with email messages as 
'attachments' or 'enclosures'. It also allows a wider range of characters to be transmitted: with MIME you 
can transmit almost any character in the Windows character set.

Turnpike lets you both send MIME messages and read MIME messages that you receive - though other 
programs may be needed to view pictures etc. included in these messages. Turnpike can also forward 
MIME messages for you.

However, there's only any point sending a MIME message if the person to whom you send it can handle 
MIME messages. So first and foremost, Turnpike gives you a Send MIME message option to select when
you want the message you are preparing to be sent as a MIME message. This option is automatically 
selected when you are replying to a MIME message but is otherwise generally left clear. Turnpike also 
records if a particular correspondent has sent you MIME messages in your Address book so that it can 
alert you when you are about to post a MIME message to someone who is not known to have MIME and 
offer to send a standard email message instead.

Click here for more information about sending MIME messages (complete with enclosures/attachments)
Or here for information about how you extract what has been enclosed in a MIME message that has been
sent to you



MIME attachments/enclosures

Files sent across the Intenet in a MIME message are typically sent as 'attachments' to the mail message. 
(The other main possibility is that they are left as External bodies for the recipient of the message to fetch 
if they want.)

To attach a file to the message you are preparing, you simply need to ensure that the Send MIME 
message option is selected in the message into which you insert the file. The inserted file is shown as an 
icon within a horizontal bar containing brief details of the file, together with a Properties button which 
calls up a Properties dialog through which you can set the type of file and how it should be encoded.

Where a message you receive contains an attached file, this is also represented by an icon within a 
horizontal bar containing brief details of the file and one or more buttons depending on the type of file 
that's enclosed. If these buttons include a View button, you can use this to see the contents of the 
enclosed file. If not, use the Save button to save a copy of the file in its original format on disk, which you 
can then open by using the appropriate application for the type of file.

It is also possible for MIME messages to include 'In-line enclosures'. In particular, forwarded messages 
are often handled as in-line enclosures. In this case the item is given its own section within the message -
complete with its own toolbar containing an appropriate range of buttons. In the case of a forwarded 
message, the toolbar contains buttons which allow you to reply etc. to the message that has been 
forwarded rather than to the message as a whole. The other main example of In-line items are Digest 
messages. In this case the toolbar includes (among others) Next and Previous buttons to make it easy to
step from one digest message to the next.



Mail

Depending on the sort of information you are looking for, either pick from the following list of topics...

Mailboxes
Reading Mail
Sending Mail
Posting & Re-posting Mail
Sorting Mail
Filing Mail
Calling up past mail (sent or received)
Tagging messages
Mail message headers
Email addresses
Alternative email names
Distributing mail on a shared system
Dead letter mail
Mail from Mailing lists
MIME
Group Mail
Allowing other people access to mail
The symbols used to mark items of mail
Buttons and menus

Or select from pop-up lists of 'How-to' instructions on the following actions:
Processing the messages you receive
Sending messages
Calling up mail eg.on a particular topic
Sorting mail into different mailboxes
Working with Mailing list mail
Making mail accessible to colleagues
Saving/Recovering the mail in your mailbase



Mail Header dialog

This dialog lets you set or change lines in the Header of the mail message you are preparing (although 
not the name of the 'Sender' of the message - this is automatically defined by which system is being used 
and who is the current user of that system).

It is displayed by clicking the Edit mail header button alongside the 'To' and 'Subject' headings for this 
message.

The main aspects you can set are:
Subject: A brief description of what the message is about.
To: The email address(es) of the person(s) the message is to be sent to.
From: Your email address.
Reply-To: The email address to be used for any reply.
Further recipients (CC or BCC): The email addresses of any people to whom either Carbon Copies (CC)
or Blind Carbon Copies (BCC) of the message are to be sent.

Any of these addresses can be entered either by typing or from the Address book by clicking on the Look 
up address button. You can also 'cut and paste' addresses via the clipboard, but note that you will need 
to use Shift + Ctrl + V to paste them in.

In addition, you can add any further Header lines you require in the Others box in the lower part of the 
dialog, while below that, you can select the type of MIME encoding to be used if you have opted to Send 
a MIME message (at the top of the dialog).

Note: If you want to record more than one To, CC or BCC address, click the [+] button next to the 
appropriate slot in the Header dialog. This creates the space for an additional entry in this slot which you 
can then fill in in the usual way. Each slot can only show one entry at a time but the number of entries that
have been set is shown alongside the slot and clicking on the arrow to the right of the slot produces a 
drop-down list of these entries.



Mail List Setup Wizard

You start the Mail List Setup Wizard by clicking New maillist in the File menu.

The wizard will guide you through the process of setting up a new mail list.

There are five types of Mail lists you can create.
On the next page you will need to choose which general type is required.

You can move backwards or forwards through the wizard pages to check or change the details using the 
Back and Next buttons.
Or you can abandon creating the mail list by pressing Cancel on any page.

When you press Finish on the last page the new mail list will be created and displayed.



Mail Lists

All the messages you send or receive are put into your mailbase, along with any news articles you post.

The way to see any of the messages in your mailbase is by calling up the appropriate 'Mail list'.

These lists are like the lists you see of messages in a mailbox (you can even set the way the dates are 
displayed in the same way as in a mailbox). But instead of just covering mail in mailboxes, they cover all 
mail that has ever been sent or received - except for messages that you've deleted - plus any news 
articles you have posted. They even cover mail that is currently in your Out tray. (Markers alongside the 
individual entries show whether the message has been sent or received; whether it is currently in an In 
tray, a Pending tray or your Out tray; and who has access to the message: see Mail symbols.)

There are five types of list that you might want to produce:
* A list of all the messages that have been sent or received at your site
* A list of all the messages that you personally have sent or received
* A list of all the messages that have been exchanged with a particular person
* A list of all the messages that have been exchanged on a particular topic (or combination of topics)
(Note: For this to work, the messages must first have been 'tagged' with their topic - see Tagging 
messages)
* A list of all the articles that have been contributed to a particular newsgroup

These lists are produced in different ways. For details of the steps to take to produce any of these lists, 
just follow the appropriate link above.

Each mail list is displayed in a separate window, which doesn't shut when you close it but is instead 
shown as either a 'filing cabinet' or a 'folder' icon on your screen - though you can shut it if you wish by 
clicking the Shut button shown at the bottom right of the window. The advantage of minimising it in this 
way is that you can simply open it when you want to consult it again. (Don't worry, the list you see won't 
be out of date because any mail that arrives in the meantime will automatically be added to the 
appropriate list.)

Other buttons along the lower edge of the mail list window allow you to switch between ordering the 
messages on when they arrived or when they were sent, and to filter the list to just show incoming or 
outgoing mail if so required. (In each case, the legends on the buttons record what is currently displayed.)



Mail Message Details

Double-clicking on a message icon within either a mailbox or a similar list of messages displays a short 
set of details about the message, which 'fill out' the brief details that displayed within the list itself.

The details given include
* The Subject of the message
* Who is it from
* Who it was addressed to
* The general rules about access to this message
* Where the message is currently located
* What tags have been applied to it

These details are given for information only. You can't change any aspect of the message from this 
display.



Mail Message Header

Each mail message starts with a 'Header' which specifies who the message is to, who it is from, etc.

This Header has a number of component lines, some of which are always included while others are 
optional. The main lines are as follows:

* Various 'Received' lines: recording the systems through which the message passed en route
* 'To' line: giving the email address(es) of the intended recipient(s)
* 'From' line: giving the email address of the sender
* 'Sender' line: giving the email address from which the message was sent (usually but not necessarily 
the same as the 'From' address)
* 'Reply-to' line: giving the email address to be used for the reply (also usually but not necessarily the 
same as the 'From' address)
* 'Subject' line: giving a brief summary of the message (principally of use to automatic mail sorting 
systems)
* 'Date' line: recording when the message was sent
* 'Message ID' line: giving the message's ID
* 'CC' line: giving the email addresses of people receiving carbon copies of the message (optional)
* 'BCC' line (outgoing messages only): giving the email addresses of people receiving 'blind' carbon 
copies of the message, undisclosed to other recipients (also optional)

In general, all you want to know about messages you receive is who it is from, the date when it was sent, 
the subject and, if it has been copied to anyone else, who. So this is the only Header information that 
Turnpike normally displays about the message you read. (The remaining information is only really of 
interest when you have been having transmission problems). To see the full Header, select Display 
Header from the Options menu.

Similarly, when you are writing a message, you generally only need to think about who you are writing to 
and the subject - so this is what is normally displayed. The other parts of the Header are automatically set
for the standard case in which you don't want any 'carbon copies' and the Sender, From and Reply-to 
addresses are all the same. If you want any 'carbon copies' sent or a different Reply address, you will 
need to click on the 'Edit Mail Header' button above the message you are preparing and set the details 
you require there.



Mail Message Status bar

The Status bar at the bottom of mail messages is used to show:

* Who owns the message (Only important on shared systems);

The owner of a message can be either a specific person or a workgroup, but only the owner or a member 
of the workgroup that owns the message can change the tags or the access rules that are applied to the 
message. If you are not the current owner (nor a member of the workgroup that owns the message), all 
the buttons on this status bar will be greyed out.

The current owner (or a member of the workgroup who owns the message) is also the only person who 
can change the ownership.

* Who can access the message (ie. Call it up in mail lists, read it, etc. Also only important on shared 
systems);

The owner of the message (or a member of the group that owns the message) can click on this button to 
switch it between Private (ie. only the owner), Public (ie. anyone on the system) or Restricted which 
makes the access depend on the tags that are set. (Some tags allow anyone to call up mail marked with 
this tag: others only allow access to specific people or workgroups.)

* What tags have been applied to the message

Next to the Private/Public/Restricted button is a Tags button, followed by a list of the tags that have been 
set. The owner of the message (or a member of the group that owns the message) can apply other tags 
to the message by clicking the Tags button and setting the required tags in the Tag Selection dialog that 
appears.



This page of the Mailbox Setup Wizard is in two sections.

Incoming mail

This section is just to confirm the list of rules which will be applied to this mailbox.    You supplied these on
the previous page.

If you need to change any of the rules go Back to the previous page.

Outgoing mail

Here you supply information to identify yourself in any email messages you compose while this mailbox is
selected.
Typically these details will be used when you reply to messages in this mailbox.

The Email name and Name entries are used to construct the reply-to address shown above.

Using the Browse button you can select a different signature file if required.



This page of the Mailbox Setup Wizard is in two sections.

Incoming mail

Here you specify the accept mail addressed to rule:

You can choose an email name from the list or type in a different name.
Unless you use wildcards only mail addressed to exactly this email     name   will be accepted by this mailbox.

Note: the characters '?' and '*' are interpreted as wildcards for partial matching so they cannot be used 
literally.
Click here for an explanation and examples of partial matching with wildcards.

Outgoing mail

Here you supply information to identify yourself in any email messages you compose while this mailbox is
selected.
Typically these details will be used when you reply to messages in this mailbox.

The Email name and Name entries are used to construct the reply-to address shown above.

Using the Browse button you can select a different signature file if required.



This page of the Mailbox Setup Wizard is in two sections.

Incoming mail

Here you specify the accept mail sent by rule.

You can pick an email address from the Address Book or type in a different address.
Unless you use wildcards only mail sent from exactly this email address will be accepted by this mailbox.

Note: the characters '?' and '*' are interpreted as wildcards for partial matching so they cannot be used 
literally.
Click here for an explanation and examples of partial matching with wildcards.

Outgoing mail

Here you supply information to identify yourself in any email messages you compose while this mailbox is
selected.
Typically these details will be used when you reply to messages in this mailbox.

The Email name and Name entries are used to construct the reply-to address shown above.

Using the Browse button you can select a different signature file if required.



This page of the Mailbox Setup Wizard is in two sections.

Incoming mail

Here you specify the accept if subject line matches rule:

Text which you specify here without any wildcards will match any subject line beginning with that text.
Often you would want to match a particular word or phrase anywhere in a subject line; to do that include 
the wildcard character '*' at the beginning.

Note: the characters '?' and '*' are interpreted as wildcards for partial matching so they cannot be used 
literally.
Click here for an explanation and examples of partial matching with wildcards.

Outgoing mail

Here you supply information to identify yourself in any email messages you compose while this mailbox is
selected.
Typically these details will be used when you reply to messages in this mailbox.

The Email name and Name entries are used to construct the reply-to address shown above.

Using the Browse button you can select a different signature file if required.



This page of the Mailbox Setup Wizard has three sections.

The first two sections are only relevant on systems with more than one user.

By default, once read, the mail will be:

You select one of: public, private or restricted to control who will be allowed to read the messages in 
this mailbox.

Mail is always marked as private until it has been read, then the default access specified here will be 
applied.
See Allowing access to mail for further information.

By default, mail will be owned by:

Usually select the person the mail is addressed to.
Otherwise pick the person or group from the list.

Only the owner of an email message is allowed to change its tags or read access.
See Allowing access to mail for further information.

Tags

Tagging is a useful facility for keeping track of different categories of mail messages.

If you select Yes all mail handled by this mailbox will automatically be tagged.
The next page will ask for details of which tags to apply.

If you select No the mail will not be automatically tagged.



This page of the Mailbox Setup Wizard. is in two sections:

Flash when

Select whether the mailbox icon will flash; there are 3 choices.

Address book

If you select add addresses then email addresses from any messages arriving in the mailbox will 
automatically be added to the address book.

Otherwise the address book will not be changed.



On the first page of the Mailbox Setup Wizard. you need to choose the type of rules to control which 
messages are put into this mailbox.

The choices are:

* Who the mail is addressed to
You will specify one email name and all messages addressed to that person will be put into this 
mailbox.

* Who the mail is from
You will specify one email address and all messages from that address will be put into this mailbox.

* The subject of the mail
You will specify some text to identify a subject and all messages with a matching subject line will be put 
into this mailbox.

* Other criteria or a combination of the above
Select this option if you want a combination of several rules from any of the above categories or if you 
want to use any Custom Rules.



This is the last page of the Mailbox Setup Wizard.

Here you can keep the suggested name for the new mailbox or type in another unique name.

You can move backwards and forwards through the wizard pages to check or change the details you 
have entered using the Back and Next buttons.

When you press Finish here the new mailbox will be created.

You can further customize or change the characteristics of the mailbox later if required by taking the 
Alter mailbox option in the File menu.



On this page of the Mailbox Setup Wizard you can set up one or more rules to control which mail 
messages will be accepted or rejected by this mailbox.

In the top section you choose whether mail which satisfies a given rule will be accepted or rejected by this
mailbox. (Accept is the usual case.)

In the middle section you can specify one of the three simple rule types available:

Note: In any of these rules the characters '?' and '*' are interpreted as wildcards for partial matching so 
they cannot be used literally.
Click here for an explanation and examples of partial matching with wildcards.

Addressed to

You can choose an email name from the list or type in a different name.
Unless you use wildcards only mail addressed to exactly this email     name   will be accepted (or rejected) by
this rule.

Sent from

You can pick an email address from the Address Book or type in a different address.
Unless you use wildcards only mail sent from exactly this email address will be accepted (or rejected) by 
this rule.

Subject Line Matching

For subject line matching only, text which you specify without any wildcards will match any subject line 
beginning with that text.
Often you would want to match a particular word or phrase anywhere in a subject line; to do that include 
the wildcard character '*' at the beginning.

Custom rules 

If you find you cannot express the selection criteria you need using any of the simple rule types, you will 
need to construct one or more Custom     rules   instead.

Note: Custom rules are more powerful, but also more difficult to construct.    The best advice is to use 
them only as a last resort.

The bottom section contains the list of rules to be applied and three buttons to Add, Remove or Alter 
rules in the list.

Use the Add button to add each rule to the list after specifying it above.

Note: If you are making a list of several rules you should add the most important ones first, as the first rule
which is satisfied determines whether a message is accepted (or rejected).
If you get the rules in the wrong order you can adjust the order later by taking the Alter mailbox option in 
the File menu.

You can also select rules you have already added to the list and use the buttons to Alter or Remove 
them.





On this page of the Mailbox Setup Wizard.you must select one or more tags to be automatically applied to
all mail messages handled by this mailbox.

Tagging messages is a useful facility for keeping track of different categories of mail messages.

Note: if you did not intend to have any automatic tagging of mail for this mailbox go Back to the previous 
page and select No to the question about tags.    Then go Forward again and this page will be skipped.

In the top section there is a list of the tags available and you can select any tags to be added one at a 
time.    Use the Add button to add each one to the list of Tags applied below.

Where the tag you want hasn't been set up yet, you first need to click the New tag button and set up the 
new tag you want in the Make New Tag dialog that is then displayed.    The new tag will then be included 
in tags available.

You can also Remove one or more selected tags from the Tags applied list if you make a mistake or 
change your mind.



Mail buttons and menus

When you are working with a mailbox, you are offered:

A toolbar

Plus the following menus:

File
Edit
Search
Message
Classify
Options
Window
Help

For details, click on the appropriate entry.



Mail symbols

In a Mailbox:
Unread message
Message that also appears in another mailbox (see Mailboxes)
Item of Group mail
Message that has been read
Message that is mirrored from a POP mailbox
Message that's private to you
Message that only you plus a restricted list of other users can read

In a Message:

Element of message that is offered in a choice of Alternative forms. 

(on a horizontal bar) File enclosed in a message (see Extracting files from messages)

(on a horizontal bar) Forwarded message follows.

(on a horizontal bar) Forwarded article

(on a horizontal bar) Text file enclosed in a message (see Extracting files from messages)

(on a horizontal bar) Returned mail

(on a horizontal bar) Document that uses an unknown character set: may not be shown correctly

 or 

 (on a horizontal bar) Text 'signed' using author's PGP signature

(on a horizontal bar) External body

In a Mail List:
Message that has been received
Message that has been sent
An article posted to a newsgroup
Message currently in an In tray
Message currently in a Pending tray
Message currently in your Out tray



Message that is mirrored from a POP mailbox
Message that's private to you
Someone else's private message
Message that only you plus a restricted list of other users can read

In the Out tray:
Message waiting to be sent
Message with multiple recipients waiting to be sent (Number of recipients shown in the box; 

individual messages also shown as waiting to be sent)
Message that is being transmitted*
Message that has been sent*
Message that couldn't be sent*

* Seen only very rarely



Mailbox Setup Wizard

You start the Mailbox Setup Wizard by clicking New mailbox in the File menu.

The wizard will guide you through the process of setting up a new mailbox.

On the wizard pages you can specify:

* the rules governing the type of mail you want in the mailbox
* the name of the mailbox
* whether its icon will flash
* whether addresses will be automatically added to the address book
* whether any tags will be automatically applied to email messages
* who will be allowed to read the messages
* information to identify yourself when you reply to messages

You can move backwards or forwards through the wizard pages to check or change the details using the 
Back and Next buttons.
Or you can abandon creating the mailbox by pressing Cancel on any page.

When you press Finish on the last page the new mailbox will be created.

You can further customize or change the contents of the mailbox later by taking the Alter mailbox option 
in the File menu.



The Mailbox dialog

Selecting Alter Mailbox from the File menu displays a dialog through which you can set or alter the 
characteristics of a mailbox - or remove it if you want.

The dialog has tabs for each of its pages:
* Name
* User info
* Standard text
* Colours
* Fonts
* Tags
* Rules

To start with, the Name page of the dialog is displayed.

If you wish to alter some aspect of an existing mailbox, you simply need to call up the relevant page of the
dialog, make the changes you require and then click the OK button at the bottom of the dialog (or Cancel 
to abandon these changes).

(If the mailbox you are changing is visible on the screen, you may be able to see the effect of the changes
you make by clicking the Apply button at the bottom of the Mailbox dialog - but note that these changes 
can't then be 'undone' by taking the Cancel option.)

If you want to remove the mailbox, click the Destroy button on the Name page.

For information about the different pages of this dialog, either click on the name of the page above or 
press F1 to call up this Help file when you have this page of the dialog on the screen.



Mailbox dialog: Name page

The main thing to set on this page of the Mailbox dialog is a Name for the mailbox you are working on. 
The name you set is entirely up to you, though it is a good idea to make it descriptive of the type of mail 
you want to use the mailbox for. It must also be different from the name of any other mailbox.

In addition to this name, you can also use this page to set:
* Whether the mailbox icon is to flash whenever there's mail in its In tray or just when there are unread 
messages in the In tray (or never)
* Whether the email addresses from the messages inserted into the mailbox should be automatically 
inserted into your Address book.

(In general, you probably will want Turnpike to add any email addresses it finds but if you are setting up a 
mailbox for Sales enquiries, for example, or for dead letter mail you may prefer not to add these 
addresses to your personal Address book.)

The Name page also includes a Destroy button to click if you want to remove the mailbox altogether, but 
you must empty it first. 



Mailbox dialog: Rules page

This page of the Mailbox dialog is all about the 'Rules' that Turnpike is to apply in picking out the items of 
mail that are to be put into the mailbox.

The main features are:
* A box in which the current rules are listed
* Add, Alter and Remove buttons through which you can set up new rules or change existing rules
* Move Up and Move Down buttons to use to put the rules in order of importance if you set more than 
one rule
(The first rule in a list takes precedence over the second and so on down the list. Another way of looking 
at this is that Turnpike acts on the first rule that specifically either accepts or rejects the mail message it is
currently considering.)

If you are the sole user of this Turnpike system or you have been nominated to receive dead letter mail, 
the dialog will also include a Check box for you to tick if you want dead letter mail to be put into this 
mailbox.

Clicking the Add and Alter button displays a further dialog through which the individual rules are defined. 
For information on this further dialog, either click here or press F1 to call up this Help file when the dialog 
is on the screen.

Note: You can only set Rules for mailboxes that you set up in addition to your Default mailbox. When you 
are working on your Default mailbox, the options on the Rules page are greyed out because that mailbox 
has the single unalterable rule that it accepts everything that isn't accepted elsewhere - including dead 
letter mail (if appropriate).

Note too that there is potentially a problem routing mail you pick up from a POP3 mailbox to a particular 
mailbox in that this can appear as dead letter mail to Turnpike (as a result of being stripped of certain 
delivery information). However, the answer is simply to check the dead letter mail option on this Rules 
page because then Turnpike will again be able to route this mail to the correct mailbox.



Mailbox dialog: Tags page

This page of the Mailbox dialog lets you select one or more tags which are to be automatically applied to 
each item of mail that is either put into this mailbox or sent from this mailbox.

The main area of the display is used to list any tags that have been picked out to be applied to the 
messages in this mailbox. To change this list, click the Edit button. This calls up the Tag Selection dialog, 
through which you can either add further tags to the list or remove ones you no longer require.

The Default owner and Default access parts of the display are only important on a shared system where
they let you specify the initial ownership and access rights to be given to the messages in the mailbox. 
Specifically, you can either let the Default owner depend on how the mail is addressed by taking the 
Recipient email name option - or you can make either yourself (under your sign-on name) or one of the 
workgroups you belong to the Default owner by picking the appropriate name from the drop-down list 
associated with the Explicit owner slot. You can similarly use the Default access options to specify, for 
example, that access to the different items of mail that are processed through this mailbox is, in general, 
to depend on the tags that are applied. (For further information, see Setting access through the mailbox.)



Mailbox flashing

The default is for minimised mailboxes to draw your attention that they contain something to read by 
'flashing' - particularly when something new has arrived. Indeed, if new mail arrives while the program is 
minimised, the Turnpike icon itself will flash.

However, the fact that mail has arrived in some of your mailboxes may be very much less important than 
in others, so Turnpike lets you specify for each mailbox whether you want it to flash whenever there is any
mail in the In-tray; to flash only when there is unread mail in the In-Tray; or to never flash.

So if a minimised mailbox which has mail in its In-tray doesn't flash, either it does not contain new mail to 
read or the mailbox has been configured not to flash even when it contains new mail - or you've already 
looked in that mailbox. (When you close a mailbox, it won't start flashing again until something new 
arrives - even if you have left some of the messages unread. It will however start flashing again the next 
time you load Turnpike.)

To check or change the circumstances under which a mailbox will flash, select the mailbox, then take 
Alter mailbox from the File menu and check which 'Flash' option is selected on the Name page of the 
Mailbox dialog (the page of this dialog that's displayed first).



Mailbox toolbar

Address book
Calls up your Address book. For information about the Address book and what it offers, see About the 
Address book

Move to In tray
Moves the currently selected mail message(s) into the current mailbox's In tray - as an alternative to 
dragging them there.

Move to Pending
Moves the currently selected item(s) into the current mailbox's Pending tray - as an alternative to 
dragging them there.

Forward message
Copies the currently selected mail message into a new message for you to send to someone else. You 
just need to fill in the email address of the person to whom you want to forward the message (eg. from 
your Address book), and add a suitable covering note at the start of the message - then click the Post 
button to send the message on. (See Forwarding mail)

File message
Removes the currently selected item(s) from your mailbox but saves them in your mailbase so that you 
can call them up later if you want (see Mail lists).

Reply
Sets up a new message for you to send in reply to the current message. This new message not only 
contains a copy of this message (or at least of the section you've marked) but also has the subject, the 
email address of your correspondent, your personal details (email address etc.) and your current 
signature already in place. You just need to delete the sections of the old message that you don't want to 
include in your reply, add what you want to say - then click the Post button to send the message. (See 
Replying to Mail)

Delete message
Moves the currently selected item(s) into your Waste basket - as an alternative to dragging them there.

Start new email
Sets up a new message for you to send, complete with your personal details (email address etc.) and 
your current signature already in place. You just need to type your message, fill in the Subject and the 
email address of the person to whom you want to send the message (eg. from your Address book) - then 
click the Post button to send the message. (See Sending Mail)



Mailbox/Newsstand dialog: Colours page

This page of the Mailbox dialog and the Newsstand dialog lets you select both the colours used to display
the messages / articles in the mailbox / newsstand you are currently working on and the colours used to 
display the different types of text that can appear in those messages.

The main part of this page is taken up by a sequence of samples that show how these different types of 
text are currently displayed. To change any of the colours used, click the Alter button to display the 
Colour Selection dialog, set up the dialog for the type of text or background you want to change (by 
picking this from the drop-down list) then pick out the colour you want either from the colour palettes or 
from the colour spectrum offered by the Colour Selection dialog.

Clicking the Default button returns the colours used for all the different types of text to the ones that 
Turnpike initially set for you.



Mailbox/Newsstand dialog: Fonts page

This page of the Mailbox dialog and the Newsstand dialog lets you set both the font used to display your 
messages / articles on the screen in the mailbox / newsstand you are currently working on and the one 
used if you print a message or an article from this mailbox / newsstand.

The fonts that are currently used are shown in the two slots on this Fonts page. To set a different font for 
either the screen display or for printing, click the Alter button alongside the font you want to change, then 
pick out the font you want from the Font dialog which is then displayed.

Clicking the Default button returns the fonts used to the ones that Turnpike initially set for you.

Note: If you choose a proportionally-spaced (PS) font for the screen, you won't a consistent number of 
characters per line in the messages / articles you prepare. Instead some lines will contain many more 
characters than others. In particular, some lines may contain more than 80 characters. This is fine where 
you know that the person reading the message uses a similar font to display their messages, but if you 
don't know that, it is better to use a fixed-pitch font which will give you a consistent approx. 72 characters 
per line with the default margins Turnpike sets.



Mailbox/Newsstand dialog: Standard text page

The standard text referred to on this page of the Mailbox dialog and the Newsstand dialog is the text used
to introduce:
(i) Quotations from a message or article that you are replying to
(ii) Messages that you forward to someone else

The display includes slots as follows:
Attribution: for the phrase to be put at the start of replies / follow-up articles that you send from this 
mailbox/newsstand
Forwarding: for the phrase to be put at the start of messages / articles that you forward

Turnpike automatically sets suitable forms for each type of text, but if you want a different style of 
introduction you can set this here.

Note: It's useful to include information from the message itself in these phrases, such as the date it was 
posted or the person who wrote it. The places where these details are to be inserted are marked with 
placeholders made up of % followed by a letter: for example, %d is used to mark where the date of the 
message should be inserted; %a the email address; %m the message ID. For full details, see Attribution 
& Forwarding text.

Note too that if you want to include a % in your message, you will need to write this as %%.



Mailbox/Newsstand dialog: User Info page

This page of the Mailbox dialog and the Newsstand dialog lets you set the personal details that you want 
used in messages and articles that you prepare from the mailbox/newsstand you are setting up. The 
details you can set are as follows:

Email name: Which of your email names should be used where your email address is quoted 

Name: The full name to be quoted

Domain name: The site address to be given

Organization: The organization you should be seen as representing

Reply-To: The Reply-To address to be specified in email messages

Signature: Which of the various signatures you've got saved on disk should be used. (Use the Browse 
button to select a different signature file if required.)



Mailboxes

Any mail you receive or send is handled through 'mailboxes' which each have:
* An In tray for the mail you receive
* A Pending tray for mail you've read but haven't yet processed

When mail is received it is automatically put into an appropriate mailbox, which if it's not open on the 
screen, will flash to draw your attention to it. (If your mailboxes don't flash, click here.)

To start with, all your mail is put into the same mailbox, but you can readily arrange to sort your mail into 
categories by setting up mailboxes for particular types of mail. You can have as many of these as you 
like. You might, for example, want to set up a special mailbox for mail with the word Urgent (or equivalent)
in its subject line or for mail sent from a particular email address. Any mail you receive that isn't 
specifically selected by any of these additional mailboxes will continue to be put into your original 'default' 
mailbox. (Note: If a mail message meets the criteria for inclusion in more than one mailbox, it will initially 
be shown in the In tray of each mailbox but it will automatically disappear from the other mailboxes once it
has been read in one mailbox.)

Different types of mail often need a different style of reply. So Turnpike also lets you set up each mailbox   
- including the default mailbox - so that messages sent from that mailbox automatically have the 
appropriate details included in them. This covers such things as the signature that is inserted, the email 
name (the name given before the @ in the email address) that you give and the way forwarded messages
are introduced. See User information 

You can also specify for each mailbox:
* A list of tags that you want applied to mail that is put into this mailbox
* The colours and fonts used to display the contents of the mailbox
* The font used when you print a message from this mailbox

You can also give each mailbox a suitably descriptive name - for example, you may well opt to call a 
mailbox by the same email name that you've set it up to select mail by. But giving a mailbox such a name 
doesn't automatically make it select such mail (as some users have supposed) nor does your choice of 
what to select set what the mailbox is called.

Note: If you aren't happy with the email details, signature or colours that Turnpike sets for you or the font 
it uses to print your messages, make the changes you want to your 'default' mailbox before you start 
setting up any other mailboxes. This will save you work in defining other mailboxes because the 
corresponding details in any new mailbox are initially copied from your default mailbox.



Mailing lists

Mailing lists do a similar job to newsgroups in that they provide people with special interests with a way of 
sending a message to everybody that shares that interest. Indeed, some Mailing lists double as 
newsgroups so that everything that's sent to the newsgroup is also sent to the Mailing list and vice versa.

The main difference from newsgroups is that Mailing lists contact people via the Internet Mail system, 
rather than via the News feed. The reason for having Mailing lists as well as newsgroups is that not 
everyone on the Internet has access to the newsgroups. In particular, people who don't use the Internet 
directly but instead log on to a network which has a gateway to the Internet may not have access to the 
News feed.

The way in which Mailing lists work is through particular email addresses being set up as 'mail reflectors'. 
Any message that is sent to one of these addresses is then automatically copied to everyone who has 
'subscribed' to the corresponding mailing list - giving the required result. Click here for information on the 
procedure you need to follow in order to subscribe to a Mailing list. (If rather than subscribe to someone 
else's list, you want to set up a list of your own, there isn't any specific support for this within Turnpike at 
present but you can get much the same result by recording the email addresses to which the mail needs 
to be sent as a distribution list within your address book.)

Messages that come from a Mailing list are standard mail messages but if you follow Turnpike's 
procedure for subscribing to a Mailing list, Turnpike will arrange that they are filtered out from your other 
mail and handled as special newsgroups alongside the other newsgroups you read. (So that you can 
readily spot them, mailing lists are automatically given a ! at the start of their name.)

Not only is this the more natural place for this material but it also has three important advantages. Firstly it
ensures that these messages don't clutter up your mailboxes. Secondly, it means the messages are 
threaded to show you how the different messages follow on from each other. Thirdly on systems with a 
number of users, it means that the messages from a Mailing list can be available to everyone at the same
site: there's no need either for multiple subscriptions or for someone to take on the task of circulating 
interesting items to their colleagues.

It also means that, like news articles, the messages you get from a mailing list will be automatically 
expired after a certain number of days. But assuming you have suitable administrative powers, you can 
set the expiry time you want for each mailing list through the Newsgroups Subscriptions dialog - again just
as for newsgroups.

Click here if there's a mailing list you already subscribe to that you would like handled as a newsgroup in 
future.



Mailroom view

The Mailroom view gives a list of all the messages in your mailbase - that is, all the email messages that 
have ever been sent or received (except for any that have been explicitly deleted), plus any articles that 
have been contributed to the newsgroups.

Turnpike automatically gives you access to this Mailroom view. You just have to double-click on the 'filing 
cabinet' icon on the Turnpike desktop or select Mailroom view from the Window menu.

Further copies of the Mailroom view can be made by taking the New mail list option from the File menu 
to start the Mail     List     Setup     Wizard  .
Note: These additional copies can be shut when you've finished with them by clicking the Shut button in 
the bottom right corner of the Mailroom view display, but this button is disabled in your last copy to ensure
that you always have access to at least one copy of this display.

What you see when you open this view is a complete list of all the messages in the mailbase, arranged in 
date order (newest first) - though this can be tailored to some degree. In particular, you can choose 
whether the ordering is based on the date each message was sent or when it arrived on your system, and
you can opt to filter the list to show just incoming messages or just outgoing ones, by clicking the buttons 
shown at the bottom left of the Mailroom view display. Note: The legends on these buttons always show 
the current selection, and clicking on them cycles through the possible states.

You can also change the width of columns to suit the size of your screen by dragging the vertical bars 
between each of the column headings.

Note: In general, you can open, print etc. any of the messages directly from the Mailroom view - just as if 
you were seeing them in a mailbox - but on a shared system, you won't be able to open any message to 
which you don't have personal access - or see its subject. Such messages will be marked  at the start 
of the line, while messages that are private to you will be marked 

 and messages that are available to a restricted list of people (including yourself) are marked 
. (If a message has none of these markers, it's available to anyone to read.)



Making access to mail dependent on topic

*** Only relevant on shared systems ***

The topic of a message and who needs to see it often go hand in hand - so along with each tag, you can 
record who can access messages marked with this tag.

The steps used to set up and apply tags that also set access details are much the same as those used to 
set up tags which simply record the topic of a message (see Setting up tags). The only difference is that 
as well as setting the name of any tag, you also need to set both the range of users that have will have 
access to this tag and the owner of the tag. (People with access to a tag can see messages marked with 
a tag but only the owner can add the tag to an item of mail (or remove it). Also, only the owner can 
change the list of people who have access to the tag.)

For this, tags are divided into three types - 'Private', 'Group' and 'Public'. Usually, a Private tag is only 
used by the person who creates the tag, who is also the only person who can see messages marked with 
this tag. Similarly, a Group tag can only be used and accessed by members of a specified workgroup - but
a Public tag can be used and accessed by anybody.

(The type of tag is set alongside the name of the tag in the Edit tag / Make new tag dialog that appears 
when you set up or modify a tag.)

But while these general definitions will give the results you require in most cases, there may be instances 
in which you want to give other users access to a 'Private' tag or a 'Group' tag. You might, for example, 
want to give one of your colleagues permission to view the mail you receive on a certain topic. So the Edit
Tag dialog includes an Access option to let you add further users and workgroups to the list of people who
will be able to see mail marked with this tag.

Click here for further information about the Edit tag / Make new tag dialog.

Important: The access details associated with your tags only come into play when the overall access rule
(shown on the status bar below the message) is set to 'Restricted'. (Such messages are also marked  in
mail lists.) If the overall access is 'Private' or 'Public', then this setting takes precedence over the access 
details set through the tags. See Allowing access to mail.



Margins and tabs

Messages and articles you prepare are laid out following the markers set on the Ruler line above the 
message. (If no Ruler line is shown, select Display Ruler from the Options menu.)

The two main markers are the left and right margin markers. These are initially set to give you an average
of 72 characters per line whatever font and typesize you are currently using to display your message on 
the screen. (Note: If you use a proportionally-spaced (PS) font, some lines may have considerably more 
than 72 characters per line while others have considerably less. If any lines contain more than 80 
characters, you will be warned of this when you post your message/article because such lines are difficult 
to display on some people's systems.)

Between these margins are a number of default tab positions, set at every 8th character along the line. 
(The scale on the Ruler line converts these character positions in the screen font into distances in 
inches.)

In common with other Windows applications, clicking on the Ruler line places a simple tab at that point 
and clears the default tabs to the left of this position. This tab can then be dragged to a new position or 
dragged off the Ruler line if it's not required.

Dragging the right margin marker out or in increases or reduces the number of characters your message 
will have on each line, while dragging the two parts of the left margin marker apart lets you indent your 
paragraphs. (The upper part of this marker marks the start of the first line of the paragraph; the lower part 
marks the start of subsequent lines in the usual way.)

In addition, pressing Shift Tab inserts an 'Indent tab' which indents the text that follows to the next tab 
position - up to the end of the paragraph.

When you post the message, Turnpike automatically inserts a carriage return at the end of every line and 
converts tabs and indents into spaces so that the message will have the same line breaks when it's read, 
regardless of the type of system used by the person who receives the message.



Marking out text
To mark out text you want to copy, move or delete, move the pointer to the start of this section of text, 
hold down the mouse button and then drag the pointer to the other end of the section. (Alternatively, if you
want to select the whole of a message or an article, you can simply click somewhere in this text, then take
the Select All option from the Edit menu.)

The text you select is shown highlighted.



Marking threads as interesting

To mark a thread 'Interesting':

Either: Double-click on its 'Classification' box (the leftmost of the three shown for the thread in the 
newsgroup list) until the thread is marked 
Or: Select the thread and click on the Mark as interesting button
Or: Select the thread and then take the Class as interesting option from the Classify menu

To mark as 'Not interesting':

Either: Double-click on its 'Classification' box (the leftmost of the three shown for the thread in the 
newsgroup list) until the thread is marked 
Or: Select the thread and click on the Mark not interesting button
Or: Select the thread and then take the Class Uninteresting option from the Classify menu

Note: If a thread has already been marked Interesting or Not interesting, you can clear this marking either
by taking the Declassify option from the Classify menu or by double-clicking on its Classification box 
until the thread is marked 



Message menu

Open message
Cancel article
Reply to message
Forward message
Forward "as is"
Reject mail
Start new email

Click here for more information on reading your mail.
Or here for more on sending mail.



If you are downloading mail by POP3 you can choose to mirror your email. This means that the state of 
your mailbox on your Access provider's server will match that of your Turnpike mailbox. If you leave email 
in a Turnpike mailbox, a copy will also remain on the server. If you file or delete the email in Turnpike, it 
will be deleted from the server next time you connect.

This option is useful if you want to dial in and read your mail from more than one place. Remember, 
though, that the email will be deleted from the server next time you log in if you delete or file it in 
Turnpike. You can choose whether or not to mirror POP3 email by going to the Connect program, 
selecting the Configure menu and then choosing the Email Transfer option.



Missing articles

The Connect program shows the number of news items downloaded. These may be headers, bodies or 
complete articles. Because of this, and other reasons outlined below, the number reported by Connect 
won't necessarily match the number of new articles that appear in your newsgroups, so any discrepancy 
in these figures is unlikely to indicate a problem of missing articles.

Firstly, the totals in the newsgroups don't include articles in threads that have been marked Uninteresting. 
They also don't include articles killed by kill rules, even though the headers of these articles will have 
been downloaded (and counted by Connect) in order to check them. Moreover, articles that pass the kill 
criteria are counted twice because the headers and the bodies are downloaded separately - so even if 
your rule fails to kill anything at all, Connect's item count will be twice the number of articles received.

On the other hand, articles which have been cross-posted to several newsgroups are only fetched (and 
counted) once by Connect, but they will feature in the count of each of the newsgroups to which they 
have been posted.

Another reason for a discrepancy in the numbers is that you may be collecting news for newsgroups 
which no longer appear in a newsstand - although Turnpike does check that all subscribed newsgroups 
appear in someone's newsstand whenever someone with permission for news administration signs on 



Moderated groups
A moderated newsgroup is one in which contributions aren't posted directly to the newsgroup but instead 
are initially sent by email to a 'moderator' who decides whether the articles are appropriate for inclusion in
the newsgroup. This procedure improves the quality of the contributions to the newsgroup and keeps the 
discussions on target, but at the cost of a slower response rate.



Moving Turnpike to another machine/system

If you want to move Turnpike to another PC or you upgrade your PC to a different operating system, don't 
try simply copying all the old files from your old system to the new one. Instead:

1. Use the Turnpike Setup program to re-install an appropriate version of Turnpike on the new system.

2. Copy the TURNPIKE.USR and CALLS.TPK files, the NEWS directory, the MAIL directory and the 
USERxxx directories (together with any special .ACC, .CST or .MDM files you use) from the old 
Turnpike directory to the new one (replacing any already there).

3. Run both the main Turnpike program and the Connect program and check that each of these are set 
up as you require (as described in the 'System Administration' section of the Turnpike Setup book).

If you are asked for your Site ID and your Site Secret, be sure to give the same ones as were given when 
Turnpike was originally installed - otherwise you won't be able to read any of the mail you transfer from 
the old set-up.



Click on a topic:

Backing up your Turnpike files

Moving Turnpike to another machine

Upgrading to the latest version of Turnpike

The Multiple-Access version of Turnpike



Multiple Access
The standard Turnpike software can be used by up to 99 people, but it is a 'single user' version, which 
means that you can only have one copy of Connect and one copy of Turnpike running at the same time 
(although they do not necessarily have to be on the same machine).

If you wish to install Turnpike on a LAN (Local Area Network), with a copy of the offline software on each 
workstation, run the Turnpike Setup program on your central server, choose 'custom install' and then 
select Turnpike Workstation Setup. This will place a special setup program on your central server from 
which Turnpike can be installed onto each workstation.

LAN Administrators should note that mail that has been collected by Turnpike can be accessed across the
network by other mailreading software if you enable the POP3 Server option, although again only one 
person at a time can use the standard version of Turnpike.

If you require more than one person to be able to use Turnpike simultaneously, you will need a Multiple 
Access version of the program. This still uses just one copy of Connect, but allows you to have multiple 
copies of the Turnpike program running, up to the number of seats purchased. Email info@turnpike.com
for further details.



News

Depending on the sort of information you are looking for, either pick from the following list of topics...

Advice to new users
Newsstands
Newsgroups
Discussion threads
Subscribing to newsgroups
Download options
Reading news
Numbers of articles
Picking out interesting articles
Killing unwanted articles
Restricting access to newsgroups
News article headers
Posting news
Binaries
FAQs
The symbols used to mark news articles/groups
Buttons and menus

Or select from pop-up lists of 'How-to' instructions on the following actions:
Setting up a newsstand
Reading newsgroups
Contributing to newsgroups
Sorting out interesting articles
Saving articles
Saving/Recovering the newsbase



News Article Kill Rule dialog

This dialog lets someone with Kill Article permission set up or modify the details of a Kill rule.

It is displayed both when you opt to set up a custom Kill rule (by taking the Custom rule option from the 
main Kill article dialog) - and when you opt to Add or Alter a Kill rule listed when you take the Review 
option from the Kill Article dialog.

Each time you call up the dialog sets the details of one Kill rule.

There are three main aspects of an article that you may want to create your rule about:
* Who it was written by - for which you need to select Written by and quote their email address in the 
adjacent slot
* The subject - for which you need to select Subject line matching and give the text to match in the 
adjacent slot
* How long it is (as given by the Lines entry in its header) - for which you need to select Longer than 
and enter the critical number of lines in the adjacent box

As well as setting the detail of the rule, you also need to set (at the top of the dialog) whether you want 
Turnpike to kill articles that meet this rule (the Reject option) or to not kill articles that meet this rule (the 
Accept option).

If you want Turnpike to pick out articles to kill on the basis of some other aspect of the article header, you 
can specify this by selecting the 'Custom rule' option and setting up the appropriate Custom Kill rule in 
the Custom rule slot of this dialog - though be warned: this is highly 'techie' stuff.

Note: The role of the Accept option is mainly to allow you to retain articles that would otherwise be killed 
by one or other of the 'Reject' rules you have set up. In the case of a    Browse group an Accept rule will 
allow articles meeting the conditions of the rule to be downloaded in full automatically.



News Header

Every news article starts with a 'Header' which specifies such things as the subject of the article, which 
newsgroup(s) it is being contributed to and who wrote it.

This Header has a number of component lines, some of which are always included while others are 
optional. The principal lines are as follows:

* 'Path' line: recording the systems through which the article has been passed
* 'From' line: giving the email address of the sender
* 'Newsgroups' line: listing the newsgroups to which the article is being contributed
* 'Subject' line: giving the subject of the article
* 'Date' line: recording when the article was posted
* 'Organization' line: giving the author's affiliation
* 'Message ID' line: giving the article's ID number (guaranteed to be unique)
* 'Followup-to' line (optional): giving the group to which an Follow-up articles should be posted
* 'References' line: listing the IDs of the articles to which the article is a Follow-up (if applicable)
* 'Keywords' line (optional): listing one or more keywords for the article (not used directly within Turnpike)
* 'Summary' line (optional): giving a brief summary of the article - useful for readers who just 'browse' the 
newsgroup

(In addition, News Headers may include 'non-standard' lines with names starting X-. For example, many 
news articles start with an 'X-ref' line which records cross referencing information used by the News 
server from which you get your News.)

In general, all you want to know about an article you read is its subject, who wrote it, the date when it was
posted - plus details of any additional newsgroups to which it has been posted and any special Follow-up 
instructions that have been set. So this is the Header information that Turnpike normally displays about 
the message you read. To see the full Header, select Display Header from the Options menu.

Similarly, when you are preparing an article for posting, you generally only need to think about the subject
and which newsgroup you wish to post it to - so this is what is normally displayed. The other parts of the 
Header are automatically set for the standard case in which any Follow-ups should be posted to the same
group. If you want to specify a different newsgroup for the reply or you want any replies by mail to be sent
to a different address, click the 'Edit News Header' button shown at the top of the article you are 
preparing and set the details you require in the dialog that appears.



News Header dialog

This dialog lets you set or change lines in the Header of the news article you are preparing (although not 
the name of the 'Sender' of the message - this is automatically defined by which system is being used and
who is the current user of that system).

It is displayed by clicking the Edit news header button shown at the top of the article.

The main aspects you can set are:
Subject: A brief description of what the article is about.
Newsgroups: The name(s) of the newsgroup(s) to which the article is to be posted (separated by 
commas).
Followup-to: The name of the newsgroup to which any Follow-up articles are to be posted (if this is not 
simply the group in which the article appears).
From: Your email address.
Reply-To: The email address to be used for any reply by email.
Keywords: Any keywords under which you would like the article to be picked out by any automatic 
selection process that uses these keyword entries to select articles for reading. (Optional)
Summary: A brief summary of the article - useful for readers who just 'browse' the newsgroup. (Optional)

In addition, you can add any further Header lines you require in the Other box in the lower part of the 
dialog.



News buttons and menus

When you are working in a newsstand, you are offered:

A Toolbar

Plus the following menus:

File
Edit
Search
Article
Classify
Options
Window
Help

For details, click on the appropriate entry.



News symbols

In the list of newsgroups:
First column (Number of Interesting articles to be read)

Newsgroup that hasn't yet been threaded (processed to identify how the articles interlink) - or 
which needs to be re-threaded

Newsgroup that has been threaded

Second column (Number of unread articles)
Newsgroup that hasn't yet been threaded
Newsgroup that has been threaded

In the list of discussion threads:
Thread you've picked out as Interesting
Thread that hasn't been marked either as Interesting or as Not interesting
Thread that you've marked as Not interesting

Unexpanded thread (Double-click on this symbol to see full details of the thread)
Expanded thread

Unexpanded user-defined thread

Expanded user-defined thread

Thread containing unread articles
Thread that has been read
Thread of articles that are being kept beyond their normal expiry time

Thread you have opted to download in full (Browse groups only)

In expanded threads:
Unread article
Article that has been read
Article of which only the header has been downloaded (If you don't know why this might be, click 

here)
Article of which only the header has been downloaded but this includes a summary
Article which isn't immediately available
Article which you have requested to be downloaded the next time you go on-line

Article within a thread that you have opted to download in full (Browse groups only)
Article that was requested but is no longer available from your news server
Article which you have asked to keep past its normal expiry time
Article that you have 'killed'

In articles:
 or 
 (on a horizontal bar) Text 'signed' using author's PGP signature

A spoiler. Pressing the button usually reveals an answer.



'Newsgroup Addition' dialog

The 'Newsgroup Addition' dialog appears when you click the Add button at the bottom of a newsstand.

The top part of the dialog helps you select the newsgroups you want. As you pick each newsgroup out, 
this is added to a list in the lower part of the dialog, so that you can see what you have picked out so far. 
(This lower part of the dialog also includes a Remove button to use if you decide you don't want a 
particular group after all.)

The Ratings button lets you call up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

You pick out the newsgroups you want, one by one from the list in the top part of the dialog. This list is 
initially set to show the groups which are currently subscribed to (ie. downloaded to your site) - but if you 
have News Admin permission, you can switch it to show all the newsgroups available from your Access 
provider's news server by selecting the option you require to the right of the list.

If you know which hierarchy the newsgroup you require belongs to, the best way to pick this out is to start 
typing this in the Find slot at the top of the screen. The section shown in the box will automatically move 
to the appropriate part of the list, from where you can scroll until you spot the group you require.

If you just know the topic you are interested in, type *topic in the Find slot, then use the Find first and 
Find next buttons to work through all the newsgroups that have this topic in their title until you find the 
one you want. (Click here for further information on this.)

When you've found a group you want to add, either double-click on it or click the Add button. The 
newsgroup is then added to the list of Additional newsgroups at the bottom of the screen.

Simply go on selecting newsgroups in this way until you have pick out all the ones you want. Then click 
the OK button to return to the newsstand.

If you add any groups to which you have not yet subscribed, you will be asked if you want to add them to 
your subscription list. (Click here for further information on this).



Newsgroup Rating Services dialog

This dialog is displayed by clicking the Ratings button within the Edit Sign-on Details dialog (or by clicking
the corresponding button within the Edit Workgroup Details dialog when the ALL workgroup is being 
edited).

The top part of the dialog shows the names of the newsgroup ratings services that are currently in use, 
together with details of the maximum levels currently in force for each of the different categories covered 
by each ratings service. Note: If you don't have Ratings permission, these details are shown for 
information only: you won't be able to change anything.

While the cursor is on the name of a service (or this part of the display is blank), you are offered the 
option to: Add a new service; Remove the selected service; and to set whether unrated newsgroups 
should be Shown (treated as innocuous) or Hidden (treated as potentially offensive) - assuming you 
have suitable permission. Details of the selected service are shown at the bottom of the dialog.

While the cursor is on a category, you'll see instead the range of levels that are available in this category, 
together with a description of what the current maximum level represents and of the type of newsgroup 
that might have this rating. Assuming you have suitable permission, you can change the maximum level 
for this category simply by picking from the set offered - but note that any settings you make that select 
levels regarded by the ratings service as unsuitable or potentially illegal will be rejected when you come to
leave the dialog. You will need to pick a lower level instead.



'Newsgroup Subscription' dialog

This dialog lets someone with News Admin permission pick out additional newsgroups to subscribe to. It 
appears when you click the Subscribe button within the Newsgroup Subscriptions dialog.

The box in the upper part of the dialog contains a list of all the newsgroups that are available from your 
Access provider's news server. Simply select the additional newsgroups you require one by one and add 
them to the list in the bottom part of the dialog.

The Ratings button lets you call up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

If you know which hierarchy the newsgroup you require belongs to, start typing this in the Find slot at the 
top of the screen. The newsgroup display will then automatically move to the appropriate part of the list, 
from where you can scroll until you spot the group you require.

If you just know the topic you are interested, type *topic in the Find slot, then use the Find first and Find 
next buttons to work through all the newsgroups that have this topic in their title until you find the one you 
want. (Click here for further information on this.)

When you've found the entry for the newsgroup you want, either double-click on it or click the Add button 
to add it to the list in the lower part of the dialog.

When you've picked out the newsgroups you require, click OK to return to the Newsgroup Subscriptions 
dialog.

If you add any groups to which you have not yet subscribed, you will be asked if you want to add them to 
your subscription list. (Click here for further information on this).



'Newsgroup Subscriptions' dialog

This dialog allows someone with News Admin permission to pick out newsgroups to subscribe to and to 
set such information as:
* How long the articles should remain on your disk (ie. their Expiry time)
* Whether the articles should be copied to your disk in full or, for example, just 'browsed'

It is also the dialog to call up when you want to cancel your subscription to a newsgroup or to limit who 
can read a particular newsgroup.

It is called up by taking the Configure option from the File menu, then selecting Newsgroups from the 
submenu that appears.

* Clicking the Subscribe button calls up the News Subscription dialog, through which you can pick out 
additional newsgroups to subscribe to.
* Clicking the Unsubscribe button cancels your subscription to the currently selected newsgroup.
* Clicking the Access button calls up an Alter Usage dialog though which you can specify which users 
can have access to the currently selected newsgroup.
* Clicking the Ratings button calls up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

To view or change the subscription information set for any of the newsgroups you subscribe to, select the 
newsgroup in the upper part of the dialog. The lower part of the dialog then changes to show the details 
currently set for this group. (The name of the group for which the details are being shown is also included 
in this area of the dialog.) These details cover:

Type: Set to either:
          Full ie. all the articles contributed the newsgroup copied to your disk in full
          Browse ie. just the headers of the articles copied to your disk

Moderated: This check box needs to be selected if the group is known to be moderated. Leave this 
setting as it is unless you know for certain that the current setting is incorrect.

Expire after: Set to the number of days any article in the newsgroup should remain on your disk, after 
which it will be automatically deleted when Turnpike 'expires the news' (usually done automatically 
whenever the Turnpike Connect program is run).

Auto Keep: Select this check box if the articles in the newsgroup are to be automatically marked to be 
kept past their normal expiry time. Note: The Keep markers this places on the articles can be removed 
using the standard Cancel Keep option if it turns out that you don't want to keep these articles after all - 
see Keeping news articles. Clearing this Auto Keep option just stops future articles being marked as to 
be kept.

Last NewNews: Sets the date from which Turnpike will take new articles in this group the next time news 
is collected from your News server. This is normally simply the date articles were last collected but you 
can set a different date using the last/now plus/minus and time options. The date shown automatically 
changes to the date you've selected so that you can check that you have made the correct settings.

IMPORTANT: If you change any of these subscription details, be sure to click the Apply button before 
either leaving the dialog or going on to set or view the details of another newsgroup. Otherwise the 
settings you've made will be lost.



About Newsgroups

A huge number of articles are posted to the Usenet network each day and on a vast range of topics. So to
help you pick out the ones you want, the articles are organised into a system of 'newsgroups', each 
covering a separate area of interest.

In Turnpike, you pick out the newsgroups you are interested in following by allocating them to a 
'Newsstand'. You can then see the different discussions that are going on in these newsgroups and the 
articles that have been contributed by going into your newsstand and opening the different newsgroups 
you've selected in turn. For further information, see Reading News.

Note: New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks 
up articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, 
you can ask Turnpike to pick up a complete new list through the Configure Usenet News dialog in 
Turnpike Connect. This is particularly useful if you change the News server you use (eg. because you 
change Access provider) because not all News servers carry the same range of newsgroups.

* If you can't find a newsgroup that covers your particular topic of interest, keep looking because the 
chances are that there will be one. If there really isn't one, it is possible to set up a new newsgroup but 
there's a formal procedure to follow through which you find out whether anyone else agrees that a new 
newsgroup is needed: see Setting up a new newsgroup.



Newsstand Setup Wizard
You start the Newsstand Setup Wizard by clicking New newsstand in the File menu.

The wizard will guide you through the process of setting up a new newsstand.

On the wizard pages you can specify:

* which newsgroups will be displayed in this newsstand
* information to identify yourself when you reply to or followup news articles
* the name of the newsstand

You can move backwards or forwards through the wizard pages to check or change the details using the 
Back and Next buttons.
Or you can abandon creating the newsstand by pressing Cancel on any page.

When you press Finish on the last page the new newsstand will be created.

You can further customize or change the contents of the newsstand later, using the Alter, Add and 
Remove buttons at the bottom of the window or by taking the Alter newsstand option in the File menu.



Newsstand dialog

Clicking the Alter button at the bottom of a newsstand or selecting Alter Newsstand from the File menu 
displays a dialog through which you can set or alter the characteristics of your newsstand - or remove it 
from your system.

The dialog has a tab for each of its 'pages':
* Name
* User info
* Standard text
* Colours
* Fonts

To start with the Name page of the dialog is displayed.

If you want to alter an existing newsstand, simply select the relevant page(s) of the dialog to make the 
changes you require.

If you want to remove the newsstand, click the Destroy button on the Name page.

When you've finished making the settings you want, click the OK button at the bottom of the Newsstand 
dialog.

For information about the different pages of this dialog, either click on the name of the page above or 
press F1 to call up this Help file when you have this page of the dialog on the screen.



Newsstand dialog: Name page

The main thing to set on this page of the Newsstand dialog is a Name for the newsstand you are setting 
up. This name must be different from the names of the other newsstands you have.

The Name page also includes a Destroy button to click if you want to remove the newsstand altogether. 



Newsstand toolbar

Open newsgroup
Opens the currently selected newsgroup.

Close newsgroup
Clicking on this button closes the current newsgroup and returns you to the list of newsgroups in the 
newsstand.

Redisplay newsgroup
Calls up the list of threads and articles in the current newsgroup.

Next
(Not to be confused with the 'Next unread' button) Clicking this button displays the next article in the 
current group, working through the group thread by thread - regardless of whether this article is marked 
Read or Unread.

Previous
Clicking this button displays the previous article in the current group, working back through the group 
thread by thread - regardless of whether this article is marked Read or Unread.

Next unread
Clicking this button displays either the next unread article in the current discussion thread, working 
through the group thread by thread, or the next discussion in which there is an unread article.

Mark as interesting
Clicking this button causes the currently selected discussion to be marked as Interesting, which means 
that this discussion thread will be moved to the top of the list of discussions the next time the newsgroup 
is re-threaded. For more information, see Picking out interesting articles.

Mark not interesting
Clicking this button causes the currently selected discussion to be marked Uninteresting, which means 
that this discussion thread will moved to the bottom of the list of discussions the next time the newsgroup 
is re-threaded.

Request article
Clicking this button specifies that you want the currently selected article to be downloaded in full the next 
time your system connects to the Internet. (Only active when you have selected either a missing article or 
one for which only the header has been downloaded.)

Reply/Follow-up
Starts the process of responding to the currently selected article - either through a Follow-up article sent 
the newsgroup or through an email message sent to the author of the article. When you click this button, 
a message is displayed asking you to pick whether you want to reply via the News (ie. post a Follow-up 
article) or by Mail (ie. send an email message).

Mark all as read
This button is included in the Newsstand Toolbar to give you a simple way of indicating that you are not 



interested in reading any of the other articles that are listed for a particular newsgroup. Clicking this button
marks every article listed in the current newsgroup as 'Read' regardless of whether you've actually 
opened it or not. Turnpike won't bring any of these articles to your attention again - nor will they be picked 
out when you ask to see the 'Next unread' article (unless you switch the marking back to Unread).



Newsstands

The news articles you download from your News server are accessed through one or more 'Newsstands'.

Each Newsstand has a selection of newsgroups associated with it and the articles that have been 
contributed to those newsgroups are effectively placed in the corresponding Newsstand.

There are a number of different levels at which you can view a Newsstand.

The 'highest' level is a list of all the newsgroups (and mailing lists) that are downloaded to that newsstand.
 and 
 boxes beside a newsgroup in this list means that it hasn't yet been processed to identify how the 

articles interlink. When the newsgroup has been threaded, the boxes are filled in with the number of 
unread Interesting articles and the total number of unread articles respectively. (Totals covering all the 
newsgroups in the newsstand are shown on the status bar at the bottom of the newsstand, together with 
buttons that allow you to change the range of newsgroups and other aspects of the newsstand in various 
ways.)

To see the articles that have been contributed to a particular newsgroup, you simply need to 'open' this 
newsgroup eg. by double-clicking on its name in the list of newsgroups in the newsstand. The newsstand 
then changes to show you a list of the current discussion threads in this newsgroup, in the following order:

1. Threads containing unread articles, with any you've picked out as interesting (marked  ) shifted to 
the top.

2. Threads in which all of the articles have been read (again with interesting threads coming first).

However, if you have picked out any threads as uninteresting (marked  ), these will all appear at the 
bottom of the list, with any threads containing unread articles appearing first in this group.

Within these various categories, threads are presented in date order, with the oldest first.

(Note: These are just a few of the symbols with which newsgroups and articles may be marked: click here
to see a full list of the symbols.)

In the simplest case, you might add every newsgroup you follow to the same Newsstand, but you can if 
you want, sort the newsgroups into different categories by setting up further newsstands.

For information on how you view the articles themselves, see Reading News.



How many articles

Before calling up a particular newsgroup, it is useful to know how many articles there are available to read
in that newsgroup and in particular, how many have been contributed to the threads that you are finding 
interesting.

So when you go into a newsstand, Turnpike shows you how many unread articles there are in each 
newsgroup (in the green box) and (in the yellow box) how many of these articles are in threads that 
you've marked as interesting - with overall totals at the bottom of the newsstand. Then when you go a 
newsgroup, it shows for each thread the total number of articles in the thread (in the blue box) and the 
number of these that are unread (in the green box) - with totals for the numbers of unread and interesting 
articles at the bottom.

The Connect program also shows a total for the number of articles fetched when news is being collected. 
But this won't necessarily be the number of new articles you are offered to read in your newsstands.

For a start, the figure given in the Connect program is the total number of items fetched, whether these 
are full articles, headers or bodies. For newsgroups downloaded in full and 'browse' groups, the number 
of items downloaded will match the number of new articles shown in your newsstands. But if any Kill rules
have been set for a newsgroup, Connect will fetch the headers first, apply your rules then fetch any 
bodies that are required. As a result, each article that isn't killed is counted twice. Indeed, if you've set up 
rules for every newsgroup but no articles are actually killed, you will appear to fetch twice the number of 
articles you get to read.

Furthermore, the articles that are killed by the rules are included in the number of items that were fetched 
but not in the totals shown in the newsstand because you are not expected to want to read these.

Another thing that will make a difference is if you have marked any threads as uninteresting. Articles 
contributed to these threads are also included in the count of items fetched but not in the totals of unread 
articles - again because you are not expected to want to read these.

Cross-posted articles also affect the arithmetic as these can be counted twice (or more) in the 
newsstands but are only fetched once.



Opening/Closing newsgroups

The way to see what discussions are going on in a particular newsgroup and what articles have been 
contributed is to 'Open' that newsgroup - then 'Close' it again when you want to move onto another 
newsgroup.

To open a newsgroup, either:
* Double-click on its icon, or
* Select it and click the Open newsgroup button (or take the corresponding option from the Article 
menu).

To close a newsgroup, either:
* Double-click on the control box of the newsgroup display, or
* Click the Close newsgroup button (or take the corresponding option from the Article menu).



Options menu

Font
Colour
Display Header
Display 'raw' text
Display Ruler

In Mail only:
Date format



Options menu: Colour
Displays a Colour Selection dialog from which you can select the colours used to display certain types of 
text.

Note: The colour you select using this option only applies to the current window and to the background 
colour used in that window. Rather more powerful colour setting is available through the Colour pages of 
the Mailbox and Newsstand dialogs. Click here for information on the Mailbox dialog or here for 
information on the Newsstand dialog.



Options menu: Date format
Lets you to set how the dates of the messages are displayed either in a mailbox or in other mail lists.

For more information on this, see 'Setting the way dates are shown'.



Options menu: Display 'raw' text
Displays any files in the current message that Turnpike has parcelled up into horizontal bars in their raw 
'uuencoded' form.



Options menu: Display Header
Controls the display of full information about a message/article (as distinct from the brief information that 
Turnpike automatically displays).

When this option is selected (shown ticked), the message/article's header is shown in full at the start of 
the message / article. Selecting the option again, both removes both the header from the display and the 
tick from the option.

(The different components of these headers are explained in the sections on 'Mail Headers' and 'News 
Headers' respectively.)



Options menu: Display Ruler
Controls the display of a ruler line (complete with margin and tab markers) above the message/article 
text.

When this option is selected (shown ticked), the ruler line is displayed. Selecting the option again, both 
removes both the ruler from the display and the tick from the option.



Options menu: Font
Displays a Font dialog through which you can select typeface, typestyle and typesize used to display the 
current message / article on the screen.

Note: The selection you make only affects text displayed in the current window. The font used when you 
print messages or articles is set through the Font page of the Mailbox / Newsstand dialog.



The Out tray

Each mail message or news article that you 'post' is initially placed in your Out tray, where they wait to be 
sent out over the Internet the next time your site is connected to your Access provider.

'Letters' are also added to the Out tray icon to show that it contains something waiting to be sent. To see 
what's currently in the Out tray, simply double-click on its icon or select it through the Window menu.

If you need to make a change to a message that's waiting in the Out tray, either open it within the Out tray
and say you want to edit it or drag it to a clear area of the Turnpike desktop, make whatever changes you 
require then re-post it. Note: Even if you are already connected to your Access provider when you 'post' a 
message, the message will stay in your Out tray for at least a minute to give you a chance to edit it before
it is sent.

Click here for an explanation of symbols seen against messages / articles in the Out tray. 



Ownership of mail

*** Only important on shared systems **

The ownership of a piece of mail defines who can change the tags or the access privileges on that piece 
of mail.

The owner can either be a specific person or a workgroup (in which case, any member of that workgroup 
can change the tags and the access rules). The current owner is displayed on the Status bar shown 
beneath the message when this is opened on the screen.

The initial owner of a piece of mail is set through the mailbox in which it is opened. This will have made 
the owner either a particular person (specified through their sign-on name), or a particular workgroup or 
set according to how the message was addressed (see Setting access through the mailbox).

Subsequently, however, either the particular person or a member of the workgroup that owns the 
message can change the ownership, either to themself or to a workgroup they are a member of - by 
displaying the message, clicking the Owner button and selecting the new owner in the Select owner 
dialog that is displayed.



POP3 server options

The POP3 Server options included in Turnpike allow users to access the mail in their Turnpike mailbox 
from outside their Turnpike system - either from a copy of Turnpike running on a machine that doesn't 
have direct access to your mailbase or from another mailreader.

This is a specialist facility intended for use in an office where mail for everyone in the company is 
collected using Turnpike but people don't necessarily always want to use Turnpike to read their mail.

It is not intended for use on a single-machine dial-up system. For a start, it requires the Connect program 
to be running whenever anyone wants to use this facility. Moreover, it requires a live TCP/IP connection 
between the machine on which Connect is running and the machine from which the mailbox is accessed.

You should also note that it opens a route whereby people from outside the company could potentially 
access users' mail. For this reason, the facility has to be specifically enabled within the Connect program 
(either through the Services menu POP3 Server option or through the 'Enable POP3 Server' option in 
the Configure Email dialog). It also has to be specifically enabled for each individual user who is allowed 
to access their mailbox in this way (by giving them Serve POP3 permission within the Configure Users 
dialog).

In addition, the system requires any user wishing to access their mail in this way to give their Turnpike 
sign-on password.

You are strongly advised to ensure that any users for whom this facility is turned on don't have a blank 
password, because that would make it just too easy for someone outside the company to impersonate 
them.

Note: Calling up a Turnpike mailbox from outside counts as an access to the Turnpike system. So with 
the standard 'Single access' version of Turnpike, you can't call up your mailbox while anyone is using the 
main Turnpike program (ie. this program) and vice versa. With the 'Multiple access' version, people can 
call up their mailboxes at the same time as others use the main Turnpike program but only up to the 
number of 'seats' on the system.



Password
Turnpike includes the option of making access to the system - and in particular to someone's personal 
mail files - dependent on giving the correct password.

Depending on circumstances, you will either have had this password set for you by your system 
administrator or set it yourself by setting the password you require in the Edit Sign-on details dialog (see 
Setting passwords). Note: Someone with Alter Users permission can let a user who has forgotten their 
password back into the system - by setting a new password for them in the Edit Sign-on details dialog.

For security, whenever a password is typed or displayed, the screen simply shows * characters 
representing the actual characters of the password.



Permission
The idea of 'permission' only really applies to shared systems, where whoever takes the role of System 
Administrator can specify the administrative actions that the different users of the system can carry out, 
either in their own right or as a result of their membership of a particular workgroup.

Individual permissions may be set by anyone with Alter Users permission through the Edit sign-on dialog; 
permissions associated with membership of a workgroup may be set by anyone with Alter Workgroup 
permission through the Edit workgroup dialog. Click here for details of both the permissions that can be 
given and the actions that they control.

Note: If you don't have permission to carry out a particular action, you'll find the corresponding options 
greyed out.



Picking out interesting articles

Within any newsgroup there are bound to be some discussion threads that interest you and others that 
don't (and others that you are neutral about).

To save you wasting time calling up articles that don't interest you, Turnpike lets you mark different 
threads as Interesting or Not interesting. (Where only a part of a discussion is interesting, Turnpike lets 
you break off part of the discussion and mark it Interesting or Not interesting as you require: see the 
section on 'Breaking threads'.)

The level of interest that's been expressed in a thread is shown in the left-hand column of the list of tiles. 
Threads that have been picked out    as Interesting are marked ; ones that have been picked out as Not 
interesting are marked 

 - while ones that haven't been classified (or which you are neutral about) are marked 
.

When you go into a newsgroup or re-thread it, Turnpike automatically arranges that Interesting threads 
with articles waiting to be read are placed at the top of the newsgroup, while Not interesting ones are 
placed at the bottom and are ignored when you ask to read the 'Next unread' article. (Interesting threads 
that don't contain anything new to read are placed after any 'Neutral' threads containing unread articles.)

Click here for information on how to mark threads as interesting or not interesting.

Note: When you come to the end of the articles that you want to read in a newsgroup, you can avoid 
calling up any others from this newsgroup by clicking the Mark all as read button. Then clicking the Next 
unread button will skip the remaining articles in the group and take you to the Interesting discussions at 
the top of next newsgroup.



Posting & Re-posting Messages

When you are ready to send the mail message or article you've been preparing, you simply need to click 
the Post button on the toolbar above the message. The message is then placed in your Out box (after a 
confirmatory message), from where it is sent on over the Internet the next time you connect to your 
Access provider - either as a single message or, if it's large, divided into two or more parts labelled [1/2], 
[2/2] etc.

That's generally all there is to posting a message, but from time to time, you may want to re-post a 
message or to post a slightly different version of the same message.

The basic procedure for doing either of these things is to call up a mail list which contains this message 
(for example, the Mailroom view of everything sent and received) then drag the message either to your 
Out box or to part of the background display. (Don't worry: this won't change the range of tags on the 
message.) Turnpike then opens the message so that you can make any changes you want before clicking
the Post button to post it.

What this has actually done is send a new message which is fine where you are re-posting a whole 
message but is not what you want when you simply want to re-post part of a divided message that failed 
to arrive for some reason. So when you select part of a divided message to re-post, Turnpike just re-posts
this without alteration so that it can be re-amalgamated with those parts of the message that were 
successfully transferred the first time.



Posting News

The process of contributing an article to a newsgroup is known as 'Posting News'.

The article you post will either be a response to an article that you read (in which case it is referred to as a
'Follow-up article') or it will start a new discussion (referred to as 'Starting a new thread').

After posting, the article is added to your mailbase, stored under the name of the newsgroup to which you
contributed to the article. So if you need to re-post an article or to copy and paste it to another message, 
you should be able to find it easily enough by calling up the Mailroom view of everything you've sent or 
received.

Click here if you want to know more about Responding to the articles you read.
Or here if you want to know about Starting a new thread.
Or here if you want to know about Cancelling articles that you post by mistake.

(By the way, you don't have to finish each article you start before going on to something else: just leave it 
open on the screen or minimised as an icon. Turnpike will automatically save it on disk for you, and it will 
still be there when you come back to it, even if you've left Turnpike in the meantime.)

Note: You are strongly recommended not to post any articles to a newsgroup until you have studied the 
articles that are contributed to that group over some weeks and studied any FAQs that are posted to that 
group.

Furthermore, new users are advised to start by posting a few trial articles to one of the test newsgroups 
that exist, in order to learn what's expected of you. (These test groups are read by people who are 
prepared to give friendly advice when you don't follow the correct conventions - rather than the rude 
comments you will receive if you break the rules in an article you post to a 'real' newsgroup.)



Posting a picture

If you have a picture that you want to post to one of the binaries groups, you need:

* Either to start preparing a new article in the usual way, then click the Insert File button (or take the 
equivalent option from the File menu) and use the File Selector that is displayed to pick out the file 
containing the picture you want to post.

* Or, if you can arrange to see both Windows File Manager and your Newsstand on your screen at the 
same time, you can simply drag the file to the appropriate newsgroup.

Just fill in the Subject slot, check that it is being sent to the correct newsgroup then click the Post button.

If the file is large enough that the article needs to be divided up into a sequence of articles, Turnpike will 
automatically do this for you.



Preparing News & Mail

The steps you take to prepare either a mail message or a news article in Turnpike are pretty much the 
same.

If you want to reply to a message or an article that you've received, you first need to select that item in 
your mailbox / newsstand or to open it up. (If you don't want to reply to a specific item, you just need to 
display the appropriate mailbox / newsgroup for your message.)

Then you just need to click the appropriate button / select the appropriate option as follows:
* To send a reply by email: click the Reply button
* To send a new email message: click the Start new email button
* To follow-up a news article: click the Followup button
* To post a news article on a new topic: take the Start news thread option
(Note: You won't necessarily be offered all these options at once - only the ones that are appropriate to 
what you are doing.)

Turnpike responds by displaying its Message Editor, set up ready for the type of message you want to 
prepare and with your standard signature already in place. Where you are replying to a message or an 
article you've received, Turnpike automatically includes a copy of that message in the new message - 
marked up as a quote according to the standard Internet conventions.

All you need to do is:
* Set up the text you want in your message
* Make any changes you require to the message's header
* Change the signature if you want
- then 'Post' the finished message (by clicking the Post button)

For information on any of these actions, simply click on the title of the action - but new users should click 
here before posting any news articles.

Note: If you're called away before you've finished writing your message or it becomes more urgent to 
write another message, just leave the incomplete message on your screen or minimise it. You can even 
leave Turnpike altogether with the message in this state. The message will be automatically saved in its 
current state - you can finish it and post it whenever you like.



Preparing the message text

For most people, preparing the text of a mail message or a news article in Turnpike will be very like 
preparing text using your standard word processor because Turnpike offers many of the same facilities 
and uses many of the same actions as common Windows word processing programs.

* You enter and delete characters using the keyboard keys
* You can Undo   and   Redo   the changes you make through all stages, by taking the appropriate options in 
the Edit menu.
* You can delete, copy or move blocks of text by highlighting the appropriate section of text and then 
taking the 'Copy', 'Cut' and 'Paste' options from the Edit menu
* You can include ASCII text and other types of file in your message - using the Insert file button
* You can Find   and   Replace   text, again by taking the appropriate options in the Edit menu
* You can set and/or move margins and tabs by dragging and clicking on the Ruler line at the top of the 
message area. (If no ruler is shown, select Display ruler in the Options menu).

The main difference to note is that fancy styling isn't appropriate in mail messages or news articles 
because there's no guarantee that the system receiving these messages will be able to interpret the 
styling instructions that are used. Instead, special characters are used where you want to emphasise 
pieces of text - see the section on 'Standard conventions'. (The Font and Colour options in the Options 
menu simply set the font and colours used to display your message on your screen.)



Previewing before you print

Before printing either the message you're preparing or a message / article you have received, you can 
see how it will look when printed by taking the Print Preview option from the File menu.

Turnpike then shows you as accurately as possible on the screen how the message / article will look if it 
is printed in its current state using the printer and paper that your system is currently set up to use. (If you 
intend to use a different printer or type of paper, leave the Preview temporarily and use the Print Setup 
option in the File menu to set these.)

Moreover you can see how the message looks at different Zoom levels (whole page, double that size 
(area), and double that again), with a choice of either single-page or double-page views at the lowest 
Zoom level. These options can be selected by clicking buttons on the toolbar at the top of the display (this
toolbar also includes buttons for turning from page to page) - or you can cycle through the different Zoom 
levels by clicking the mouse on the Preview display.



Print Preview toolbar

Print
Prints the message or article that you are currently previewing.

Next Page / Prev Page
Allow you to step page-by-page through the message or article you are previewing.

One Page / Two Page
Switches between a Single-page and a Two-page view of the message or article you are currently 
previewing. (Note: Only available at the lowest zoom level.)

Zoom In / Zoom Out
Allow you to display the message / article you are previewing at different zoom levels.

Close
Closes the Preview display.



'Print Setup' dialog

Taking the Print Setup option from the File menu displays a standard Windows Print Setup dialog 
through which you can set the printer and paper you use.

The main features of the dialog are:

Printer: Select either your Default printer or a specific printer as you require.

Paper: Selected from a drop-down list.

Orientation: Select either Portrait (paper used lengthways) or Landscape (paper used widthways) as 
required.

Options button: Click this button to call up a further dialog in which you can set more advanced features 
such as printing to a file and duplex printing (if your printer supports this).



'Print' dialog

Taking the Print option from the File menu in order to print a message or an article displays a standard 
Windows Print dialog through which you can set such things as the number of copies you want.

The main features of the dialog are:

Printer: This entry shows your current printer. (If you want to use a different printer, click the Setup 
button.)

Print Range: Through which you can specify that you want to print either the whole message/article or a 
range of pages. (You can find out how a message or article divides into pages by previewing it.)

Setup button: Click this button to check or change the printer or paper you will use.

Copies: Set the number of copies you want here.



Printing

To produce a printed copy of either the message you are preparing or a message / article you've 
received, either select the message or open it on the screen and then take the Print option from the File 
menu.

A standard Windows Print dialog then appears, primed to print one copy of the whole message/article 
using your current printer set-up. (Click the Setup button included in the dialog if you want to check or 
change the printer / paper you are about to use.)

Make any changes you require either to the number of copies, the range of pages or to the printer set-up 
through this dialog, then click on the Print button.

The printed copies are automatically given both page numbers and a standard heading which gives the 
basic details about the item being printed. Turnpike also puts your name right at the top so that you can 
readily pick out the items you've printed from among other people's on a shared printer.

Note: The typeface, typesize and typestyle used to print messages / articles prepared or read in a 
mailbox or newsstand is set on the Fonts   page   of the corresponding Mailbox or Newsstand dialog. So if 
you'd like the messages in a particular mailbox or newsstand to be printed a different typeface, typesize 
or typestyle, you need to take the appropriate Alter option from the File menu and then set the font you 
want on the Fonts page of the dialog that is displayed.

If you want to see what the message / article will look like when printed or to find out how it divides into 
pages before you print it, preview it by taking the Print Preview option.



Progress Dialog

A progress dialog is shown whenever Turnpike starts an operation which will take more than a few 
seconds to complete.    To give you a rough idea of how long it will take the progress is shown in terms of 
a count or percentage.

You can Cancel the operation if you wish, but usually you would then have to start it again from the 
beginning.



'Properties' dialog

This dialog is called up by clicking the 'Properties' button shown next to a file that has been inserted in a 
MIME message.

The dialog allows you to specify the type of file that is being inserted so that the appropriate application 
can be chosen to view the file where it is received. The information to be given about any file is:

The general Type of File that's being included - Image, Audio, Video, Application data (sent in binary) - or
'Other' (which you specify in the slot alongside the main Type option).

The specific Sub-Type of these files eg. JPEG, GIF, TIFF etc..

A Description - normally set to the name the file has on your disk.

In addition, you can specify the Transfer Encoding you require for the message. In general, the option to
choose here is Base64 which treats everything as binary. But if the file you are sending is mainly plain 
text and it's possible that the person receiving the message isn't able to interpret MIME, it's better to 
choose Quoted Printable. This will give them a good chance of being able to read the file, as standard 
characters will then be transmitted in clear. Opting for Quoted Printable for a text file also has the 
advantage that it will usually cut down the size of the encoded file (which in turn will cut down the time 
taken to transmit it).

Note: In the main, Turnpike will make the correct settings for you. As setting the wrong properties will 
confuse matters for the recipient, we recommend that you only change the selections that Turnpike 
makes if you know for sure that the file should be identified in a different way. In particular, don't identify a 
file as Other unless you know that it is of a MIME type that Turnpike doesn't cover.



This message is just warning you that when you go into any newsgroups, the interesting/not interesting 
markers will have gone and the threads will no longer show which articles you've read because that 
information was recorded in the file that's being replaced.



The action you are trying to take is contrary to the access that's allowed to the object you are trying to 
process. You may, for example, be trying to write to a read-only file or to open a directory as a file.

You probably need to select a different filename.



Click Yes to send copies to these additional people, or No if you don't want to send them copies - or 
Cancel to abandon the operation.



The message you are reposting was originally addressed to several recipients.

If you want to repost the message to everybody, click the All recipients button - but if you only want to 
repost it to the people who weren't sent their copies before, click the Unsent recipients button.



Turnpike no longer has any record of the details of this article eg. because it has been removed from your
disk. This unfortunately means that it is not even possible to request the article.



Either you've tried to combine files from different versions or from different users, or this file has become 
corrupted.

Make a back-up of the important files in your system - separate from any previous back-up you've taken - 
then try to sort the problem out, for example by restoring files from a previous back-up or, if a datafile has 
been corrupted, by rebuilding the affected file.



The Mailbox or Newsstand must be given a name, and this must be different from any other Mailbox or 
Newsstand.



This is only relevant on a shared system.

Filing this message would remove it from a mailbox or out tray belonging to somebody else.    This is not 
allowed.



Only the owner of a message can drag that message between one tag list and another because the effect
of dragging is to change the tags on the message and only the owner of a message can change its tags.

Or, to put it another way, you can only drag your own messages between tag lists.



Outgoing messages can only be moved into the Out tray (for reposting) or out of the Out tray (to prevent it
being sent) or between mail lists (for tagging).

When moving messages between mail lists, you must move the whole of a message - you can't move 
individual parts. You can, however, move individual parts of a message to the Out tray for reposting.

Also you cannot move an outgoing message at all while it is in transit, i.e. being sent out onto the 
Internet.    If you were trying to prevent it being sent it is too late.    Otherwise try the move operation again 
after it has been sent.



You may be able to get more from the message by using the Display 'raw' text option in the Options 
menu to display the message in its raw encoded form.



You will be able to remove the attachment once the message has been sent.



Click the Yes button to cancel or the No button to continue without cancelling.



The Request system only works for articles which are available from your news server ie ones in 
'standard' newsgroups. Articles in local newsgroups and mailing lists don't come from your news server, 
so can't be requested - because they are actually mail messages.



The change you have picked out to make will significantly change either the text or the layout of quoted 
text. If you proceed with this change, this text will have to lose its quoted status.

Note: The only changes you can make to quoted text without affecting its status are to insert/delete whole
lines; and to delete text at the beginning or the end of lines.



Click OK, then return to Turnpike and close it - either by taking the Exit option from the File menu or by 
clicking on its window's Close box.



If you are sure you have not mistyped any details, either email info@turnpike.com or phone Turnpike 
Support on 0181-371 1010* with details of your Site ID (which you can find out by editing the 
CONNECT.INI file in your Turnpike directory).

* Calls to 0181-371 1010 may be monitored for training purposes. This information may be used for marketing purposes.



The datafile(s) need to be rebuilt.

To rebuild the files, either the System administrator or another user with Rebuild files permission needs to 
run Connect and take the Rebuild database option from the File menu.

Note: Rebuilding these files may take some time.



In the first instance, ask your correspondent to send the message again - but if you continue to have 
problems, ask them to pick a different message format.



Moderators of moderated groups may reject cross-posted articles on the grounds that the follow-up path 
can become very confused - so you should check first whether cross-posting is acceptable in the 
moderated group(s) to which you wish to post your article.



This is a system-level problem.

For a detailed explanation, look up the error message in the information on 'DOS errors' or 'System errors'
in the documentation supplied with your machine or with the operating system you are using.



The chances are your mail/news files have been moved but this move hasn't been recorded in the File 
Paths dialog.

To sort this out, click OK: then back in the Sign-on dialog, click the Paths button to display the File Paths 
dialog and check that the correct directories are selected.

If necessary, use the Windows File Manager / Explorer to check the location of:

      * Your TURNPIKE.USR file (the Server path - probably a TURNPIKE directory)

      * Your MAILBASE, MSPOOL and ADDRBOOK files (the Email path - probably a MAIL directory)

      * Your NEWSBASE and NSPOOL files (the News path - probably a NEWS directory)



When a message in Turnpike is a 'mirror' of a message in a POP mailbox, this isn't normally deleted until 
the next time mail is collected from this mailbox so that the range of messages in Turnpike properly reflect
the contents of your POP mailbox.

But you have been offered the option of deleting these messages in case any are mirrored from a POP 
mailbox that you no longer use and so won't ever connect to again.

Before taking the option to delete the messages associated with a particular POP mailbox, however, it's 
important to understand that if you do ever re-connect to this mailbox any messages that are still in the 
POP mailbox will appear as new messages in your Turnpike mailboxes because all record of these 
messages has been erased.



Reposting a message creates a second copy which is automatically filed in your mailbase.

This message lets you choose whether to keep the original message as well as the new copy.



You are strongly recommended to switch to the Windows File Manager / Explorer and make some space 
available on the drive named in the message. Having made space, you should then return to the 
message and click the Retry button.

Doing anything else is not recommended.



This is a disk/drive problem.

If it's obvious to you what you need to do to correct the problem, look up the error message in the 
information on 'DOS errors' or 'System errors' (or just 'Errors') in the documentation supplied with your 
machine or with the operating system you are using.



If in doubt, take the Edit option - just in case you find you want to change anything.



The rule you are trying to set up hasn't been formulated correctly.

Return to the dialog in which you set this rule, press F1 and study the page of on-screen Help that is 
displayed. Note in particular what it says about what should be put in the different slots in the dialog.

Note: Custom rules should only ever be put in the Custom slot of the dialog - even where they are 
picking out messages/articles by subject.



The Evaluation version gives access to the Internet for 30 days, with an optional 15-day extension for 
anyone ordering a full copy of Turnpike before the Connect program 'expires'. (To order your full copy of 
Turnpike, ring Demon Sales on 0181-371 1234*)

If the program expires before your full Turnpike package arrives, either email info@turnpike.com (if you 
can) or phone Turnpike Support on 0181-371 1010* with details of your Site ID (which you can find by 
editing the CONNECT.INI file in your TURNPIKE directory). They should then be able to provide you with 
a 'Site Key' to unlock your copy of Turnpike.

* Calls to 0181-371 1010 and 0181-371 1234 may be monitored for training purposes. This information may be used for marketing 
purposes.



Since you opened this newsgroup, the newsbase has been 'expired' - deleting articles that have been on 
the disk for longer than their allotted time. The article you've just picked out was one of the ones deleted. 
(Clicking the Refresh button at the bottom of the newsstand will clear the newsgroup of any other articles 
that have been expired.)

If you particularly want to read this article and it comes from a Usenet newsgroup (rather than a local 
newsgroup or a mailing list), you can use the Request article button on the toolbar to ask for it to be 
downloaded the next time News is collected from the news server.



The message has already been removed from here - eg. by another user, or it has been posted (in the 
case of messages in the Out tray).



Check the file details you are giving. They are probably out of date.



The filename associated with the enclosed file is either not a valid name on a PC or is wrong for the type 
of file it represents.

If the suggested name is acceptable, click Yes. Otherwise click No and set your preferred name in the 
selection dialog that appears.



If you are doing this deliberately, fair enough - but you are missing out on a couple of features quite 
unnecessarily.

You can pick up a full version by FTP from:
       //ftp.demon.co.uk/pub/mirrors/turnpike/

Note: The files are quite big, so different 'flavours' are offered, covering the choice of 'Windows 3.x' 
version (for 16bit systems) or 'Windows 95' version (for 32bit systems), with or without Microsoft Internet 
Explorer. Study the Readme file in the directory for information on which file you need to copy.



You must enter a name here.



The options are either to 'Ignore enclosure' and just reply to the main author of the message sent to you,
or to 'Reply to all' and thus also send copies to everyone involved in the enclosed message (or to Cancel
the operation).

Just pick the option you require.



The options are either to make a 'Simple reply' to the main author of the message sent to you, or to 
make a 'Group reply' and send copies to everyone involved in the original message (or to Cancel the 
operation).

Just pick the option you require.



One or more of the header lines appear incorrect. You may have forgotten to fill-in the To: or Subject: 
boxes.

If not, our advice is to go back to your message, click the Edit header button to go back into the Edit 
Header dialog and check the header lines you've set up - particularly the ones you've set up in the slot for
'Other' header lines. But you can if you want take the option to Post anyway if this is offered.



The Evaluation version doesn't allow you to import mail that's been exported from Turnpike.

This restriction doesn't apply to full versions of Turnpike.



If you scroll back through the inspected text, you'll find a horizontal bar which includes a Merge into text 
button which you can use to merge this text into your message.



You probably need to close some of the other applications you are currently running.

It may even be a good idea to restart Windows.



Turnpike is simply checking that you meant to do this - in case you've accidentally selected a whole 
thread when you meant to just select one article from this thread.



The ratings service you are using considers the level you wish to select unsuitable for anyone to access.

For further information, you should refer to the documentation provided by this ratings service.



Turnpike is unable to handle this file.

Are you sure you picked the file you meant? Are you sure it is a text file?



With Turnpike, you normally get an average of 72 characters per line, but if you have changed the 
margins or you are using a proportionally-spaced font, you may be getting many more characters than 
this on some lines. (With a proportionally-spaced font, there's the additional problem that the text won't lay
out in the same way for the recipient unless they use exactly the same font.)

Lines over 80 characters in length aren't generally recommended because not everyone can view long 
lines of text. So this message gives you a chance to change either the margins or the font you've used to 
make it more likely to lay out well for the recipient.



Not all the transport systems on the Internet can handle messages as large as this.

As there's always a chance that your message will pass through one of these more limited transports, we 
would recommend letting Turnpike split it into multiple sections for you, but you can opt to post it as a 
single section if you want.



Mailing Lists must be added to a newsstand before you can use them.



Simply pick the option you prefer.



If you are happy to go ahead, click OK - but if you would rather abandon the task, click Cancel.



The item you typed has not been found - possibly you mistyped it or there are no more matching entries 
in the list.



Check that you are using the files you intend, then rebuild the relevant datafile.

Note: If you replace any files from backup copies, be sure to replace the NEWSBASE and NSPOOL files 
together and the MAILBASE, MSPOOL and ADDRBOOK files together. Don't try to combine files from 
different back-up sets.



Consult your system administrator.



A newsgroup you've specified doesn't appear in the list of newsgroups available from the news server. 
Are you sure you have the correct name ?

Note: Turnpike won't actually stop you from posting to a newsgroup that isn't on this list but you won't be 
able to download any articles from this newsgroup.



Return to the Alert box and follow the instructions it gives.



The article is probably no longer still available on the news server from which you collect news.



The Address book entry you've selected doesn't give any email address to which to send messages. 
Either amend this record or pick again.



You must enter at least one name in the Index by slot for this address book entry to appear in the list on 
the main Address book display.



You've filled all the seats available on your system (99 in the standard version of Turnpike).

The chances are that you've still got some people listed as users who no longer use the system and you 
will be able to make space for your new users by removing some of these. Click here for the steps to use.
(Note: Removing a user is not simply a matter of clicking the Remove button because you also need to 
tidy up any mail files etc. that remain for them.)

If you need more seats, contact Turnpike Sales on 0181-371-1234*.

* This number is monitored for training purposes. This information may be used for marketing purposes.



Turnpike is unable to send a Delivery Status Notification if the email you are trying to reject lacks 
information on where the rejection message should be sent.

This can happen with email that has been sent through certain POP3 servers, email sent to you from 
someone else at your local domain and email that has a null return path (which Delivery Status 
Notifications themselves have).



This looks like a mistake.

Click Yes if you really want to post the message like this - or click No to return to the message.



This attachment was prepared on a system that doesn't use CRLF line endings. If you save it with its 
current line endings, the program in which you open the file may not be able to interpret it correctly. It 
might therefore be better to let Turnpike save a version with the current line endings replaced by CRLF 
line endings.



The specified file type isn't an appropriate type for a MIME attachment, eg. because it describes a 
composite type that can't be sent by MIME.

Depending on what you're trying to send, you need either to simply change how this file is described or to 
change what you trying to send.



It's only worth sending a MIME message if the recipient can handle MIME messages.

To help you avoid sending MIME messages to people who can't handle them, Turnpike notes whether 
someone has sent you a MIME message in the Address book so that it can warn you before you post a 
MIME message to someone not known to be able to handle MIME messages, and if a distribution list you 
set to send MIME messages includes anybody that is not known to be able to handle MIME messages.

However, Turnpike's knowledge is limited to the messages you've received. If you know that they can 
handle MIME, it's OK to continue - but if you aren't sure, it's better to switch to sending a standard 
message instead.



This message has been displayed for your advice. There isn't necessarily any problem for you to sort out.



The only email name you can specify here is one that you personally own or one that belongs to a 
workgroup of which you are a member.



Turnpike doesn't support the Ratings system being used in the .RAT file you have selected, so this 
Ratings service can't be used.



The problem with using a proportionally-spaced font is that your message won't lay out the same way for 
the recipient unless they display it using exactly the same font. You may also produce messages with 
lines that have more than 80 characters on them, which will be awkward to read on some people's 
systems.

Using a fixed pitch font is advised but stay with the font you've picked if you want.



Opening all the parts of a message together is generally best but you can open individual parts if needs 
must.

But beware! If what you open contains a section of an encoded file, you will be unlikely to be able to make
any sense of it.



Click OK, then pick again.



Choose to Post or Abandon as required - or click the No! button to return to the message. Abandoned 
articles are placed in the Waste basket and will be lost when you exit Turnpike.



If you think you should have been able to access this message, talk to the user whose message it is.



Click the Yes button to continue or the No button to cancel.



Selecting Normal quote will quote the whole of the message in your reply. Selecting Quote selected will 
just quote the section that is currently highlighted.



To resolve this, you need to re-install Turnpike.



The database files need to be rebuilt to incorporate the new information, and wherever possible, Turnpike 
offers the chance of doing this now. But as this will take some time, Turnpike also offers the option of 
leaving the database files as they are by clicking the No button. However you won't then get the changes.

Database files can also be rebuilt by running the Connect program and taking the Rebuild database 
option from the File menu - assuming you have Rebuild files permission.



One or more of the entries in the dialog has 'overflowed' the space available to it.

Return to the dialog and check that you have the correct information in the various slots.



Replies sent to the newsgroup / mailing list will be seen by everyone who subscribes to this newsgroup / 
mailing list.

Replies sent by email will only be seen by the author of the original posting but can make sense if for 
example they are planning to post a summary of the replies received.



Where a message has been forwarded to you, your reply can be sent either to the originator(s) of the 
message (a 'Normal reply'); or to the person (or persons) who forwarded the message to you - or to both.

Just pick the option you require.



Where the original message was split into separate parts for posting, it makes sense to just repost the 
sections that the intended recipient needs.

But if you want to change any part of the message, you should really repost the whole message - 
because any changed section represents a new message which can't be merged with sections of the 
earlier message.



You have the choice at this point of requesting either just the particular article you've selected or all the 
articles fom this thread.

Simply pick the option you require.

(If the article is missing because it is in a thread that has been killed at some stage, then you can opt to 
'unkill' the thread.)



We recommend shutting down all applications and restarting Windows.



The file you've asked to view contains an application.

Turnpike is simply checking before running this application in case you hadn't realised that this is what the
file contained.

Unless you are sure that the attachment comes from a reliable source, it may be wiser to save it to disk, 
and then check it for viruses, before you run it.



Shame though it is, it is probably best to abandon your changes then call up this entry again so that you 
can see what changes the other user made - then make the further changes that are still required. You 
would extremely unlucky to lose your changes a second time.



To sort this problem out, the System Administrator or some other user with Configure Users permission 
needs to call up the Configure Users dialog.



The information provided about this external body doesn't include a server address, so Turnpike is unable
to fetch it.



The file you are trying to access is being used by another application - possibly on another machine if 
your computer is on a network.



An error has occurred in the program.

Please email helpdesk@demon.net with details of the message seen and the circumstances under 
which this message appeared.



The text you have entered here is too long.



If the search hasn't brought up the particular item you were searching for, think of something else you 
might use to search for this item, then try again.



You should supply some text here for subject line matching.    If you leave this blank then only messages 
with a blank subject line will be be accepted (probably not very useful).

Text which you specify here without any wildcards will match any subject line beginning with that text.
Often you would want to match a particular word or phrase anywhere in a subject line; to do that include 
the wildcard character '*' at the beginning.



If you click Yes, the newsgroup(s) will be added to the list of newsgroups subscribed at your site and set 
to be downloaded in full, visible to all users and expired after three days. If required, you can change 
these subscription details through the Newsgroup Subscriptions dialog.

If you click No, you will not be able to download any new articles from the newsgroup(s) and Turnpike will 
repeat this reminder each time it is launched.



Exit from the program as 'gracefully' as you can, then restart.

It may also be a good idea to restart Windows.



With the standard 'single-access' version of Turnpike, you can only have one copy of the Connect 
program and one copy of the Turnpike program running at any time - though not necessarily always from 
the same machine. With the 'multi-access' version, you still can only run one copy of Connect but you can
have multiple copies of the Turnpike program running, up to the number of seats purchased.



You've given Turnpike an excessive number of rules to process. Please review the rules you've set, 
decide which ones you don't need and delete them.



The characters of the 7bit US ASCII character set are the only ones guaranteed to be able to pass 
through all the different transport systems on the Internet. Other characters may be replaced by another 
character or a blank.

If you are sending an email message, sending a MIME message instead of a standard email message will
allow almost all the characters of the Windows character set to be sent correctly (curly quotes are the 
notable exception) - though this is only any good if you know that the intended recipient can handle MIME
messages.

But if you are posting an article to a newsgroup or forwarding a message, you just get the option to post 
anyway or to go back and change the message to get rid of the problem characters - replacing £ by GBP 
for example.



This message is currently waiting to be read in several different mailboxes either on one user's system or 
spanning several users' systems.

Once it has been opened in any of these mailboxes, it will then be assigned to that user and mailbox - but
until that has happened, it can't be opened through any mail list (for technical reasons).



You've addressed your message to someone in your local domain but the email name you've given isn't 
on the list of local email names.

Probably the best way to get a correct email name for this person is to return to your message and use 
the Look up address button on the toolbar. They are almost certainly in the Address book.



Click OK to return to the Sign-on dialog and enter the correct information.

If you don't know or can't remember either your sign-on name or your password, consult your System 
Administrator or some other user who has Configure Users permission. They should be able to tell you 
what your sign-on name is and to set a new password for you. Once you've signed on using this 
password, you'll be able to set a new password for yourself by selecting Configure | Users from the File 
menu and setting this in the Edit sign-on details dialog that is displayed.



The file you are trying to use was created on an incompatible Turnpike system. At the time of writing, no 
such system existed but it is always possible that one could have subsequently been created.

If you have access to a newer version of Turnpike, try using that.



Ratings display

This dialog is displayed by clicking the Ratings button within the Newsgroup Subscriptions dialog (or the 
associated Newsgroup Subscription dialog) or by clicking the corresponding button within the Newsgroup 
Addition dialog when newsgroups are being picked out for inclusion in a newsstand.

The top part of the dialog shows the names of the newsgroup ratings services that are currently in use (or
blank if none have been selected), together with details of the rating that has been given to the currently 
selected newsgroup under each of the different categories covered by each ratings service.

While the cursor is on the name of a service (or this part of the display is blank), you are offered the 
option to Add a new service or to Remove the selected service. Details of the selected service are shown
at the bottom of the dialog.

While the cursor is on a category, you'll see instead the range of levels that are available in this category, 
together with a description of what the rating that has been given to the newsgroup means.



Switching between Read and Unread

The articles and messages you open on the screen are automatically marked as 'Read' on the 
assumption that (a) you will read them while they are on the screen and (b) that you won't want to read 
them again. (Articles that have been read aren't drawn to your attention again.)

In general, this is precisely what you need but there may be times when you will want a message that 
you've read marked 'Unread' so that it is drawn to your attention again or an article to be marked read so 
that this isn't picked out by the 'Next unread' option.

The options you need to switch between Read and Unread are in the Classify menu.

Note: You can mark all the remaining articles in a newsgroup as read (so that they aren't drawn to your 
attention again) by clicking the 'Mark all as read' button.



Reading mail

When there's mail for you to read in a mailbox that is currently minimised, the mailbox will normally flash 
to draw your attention to this - or if Turnpike itself is minimised, the program icon will flash. (If your 
mailboxes don't flash or you would like to turn this feature off, click here.)

To read this mail, you simply need to go into the mailbox (either by double-clicking on its icon (if this is 
visible on the screen) or by selecting it from the list of windows in the Window menu), then open the 
messages in its In tray one by one.

You can either:

* Pick out messages to read as they catch your eye
 - by double-clicking on any part of the message details

* Or work systematically through the messages that are waiting for you to read
- by pressing the Space bar or by taking the Next unread option in the Search menu.

* Or search for messages on particular topics
- by taking the Search option from the Search menu (see Searching).

Many of the messages you open will just contain plain text, but you may also receive messages in which 
some or all or the text is encoded or that contain additional items (represented by a horizontal bar 
containing an icon, one or more buttons and some brief details). The description in the horizontal bar will 
tell you whether the additional item is an enclosed message (ie. a forwarded message), a particular type 
of file, a digest message or a reference to an external body. Very occasionally you may be offered an icon
together with the option of selecting from two or more alternatives. (Click for further information on any of 
these.)

After you have read a particular message, you can either:
* Reply to it,
* Move it to the Pending tray for replying to later (eg. by using the 'Move to Pending' button)
* File it
* Or if you really don't want keep it, delete it (eg. by using the 'Delete message' button).

You're not advised to leave it in the In tray (though there is nothing to stop you leaving it there) because it 
will just clutter up this tray and make it harder to spot the messages that are waiting to be read.

Note: Once a message has been opened, it is automatically marked as 'Read' so that your attention isn't 
drawn to it again. But you can, if you wish, change its marking back to 'Unread' by taking the Mark as 
unread option in the Classify menu. 



Reading News articles

To read the articles that have been posted to a particular newsgroup, you first need to add this newsgroup
to one of your newsstands, then you need to go into that newsstand, open the newsgroup and scan the 
list of topics currently under discussion.

Against each of these topics will be a number telling you the number of articles which are waiting to be 
read on that topic (assuming that it's a topic that interests you).

To see more about the articles that have been contributed on a particular topic, double-click on the  icon
in the second column of the display to 'expand' the thread. Alternatively you can use the Expand options 
in the Article menu to display the articles in detail - together with the corresponding Collapse options to 
close up the display again.

The topic then opens up to show both the author of each article that's available to read in the thread and 
how the different articles thread together. (Any  s included in the display mark articles that are part of
the thread but which aren't currently available for you to read, while 

 or 
 marks an article of which only the header has been downloaded If you want, you can ask for these 

to be downloaded in full when you next go on-line: see Requesting missing articles.)

Depending on the articles offered, you may want to:
* Pick out articles that catch your eye
* Search for articles on particular topics, or
* Work systematically through the articles you've not yet read (perhaps taking in some you have read as 
well)

Turnpike supports all these actions - and you can swap from one to another at will. Perhaps the easiest, 
though, is simply to press the space bar to cycle through each new article in turn.

If an article catches your eye, either double-click on its name (or on the icon alongside), or select it and 
take the Open article option from the Article menu. When you've read that one, close it by clicking on its 
window control box and then pick out another article in the same way.

To pick out articles on a particular topic, select Search article from the Search menu (see Searching).

To work systematically through articles that haven't yet been read, select the point at which you 
want to start (this can be an article, a discussion thread or a newsgroup) then either press the Space bar 
or use the Next unread button to view each of these articles in turn. (The space bar also pages down 
through the article.) If you want, you can carry on in this way from your current newsgroup into the next 
newsgroup and then through the unread articles in that group.

Alternatively, you can work systematically through every article using the Next and Previous 
buttons. Clicking on Next allows you to follow the entire thread of a discussion; clicking on Previous 
allows you to see the article which the current article is a follow-up to.

Most news articles just contain plain text, but some contain pictures or other binary information, which 
requires special handling, while others - especially FAQs - may be split up into a number of sections, each
with its own mini-toolbar. Such articles are known as MIME digests.

There's also the possibility of articles being set up with a 'hidden' section at the end - typically to stop you 
being shown the answer to a riddle or some other problem before you want to see it. In Turnpike, such 
hidden sections are initially represented by a horizontal bar containing a 'Reveal' button for you to click 
when you want to see the solution.



Note: Once you've opened an article, it is automatically marked as 'Read' so that you attention isn't drawn
to it again. If you want, you can change its marking back to 'Unread' by taking the 'Mark as Unread' option
in the Classify menu. Alternatively, you don't want to bother with particular articles or with the remainder of
the articles in a particular newsgroup, you can avoid having these picked out when you go 'Next unread' 
by using the 'Mark as read' and the 'Mark all as read' buttons to mark these as Read.



'Reading' binaries

The articles in 'binaries' groups often include files contain pictures or other such binary information - 
maybe, spread across a number of articles.

To view the contents of such an article (or a sequence of articles), you first need to extract the original file 
from the news article. To do this, select the article (or sequence of articles) and then take the Decode 
option in the File menu. This stores a copy of the file contained in the article(s) on disk for you in its 
original format. (You are asked where you would like the file to be stored.)

You can then use the appropriate application for the type of file that's been produced to see what the file 
contains.

Note: You can extract the files contained within a number of articles at once - by selecting all the articles 
you are interested in as a group, then taking the Decode option. Any uuencoded and Base64 encoded 
files within the files you select will be saved to disk as separate files, which you can then open using the 
appropriate applications.



Re-building mailbase etc.

Wasted disk space left in your newsbase, mailbase or address book after earlier entries have been 
erased can be recovered by 'rebuilding' the relevant datafile. Rebuilding can also be used to recover 
these if they should become corrupted (or at least as much of possible of these).

To rebuild any of these files (assuming you have Rebuild Files permission), you need to run the Connect 
program, take the Re-build database option from the File menu and follow the instructions displayed. 
Turnpike then builds a new version containing just the current information from the old version - 
recovering both wasted disk space and as much as possible of the information from the old files.

Note: Although rebuilding a database will usually recover all your email messages or news articles, there 
is no guarantee that this will always be possible. You are strongly advised to keep up-to-date backups of 
all these databases: see Backing up your Turnpike files.



Regular expressions

Regular expressions are used to express custom rules for selecting the mail that is put into your different 
mailboxes; to express special rules about how mail from mailing lists is to be identified, and to express 
custom criteria for killing articles.

The syntax to be used is as follows (expressed in BSI syntactic metalanguage):

regular expression = anchor, {"|", anchor}.

anchor =      ["^"], {closure}, ["$"].

closure =    primary, ["*" | "+" | "?"].

primary = "." |
    "\", digit |
    ["\"], (ASCII char - digit) |
    "[", ["^"], {char, ["-", char]}, "]" |
    "(", regular expression, ")".

meta-character = "|" | "^" | "$" | "*" | "+" | "?" | "." | "\" | "-" | "(" | ")" | "[" | "]".

char = ASCII char - meta-character.

ASCII char = ; ASCII character

Note: If you want a meta-character to stand for itself, you need to precede it by \.

Semantics
| or
^ start of string
$ end of string
* 0 or more of the previous character
+ 1 or more of the previous character
? 0 or 1 of the previous character
. match any character
\d a digit, equivalent to [0-9]
\D not a digit, equivalent to [^0-9]
\w a word character, equivalent to [a-zA-Z0-9_]
\W not a word character, equivalent to [^a-zA-Z0-9_]
\ escape meta-character
\t a tab
\s a space or a tab, equivalent to [ \t]
\S not a space or a tab, equivalent to [^ \t]
\n line feed
\r carriage return
\f form feed
[ ] matches any one of enclosed characters
[^] matches any one character except those enclosed
- specifies range for use within [ ]
( ) grouping
\0...\9 matches that which matched in the nth parentheses



Reject mail
This option in the Messages menu will cause Turnpike to create, and attempt to send, a rejection 
message called a Delivery Status Notification (DSN) for each of the selected messages. The DSN, which 
is in the form of an automatically generated message, informs the sender that delivery of their message to
you appears to have failed.

This feature is intended for the rejection of unwanted "junk" mail. Be aware that such mail often has a 
deliberately flawed return path, so rejecting it may be wasted effort.

IMPORTANT      Reject mail should not be used in cases where someone is trying to contact you for 
genuine reasons, as it could cause people to go to a lot of trouble investigating why their mail to you 
appears to be failing. In particular, it should never be used to unsubscribe from a mailing list you have 
joined, as this could cause considerable inconvenience to the list owner. Always cancel subscriptions to 
mailing lists in the proper way, which is usually by sending an unsubscribe message to the list control 
address (not to the list itself).



Removing a mailbox or a newsstand

If you no longer require a particular mailbox or newsstand, you can easily remove this.

Just select the mailbox / newsstand you no longer want, then take the appropriate Alter option from the 
File menu and click the Destroy button in the dialog that is displayed.

Note: Before you remove a mailbox, you need either to move any mail it contains to another mailbox, file 
it or delete it. Turnpike won't let you throw any mailbox away until you have emptied it.



Removing newsgroups

When you decide that you no longer want to follow the discussions in a particular newsgroup, you can 
remove this newsgroup from your newsstand by selecting the newsgroup in the list of newsgroups shown 
at the top level of the newsstand and clicking the Remove button displayed on the bottom edge of the 
newsstand.

However, it is important to understand that while this removes the newsgroup from your newsstand, it 
doesn't stop articles from that newsgroup being downloaded to your disk. To stop any more articles being 
downloaded, someone with News Admin permission needs to remove the newsgroup from the overall list 
of newsgroup subscriptions.

This overall list of newsgroups is shown in the Newsgroup Subscriptions dialog, but in practice there's no 
need to call up this dialog because Turnpike automatically alerts any user with News Admin permission 
when they log on if there are newsgroups listed in the newsgroup subscription list that don't appear in 
anyone's newsstand. That person then gets to choose whether to continue subscribing to that newsgroup 
or to remove the newsgroup from the list of newsgroup subscriptions and cancel the subscription.

Note: Before removing the newsgroup, check whether there are any articles from the newsgroup that you
want to keep and export these immediately, because all the articles - including ones that you have 
marked 'to be kept' - will be deleted from the disk the next time News is expired (probably the next time 
Connect is run).



Removing users from a shared system

When someone who has been using your Turnpike system leaves, there are three things the System 
Administrator can do:

* Leave them as a user on the system: after all, there's room for 99 different users

* Allocate another user to their seat, or

* Straightforwardly remove them from the system

Which to do depends on which is best in the given circumstances, but each case there's a certain amount
of tidying to be done.

To see what's involved, click on the appropriate heading above.



'Replace' dialog

Taking the Replace option from the Edit menu displays a standard Windows Replace dialog through 
which to set the details of the word or phrase you want to replace and the word or phrase that you want to
replace this by.

Simply enter the word or phrase you want to replace in the Find What slot, the word or phrase you want 
to replace it by in the Replace With slot; set the Match options, then click Replace All if you want 
Turnpike to go ahead and replace this text - or Find next if you want to check each replacement before it 
is made.



Replying to Mail

The standard way of replying to a message you receive is to select this message (if it isn't already open 
on the screen) then click the Reply button on the mailbox toolbar (or take the Reply to message option 
from the Message menu).

Turnpike then displays its Message Editor, with a new message set up ready for your reply - complete 
with a copy of the message suitably marked up for inclusion in your reply, though with just markers in 
place of large enclosures such as GIF files which it would be a waste of resources to send back. Where 
possible, Turnpike will also leave the signature out of the copy to save you having to cut this from your 
reply.

Simply delete the parts of the original message you don't want to include in your reply, insert your reply to 
the various issues raised, then click the Post button. The message is then placed in your Out tray, from 
where it can be opened and edited (or thrown away) any time up to the point that you are connected to 
your Access provider. Note: Even if you are already connected to your Access provider, the message will 
stay in the Out tray for at least a minute to give you a chance to change your mind or edit it before it is 
sent.

If, however, you just want to reply to one part of a message, the thing to do is to select that part of the 
original message before you click the Reply button. Then the new message will just contain the selected 
text, marked up ready for your reply.

Being able to select the section you want first saves you having to remove the sections you don't want 
from your reply. It also allows you to pick out your correspondent's signature to comment on, should you 
want to do this.

Note: The introductory line at the top and the signature at the bottom are just text which you can change 
simply by editing in the normal way. You can also arrange for your own style of messages to be inserted. 
Click here for information on setting the format of the introductory text - or here for information on setting 
your own style of signature.

(For information about using Turnpike's Message Editor, see Preparing News / Mail messages.)



Requesting missing articles

When discussion threads are expanded, they frequently include entries shown only as . These 
represent articles that form part of the discussion thread but aren't included in the current newsbase. 
Similarly, where you've opted just to 'browse' a particular newsgroup, you will find the entries in the 
discussion threads marked 

 or 
 to show that just the header of the article has been downloaded.

If you want to read either a missing article or one you currently only have the header of, you can ask for it 
to be downloaded the next time you go on-line. To arrange this, simply select the entry for this article and 
then either click the Request article button or take the Request article option from the Classify menu. 
The article will then be marked  to indicate that it will become available at a later time, while the thread 
itself is automatically marked Interesting (

) so that it will be drawn to your attention the next time you log in to read your news.

(If you change your mind about requesting an article, then you can cancel the request by selecting the 
article then taking the Cancel request option from the Article menu.)



Responding to News articles

There are two possible ways in which you can respond to an article you read. You can either:
* Post a 'Follow-up' article, or
* Send an email message to the author of the article.
(The general method is to post a 'Follow-up' article but article authors may specifically ask for replies by 
email, eg. because they are intending to post a compilation of the responses they get.)

Whichever method you wish to use, the steps you take are much the same.

To post a follow-up message, just select the article (if it's not open on the screen), click on the Reply / 
Follow-up button, then when the message appears, select the option to reply by News. (Alternatively, call
up the Article menu and select Followup article.)

To send an email message to the author, just select the article (if it's not open on the screen), click on 
the Reply / Follow-up button, then when the message appears, select the option to reply by Mail. 
(Alternatively, call up the Article menu and select Reply by email.)

In either case, Turnpike then displays its Message Editor, with a new message set up ready for your reply 
- complete with a copy of the article you were reading (suitably marked up for inclusion in your reply). 
Your standard signature is also automatically added to the bottom of the message.

You also have the option in either case to follow-up on just one section of the article by highlighting the 
section you want to quote before taking the Reply/Follow-up option.

Simply make the changes you want to this letter, click on the Edit header button to make any changes 
you want to the header, then click on the Post button. The article is then placed in your Out tray, from 
where it can be opened and edited (or thrown away) any time up to the point that it is actually sent. Note: 
Even if you are already connected to your Access provider, the article will stay in the Out tray for at least a
minute to give you a chance to change your mind or edit it before it is sent.

For information about using Turnpike's Message Editor, see Preparing News / Mail messages.

Note: Opinions vary on whether it is a good idea to email someone with a copy of the response you've 
made to an article of theirs. On one hand, sending a copy by email ensures that the person in question 
will see your response. However, if it isn't clear that the email is just a 'courtesy copy', the original author 
could think that you wish to have a private one-to-one conversation on this point and reply by email only 
to discover later that a public reply is needed as well.

If you really do need to send an email copy of your follow-up - prepare your follow-up article, copy the text
to the clipboard using Ctrl C, then set up a 'reply by email' and paste the text into that.



Restricting access to newsgroups

There is a vast range of newsgroups covering a vast range of topics, not all of which you might want 
children to read about. Some even carry material that it may be illegal to possess.

So Turnpike lets you restrict access to newsgroups:
* Firstly, on the basis of the ratings given to different newsgroups.
* Secondly, by specifying precisely which users can access particular subscribed groups

Follow the above links to find out more about these schemes.

Note: Both these schemes filter articles on the basis of which newsgroup they have been contributed to, 
rather than the content of the articles themselves. This works well in the vast majority of cases because 
most contributions to newsgroups keep to the topic of the newsgroup. But it is not foolproof because it is 
in the nature of Usenet that anyone can post an article on any subject to any newsgroup - even 
moderated ones (though unauthorised articles in moderated groups are normally quickly cancelled). It's 
very unlikely but possible - even with these filtering schemes in place - that one day you'll be reading a 
newsgroup about pet cats and suddenly find an encoded picture of naked lady.



Running a mailing list

Turnpike doesn't offer specific support for running a mailing list (ie. for taking incoming mail messages 
and 'exploding' them to a given list of addresses).

However, it is possible to set up distribution lists of addressees and select them en masse from the 
address book. This is a good technique for outgoing email which has to be regularly sent to the same 
group of people. You can even import this list from a CSV datafile of the appropriate format (see Importing
& Exporting addresses.).

However, note that there is a limit of 256 addresses on any such list.



Running under Windows NT

Turnpike works fine under Windows NT but the NTS stack provided with Turnpike cannot be used with 
Windows NT because it is implemented using VxDs. This means you will need some other Winsock and 
some other way of dialling up the Internet.

Instructions for setting up Windows NT's RAS can be found in
         ftp://ftp.demon.co.uk/pub/nt/general/nt-demon.txt



Search dialog

This dialog is used to specify the search you want Turnpike to carry out of the messages / articles in the 
mailbox / mail list / newsstand / newsgroup you currently have displayed on the screen.

It is called up by taking the Search option from the Search menu.

The search can be for messages / articles either on a specific subject or by a specific author or containing
a word or phrase in the message itself or perhaps in its header. The details you need to give through this 
dialog are:

* The subject, name or string Turnpike is to search for. Set this in the Search for slot at the top of the 
dialog. (Note: You don't have to give an author's name or a subject in full - just as much of this as you 
want Turnpike to search for.)
* The range of messages / articles that are to be searched - either All in the current mailbox / newsstand /
newsgroup; from here on or just the messages / articles / newsgroups that have been Selected;
* What Turnpike is to search - the Subject line; the Author line or the Message text (including the 
header if you wish); and
* Whether Turnpike is to match Whole words or Case.

The search is started by clicking the Search first button. When this dialog is re-displayed after you have 
looked at the first message / article that Turnpike finds, you will be able to continue looking for further 
messages / articles by clicking the Search next button.

You can, if you want, change the details of the search before continuing - even what you are searching for
- but note, if you change the range of the search (between All, From here on and Selected), you will 
have to Search first again.

For further information, see Searching.



Search menu

In both Mail & News:
Next unread
Search message/article

In News only:
Next in group
Previous in group



Search menu / Newsstand button: Next in group
Opens up the next article in the current discussion thread / in the next discussion thread, regardless of 
whether this has already been read.

For further information, see Reading news articles.

See also: Next unread and Previous in group



Search menu / Mailbox/Newsstand button: Next unread
Takes you to the next 'Unread' message / article and opens it up for you to read.

For further information, see Reading your mail or Reading news articles as appropriate.

See also: Next in group (News only)



Search menu / Newsstand button: Previous in group
Opens up the previous article in the current discussion thread / in the previous discussion thread, 
regardless of whether this has already been read.

For further information, see Reading news articles.

See also: Next in group



Search menu: Search option
Calls up a dialog through which you can set Turnpike to search for messages / articles by subject, by 
author or by content.

Click here for more information about the Search dialog
or press F1 to call up this Help file when this dialog is on the screen



Searching

One of the options Turnpike offers is to search for messages / articles by subject, by author or according 
to the content of the message.

This search can be carried out either across the messages in a single mailbox, the messages listed in a 
mail list, or across the articles in a particular newsgroup or across a number of newsgroups in the same 
newsstand.

The first step is therefore to display the mailbox / mail list / newsstand / newsgroup in which you want the 
search to be carried out. (Note: If you have a newsgroup open in a newsstand, Turnpike will only search 
the contents of that newsgroup. If you want to search more than one newsgroup, you will need to return to
the top level of the newsstand where you can see all the different newsgroups it contains.)

Turnpike further offers the choice of searching all the items in the mailbox / mail list / newsstand / 
newsgroup you display - or just a selection of these. If you are only interested in a selection, pick these 
out eg. by using Shift-click and Ctrl-click.

When you have the appropriate items displayed and selected, take the Search option from the Search 
menu and set the details of the search you want Turnpike to make in the dialog that's displayed. This 
involves setting what you want to search for; whether you are interested in subject, author or the text; and
whether the search is to be over all items or just the selected items. (For further details of this dialog, 
either click here or press F1 to call up this Help file when the dialog is on the screen.)

The search itself is started by clicking the Search first button included in the dialog.

What happens when a match is found is slightly different depending on whether you are searching for 
messages / articles by a particular author or on a particular subject or you are searching for a particular 
word or phrase within the text of each message / article.

If you are searching for messages / articles by a particular author or on a particular subject, Turnpike 
simply opens the relevant message / article for you to read. If the article / message Turnpike finds isn't the
one you want, either close it or take the Search option from the Search menu again. The Search dialog 
then re-appears - allowing you either to start a new search or to continue the current one by clicking the 
Search next button.

If you've opted to search the text of each message for a particular word or phrase, Turnpike not only 
opens the message / article for you to read but also shows you precisely where the given word or phrase 
was found - even arranging that the header of the message is displayed if this was where the given word 
or phrase was found. It also displays a Find dialog so that you can go ahead and find further instances of 
this word or phrase within this message. (Note: If no further instances are found, the Search dialog will be
displayed again so that you can continue the search through further messages.)

In this case if the message that's been found isn't the one you want, you can re-display the Search dialog 
to continue the search either by closing the message or by closing the Find dialog (or by calling up the 
Search option again).

Note: If you want to 'read next' or 'read previous' etc. from a message / article that Turnpike finds for you, 
you can simply use the standard options to do this: you don't have to cancel the search first. But you will 
then have to start a new search (ie. by taking the Search option from the Search menu) if you then want 
to continue searching from this point.

You should also note that when you cancel a search, Turnpike automatically moves the cursor to the last 
message / article it found so that you can continue working from there.



Seeing correspondence

Lists of messages that you have exchanged with particular people are displayed through your Address 
book.

To see a list of the messages that have been exchanged with someone, you just need to select this 
person's entry in the Address book, then click the Messages button shown on the toolbar. (Alternatively, if
you want to check first that you've picked out the correct entry, click the View/Alter button then click the 
Messages button in the Address book entry dialog that appears.)

This displays a mail list of all the messages that have been exchanged with the person.

Note: The messages shown are the ones that were either sent to or received from the email address(es) 
listed in the 'File as' section of the Address book entry. If someone uses more than one email address or 
changes their address, you should add these to the 'File as' section of each entry otherwise the list of 
messages you see won't be complete.



Seeing everything you've sent or received

If you're the sole user of your copy of Turnpike, then you can see a list of everything you've sent or 
received by calling up the Mailroom view - for example, by double-clicking on the 'filing-cabinet' icon on 
your Turnpike desktop.

On a shared system, your messages will be mixed in all the messages sent or received by the other users
at your site in the Mailroom view. To see a list of just the mail you have sent or received in this case, you 
need to open the Address book, select your entry, then click the Messages button shown on the toolbar - 
in very much the same way as you call up a list of the correspondence exchanged with a particular 
person. The only difference is in the entry you select in the Address book..



Seeing mail on a particular topic

To see what messages have been exchanged on a particular topic, take the New mail list option from the
File menu which will start the Mail     List     Setup     Wizard  .

Note: For this to work, the messages must first have been 'tagged' with their topic - see Tagging 
messages.



Seeing the messages you've posted

Every message you send is automatically filed in your mailbase. So when you want to call up any of these
again - either simply to inspect or to re-post (if necessary) - all you need to do is call up either the 
Mailroom view of everything sent or received (eg. by double-clicking on the 'filing cabinet' icon on the 
Turnpike desktop) or by calling up some other suitable mail list.

To inspect a message, simply open it directly within the list - either by double-clicking on it or by taking the
Open message option from the Message menu.

To re-post a message, drag the message from the mail list either to the Out tray or to part of the 
background display. Turnpike then opens a copy of the message ready for you to change (if you want), 
then post. You can even send it to a different person if you require.



Seeing the news articles you've posted

One way of seeing an article you post to newsgroups is, of course, to go into the relevant newsgroup. 
Your article will be among the threads marked  at the top of newsgroup, because Turnpike automatically
marks as Interesting any thread you contribute to.

However, each article you post is added to your mailbase so you can also see these articles by calling up 
a list of everything you've sent or received such as that provided by the Mailroom view. News articles are 
shown in this list marked  and with the name of the newsgroup to which they were contributed (or the 
first of the list) as the Author.

These articles are also automatically tagged with the name(s) of the newsgroup(s) to which they were 
posted. So you can also see them in the same way as you can call up a list of all the mail sent and 
received on a particular topic - by calling up a tag list of all the items tagged with the newsgroup's name.

Note: If you are not sure which group you posted the article to, call up separate tag lists for each possible
group. Don't ask for a tag list covering all the possible groups because that will just give you a list of the 
articles you have cross-posted to all these groups (if any!).



'Select owner' dialog

*** Only important on shared systems ***

This dialog is used to change the ownership of a mail message. It is called up by clicking the Owner 
button on the Status bar shown beneath the message.

Pick the new owner from the drop-down list of names associated with the Owner slot in the dialog.

Note: You can only change the ownership of a mail message if you (or a workgroup to which you belong) 
currently own it. Also, you can only change the ownership to either yourself or one of your workgroups.



Selecting a newsstand

To select a particular newsstand, either double-click on its icon (if this is visible on the Turnpike screen) or
select it from the list of windows given in the Window menu.



Selecting an entry in the Address Book
There are two main ways of selecting an entry in the Address book.
* One is to click on the appropriate letter in the Goto box to take you to the required part of your Address 
book then scroll down the list until you see the entry you want.
* The other is to start typing one of the names the entry is indexed under in the Selection box: the list will 
then automatically scroll to show you the appropriate part of your Address book.

But if you simply want to return to an entry you've picked out before, it's worth seeing if you can pick it out 
the entry from the drop-down list associated with the Selection box. This lists the most recent Address 
book entries you've picked out.



The standard Windows techniques of Shift-click (ie. holding down the Shift key as you click the left-hand 
mouse button) and Ctrl-click (holding down the Ctrl key as you click the left-hand mouse button) may be 
used to select a number of messages/articles eg. to drag them all into a Mail list or mark them all as read.

Clicking on one message then Shift-clicking on another selects all the messages between the two you've 
clicked on. Ctrl-clicking on a message adds it to the range of messages already selected or clears it if it 
has already been selected.



Sending Mail

There are basically three types of mail message you may want to send:

* Replies to messages that you've received
* New messages (ie. ones that don't follow on from a previous message)
* Messages containing a forwarded message

Each of these actions is available at the press of a button, which takes you straight into Turnpike's Editor 
with as much as possible of the 'bones' of your message already set up. For example, when you reply to 
a message, your new message will automatically have your correspondent's email address and the 
subject of the message in place, plus a copy of their message (properly marked) so that you can easily 
quote parts of this message in your reply. And in all three cases, the new message will have your name, 
reply-to address etc. set in its Header and the signature that's been set up for your mailbox at the bottom.

All you need to do is prepare your message, check the address and the subject are filled in correctly, and 
then click the Post button. (By the way, there's no requirement to finish each message you start before 
going on to something else: just leave the message open on the screen or minimised as an icon. Turnpike
will automatically save it on disk for you, and it will still be there when you come back to it, even if you've 
left Turnpike in the meantime.)

Each message you post is initially placed in your Out tray, from where it can be opened and edited (or 
thrown away) any time up to the point that it actually gets sent - which will typically be when you next go 
on-line to the Internet. It is also automatically filed in your mailbase, from where it can be called up at any 
time from the appropriate mail list.Note: Even if you are already connected to your Access provider, the 
message will stay in the Out tray for at least a minute to give you a chance to change your mind or edit it 
before it is sent.

Click here for information on sending a reply to a message
Or here for information on sending a new message
Or here for information on forwarding mail

Note: Most messages will be sent to one person, but you can readily send both 'full' copies and 'carbon' 
copies to other people if you require (the difference between these two types of copy being simply 
whether the person receiving the message sees themselves as a full recipient of the message or just the 
recipient of a copy). You can also send 'blind carbon copies' of a message, where none of the other 
recipients of the message know that these copies have been sent. Click here for further information on 
this.

(For information about using Turnpike's Message Editor, see Preparing News / Mail messages.)



Sending a MIME message

To send someone a MIME message, you just need to select the Send MIME message check box shown 
above the message as you prepare it. (This option is automatically selected for you where you are 
replying to a MIME message.)

In all other respects, the steps used to prepare and send a MIME message are the same as those used to
prepare and send standard email message. In particular, any files you wish to include with the message 
are inserted in the usual way - either by using the Insert File option or by dragging them from the 
Windows File Manager (see Including files stored on disk).

The only special feature is that the type of file needs to be recorded alongside each file you include - 
principally to allow the correct viewing application to be chosen where the file is received. In the main, 
Turnpike will do this identification for you - automatically picking out files as image, audio etc. and 
recording the appropriate sub-type (eg. JPEG, TIFF, GIF etc.), but if Turnpike fails to identify the type of 
file (or you know there's something better to specify), you can set the type etc. through the Properties 
dialog , which is either called up automatically or by clicking the Properties button shown alongside the 
file's icon. 

If you don't select the MIME option, any files you specify as containing data will be uuencoded, while any 
characters in the text that are outside the ordinary mail character set will be replaced by a dummy 
character (after a warning).

Note: Turnpike normally sends the text of a MIME message 'Plain' (ie. without any formatting) but you 
can, if you want, opt for 'Enriched' text instead. The advantage of the Enriched option is that it leaves the 
text to be broken into lines at the receiver's end, where the font and margins that the person reading the 
message uses can be taken into account. If you'd like to give the person you are writing to this option and
they can handle Enriched MIME text, just go into the header of your message (by selecting the Edit mail 
header option) and switch the MIME option from Plain to Enriched. (There is also a Enriched & Plain 
option which caters for the case where you are not sure whether the person receiving the message can 
handle Enriched MIME - by sending two copies of the text, one enriched and one plain.)

Enriched MIME also allows a certain amount of text styling to be transmitted, but few people use this 
facility. In practice, you will get very much better results by leaving the MIME option set to 'Plain' and 
using your word processor to set up a suitable text file which you then include as a MIME attachment as 
described above.



Sending a pre-prepared message

If you have a message that you want to send held as a file on disk (eg. one that you've prepared using 
your word processor), this can readily be sent from Turnpike.

All you need to do is insert the appropriate file into a new mail message - either by using the Insert file 
button or by dragging it from the Windows File Manager into either the message or your mailbox.

To start with, your message will be represented by an icon within a horizontal bar - just like any other item 
you insert. But if you have stored the message as an ASCII text file, the horizontal bar will include a 
Merge into text button which you can use to insert it as text in the new message. This has two 
advantages. Firstly the person you are writing to won't have to do anything special in order to read it. 
Secondly, you will be able both to read the message and to make any changes you want before you send 
it. So do save your message as ASCII if you can.

All you have to do then is fill in the subject and the appropriate email address at the top of the message, 
then click the Post button to send it.

Click here for further information on Inserting files into mail messages.



Sending mail to someone in the Address book

One way of sending a message to someone in your Address book is to start a new message, click the 
Look up address button shown on the toolbar above this message, select the appropriate entry in the 
Address book and click the Select button.

But there's another way which is to pick out the person you want from the Address book and then create a
message to send to them.

The basic procedure in this case is to select the appropriate entry on the main Address book display, then
click the Start new email to: button on the toolbar. But if you want to check first that you've picked out the
correct entry, click instead the View/Alter button to display the details of the required entry. You can then 
use the Start new email to: button within this second dialog to create a message to this person.

When you click the Start new email to: button, Turnpike creates a new message ready set up for 
sending to the person you've selected. All you need to do is type your message, set the subject and then 
click the Post button.

Note: The new message is set up as if you had opted to send a new message from your default 
mailbox. If you want to use a special email name or to give a special reply-to address, you will need to 
edit the message header. If you want to use a different style of signature, then you can either edit the one 
you're given or pick out a different one to use.



Sending multiple mail messages

Mail messages are commonly sent to individual people but copies can readily be sent to other people if 
you require. You can also arrange to send the equivalent of 'carbon copies' or 'blind carbon copies' to 
people.

The way to arrange that these additional copies are sent is by adding the relevant email addresses to the 
Message header. The addresses of people receiving full copies need to be added to the To line of the 
header; those of people receiving carbon copies need to be added to the cc line; while the addresses of 
people receiving blind carbon copies need to be added to the bcc line of this header.

To add these addresses to the header of the message you are currently preparing, you need to click the 
Edit mail header button alongside the Subject and To boxes at the top of the message. This displays a 
dialog with slots for the main Header lines that you may want to set. You then simply need to enter the 
email addresses of the additional recipients in the To, cc and bcc sections of this dialog - using the 
adjacent [+] button to add extra addresses where you need to record more than one address in each of 
these slots.

Click here for further information about the Mail Header dialog.

Note: The required Header lines can be set up 'by hand', but if you expect to send copies to the same 
group of people again, the best approach is to set up the complete set of details as a 'Distribution List' 
within your Address book. Then whenever you want to send a message to this particular combination of 
people, you can simply insert this Distribution list from your Address book - in the same way that you 
insert any other entry from the Address book.



Sending new email

You can start a new email message (as distinct from a reply to a message that's been sent to you) from 
almost anywhere in the main Turnpike program - even from the Waste basket. Just click the Start new 
email button (if this is offered on the toolbar) or take the equivalent option from the Message/Article menu
- though if you are working in the Address book, there is an alternative option you can take.

But if you have set up any of your mailboxes (and newsstands) to insert special User information, it's 
worth thinking about precisely where you are working before you take the Start new email option 
because where you are will affect which signature is used in the message and what user information is 
set in the header of your message. In particular, it may affect what organisation you are seen to represent
and what reply-to address is given. If these things matter, it's important to select the correct mailbox / 
newsstand first. (Note: Messages sent from anything other than a mailbox or a newsstand - eg. a mail list
or the Address book - are styled as if they are being sent from your default mailbox, while those sent from 
a list of correspondence with a particular person are automatically addressed to that person. Similarly, 
messages sent from a tag list are automatically tagged with that tag.)

Clicking the Start new email button puts you into Turnpike's Editor with the outline for a new mail 
message already set up, complete with your signature at the bottom of the message. The appropriate 
sender and reply details are automatically set in the message header for you, so all you need to do is type
your message, fill in the subject and the email address of the person you're writing to (eg. by taking this 
from the Address book) in the upper part of this display and then click the Post button.

Note: The message you prepare is initially placed in your Out tray from where it can be opened and 
edited (or thrown away) any time up to the point that it is actually sent. However, even if you are already 
connected to your Access provider, the message will stay in the Out tray for at least a minute to give you 
a chance to change your mind or edit it before it is sent.

(For information about using Turnpike's Message Editor, see Preparing News / Mail messages.)



Setting access through the mailbox

*** Only important on shared systems ***

The access details initially set for any message is based on the Tags information set for the mailbox in 
which it is opened.

This information is recorded on the Tags page of the Mailbox dialog, which includes settings for the 
'Default owner of the mail' and the 'Default access when filed'.

What you need to set here are the access details that you will want to apply to the majority of messages 
in this mailbox - so that you will generally get the right result even if you forget to check the access 
settings before filing the message. (It also means that you will only have to set these details in the 
messages that don't fit the general rule.) So if most messages will be private, for instance, you should set 
the 'Default access' on the Tags page to 'Private'.

In the 'Default owner' part of the dialog, you can either select a specific owner for the mail - either yourself
or a workgroup you belong to - or opt for the ownership to depend on how the message was addressed 
(ie. 'you' if the message was sent specifically to you but if the message was sent to a workgroup, it should
be owned by the workgroup).



Setting colours and fonts

Turnpike has a standard font and a standard range of colours that it uses to display the different types of 
text within mail messages and news articles, but you can use other colours and fonts if you wish.

There are two ways of setting the font and the colours. Which you use depends on whether you simply 
want to affect the message / article that you are currently displaying (and any other messages / articles 
that you open in the same window) or whether you want to make the font or colour you choose the 
standard one for the mailbox / newsstand you are currently working on - or even across all your 
mailboxes and newsstands.

If you simply want to affect the message / article you are currently displaying, then the way to select the 
font or colour you want is through the Options menu. The Font option in this menu calls up a Font dialog 
through which you can select the Font, Font style and Font Size you want to use to display the current 
message / article (and any further messages / articles that you call up in the same window). Similarly the 
Colour option in this menu calls up a Colour Selection dialog through which you can select the colours 
used for the main text and for the background of the message / article you are currently displaying.

If, however, you want to make the colours / fonts you choose standard for the mailbox / newsstand you 
are working on, you need to set these as part of the definition of this mailbox / newsstand by recording 
them in the appropriate Mailbox / Newsstand dialog. In particular, if you want a particular colour or font 
used across all your mailboxes / newsstands, you need to record this as part of the definition of your 
Default mailbox - because any colour or font you set for your Default mailbox is used by default in all your 
other mailboxes and newsstands.

The dialog through which you need to set your choice of colour / font is called up by selecting the 
mailbox / newsstand you want to affect and then taking the appropriate Alter option from the File menu. 
The colours you want are then set on the   Colours   page of this dialog  , while the Fonts you want are set 
on its   Fonts   page  .

Note: The font used to display messages / articles can be set through either the Options menu or the 
Mailbox / Newsstand dialog as appropriate, but the font used to print them can only be set throught the 
Mailbox / Newsstand dialog. 



Setting the general ratings levels

Note: This procedure can only be carried out by someone who has both Alter Workgroups   and   Ratings   
Admin   permission   (or who can give themselves these permissions through having either Administrator 
or Configure Users permission). You should also note that, to start with, it may be that either no-one has 
Ratings Admin permission or just the Administrator has this permission.

To set the ratings levels that are to be generally applied, select Configure from the File menu, and take 
the Workgroups option from the sub-menu that appears. Then when the list of workgroups appears, 
select the ALL workgroup then click the Edit button to edit this workgroup. (ALL is a special workgroup 
which is automatically set up specifically to give you an easy way of giving the same permissions etc. to 
every one who uses your copy of Turnpike.)

When the details of the ALL workgroup appears, click the Ratings button.

This displays the Newsgroup Rating Services dialog, the top part of which is used to display the rating 
services that are in use and the maximum levels of each category covered by each service that are to be 
applied.

To add a new service, click on the Add service button shown in the lower part of the dialog and pick out 
the .RAT file corresponding to the service that is required. (These .RAT files are to be found in your 
Windows/System directory.) Note: The Add service button (and the corresponding Remove service 
button) are only displayed when the service details are blank or the cursor is on the name of a currently 
selected service, so if you can't see this button, move the cursor!

When you return to the Newsgroup Rating Services dialog, you will see the name of the service you've 
selected followed by a list of the categories identified by this service, together with the suggested 
maximum level for each of these categories.

To see what each selection means (and set a different level if required), select each category in turn and 
study the information given in the lower part of the dialog, then select a different level if required.

Last but not least, move the cursor back to a service name and choose whether unrated newsgroups 
should be hidden (treated as potentially offensive) or shown (treated as totally innocuous).

Note: The settings you make won't be accepted if they select levels regarded as unsuitable or potentially 
illegal by the ratings service. You will need to set a lower level instead.



Setting passwords

To set (or change) your password, take Configure from the File menu and then select Users from the 
submenu that appears.

If you're simply a user of the system, this takes you straight to an 'Edit Sign-on' dialog in which you can 
set a new password for yourself.

If you have appropriate administrative powers, you go first to a list of users, from which you need to select
the appropriate entry and then click the Edit button to display (a more comprehensive version of) the Edit 
Sign-on dialog.

As well as setting your new password, you automatically enable Turnpike's sign-on dialog. In future when 
you load either this main Turnpike program or the associated Connect program, you will see a sign-on 
dialog which you will need to fill in with your sign-on name and your password before you will be allowed 
into the program.

For further information about the Edit Sign-on dialog, either click here
Or press F1 to call up this Help file when you have the dialog on the screen



Setting permissions

*** Only important on shared systems ***

Where a number of people share the same system, it is generally best to have just one user - or at most a
handful of users - responsible for administrative tasks like allocating users to seats, editing call cost 
information, setting how email is distributed etc.

The way this is handled in Turnpike is by associating a range of permissions with each user.

The permissions that someone has can either be set directly for that person or they can come through the
workgroup(s) of which they are a member.

Personal permissions are set through Edit sign-on details dialog that is used to set the user's sign-on 
name and password. Workgroup permissions are set through the Edit workgroup details dialog that is 
used to specify the members of the workgroup. In either case, you simply need to select the actions that 
you want the user to be able to do without reference to the system administrator.

If someone gets permission to carry out a particular action through a workgroup that they are allocated to,
there is no need to give them personal permission to carry out that action. Indeed, you may find it best to 
treat the list of personal permissions as setting the actions that someone can carry out over and above 
the actions that their workgroup(s) allow.

Note: Of course, at least one user must be given permission to be the system administrator!



Setting personal ratings levels

Note: The following procedure can only be carried out by someone who has both Configure Users   and   
Ratings Admin   permission   (or who can give themselves these permissions). Moreover, it only needs to 
be carried out where special ratings levels are required for a particular user. The ratings levels that are to 
be applied generally are set by configuring the ALL workgroup.

You should also note that, to start with, it may be that either no-one has Ratings Admin permission or 
just the Administrator has this permission.

To set special ratings levels for a particular user, select Configure from the File menu, and take the 
Users option from the sub-menu that appears. Then when the list of users appears, select the entry for 
the person concerned then click the Edit button.

When the Edit sign-on dialog appears, click the Ratings button.

This displays the Newsgroup Rating Services dialog, the top part of which is used to display the rating 
services that are in use and the maximum levels of each category covered by each service that are 
currently applied.

To set this person's ratings levels, select each category for which a special level is required in turn, and 
select a required level from the options that are displayed.

You may also wish to make a special setting with regard to how unrated newsgroups are to be treated.

Note: The settings you make won't be accepted if they select levels regarded as unsuitable or potentially 
illegal by the ratings service. You will need to set a lower level instead.



Setting up Group mail

*** Only of interest on shared systems ***

Group mail is mail that can be opened and processed by any one of a group of users.

The way to arrange for mail to be delivered to such a group is to set up one or more email names with the
people or workgroups concerned as its users.

Assuming you have Alter Names permission, you can set up such an email name using the same steps 
that you use to set up alternative email names for yourself. The only difference is that as well as setting 
the email name itself in the Usage dialog that's displayed, you also need to set up a list of the users or 
workgroups that can use this name.

Click here for more information about Group mail



Setting up a mailing list as a newsgroup

Assuming you have List Subscribe permission, you can have the mail you receive from a mailing list 
treated as a special 'newsgroup' which not only you but other users of Turnpike at your site can use. Not 
only does this keep messages from the mailing list separate from your other mail, but it also arranges to 
thread messages that follow on from each other and to expire old messages after a set time.

To set this up, first select Configure from the File menu, then take the Email routeing option from the 
sub-menu that appears. This displays Turnpike's Email routeing to seats dialog, the first 'page' of which 
both shows what mailing lists have already subscribed to through Turnpike. To subscribe to another list, 
click the Add button and then fill in the name, address etc. of the list in the Mailing list details dialog that is
then displayed. (Note: If you later decide to cancel your subscription to this mailing list, you will need to 
remove it from the list of newsgroup subscriptions.)

If you don't already subscribe to this mailing list, you should click the 'Send email' button in the dialog so 
that Turnpike generates the appropriate subscription message for you. This message will appear for you 
to check then post when you click OK to finish with the Email routeing dialog.

When you return to the Email routeing dialog, the new mailing list will have been added to the list on the 
Mailing lists page. To read the messages that arrive from this mailing list, just add it to one of your 
newsstands in the same way that you add a newsgroup to a newsstand.

Mail from the mailing list should then start to be added to the mailing list newsgroup from the next time 
you collect mail. If it is put into one of your mailboxes instead, check the details set in the Mailing list 
details dialog, then if necessary study the page of this Help on Custom Mailing List Rules.)

If the mailing list sends a duplicate of a message already in your mailing list newsgroup, the duplicate will 
be sent to the wastepaper basket.

If you have already received any mail from this mailing list, then to add it to the mailing list newsgroup you
will need to export it, then re-import it as mail - as described in the section on Converting a mailing list to a
newsgroup.

Note: The mailing list will have a ! at the start of its name to identify it as a mailing list but otherwise it is 
treated just like any newsgroup. In particular, the messages will initially be set to be expired after the 
standard 3 days, but also just as with an newsgroup, you can set a different expiry time if you want in the 
Newsgroup Subscriptions dialog - assuming you have News Admin permission.



Setting up mailboxes

Turnpike automatically gives you one mailbox for your mail but it is useful to set up further mailboxes, 
because this will allow you to separate eg. personal mail from business mail. Multiple mailboxes can also 
be useful if you receive mail on behalf of a number of different organisations.

In general terms, messages can be sorted into different mailboxes according to:
* Which of your email names the message uses, or
* Where it has come from, or
* The subject of the message
(or any combination of these three) - though it is also possible to set some 'custom rules' for selecting the 
messages that are to be put into a mailbox.

To set up a new mailbox, take the New mailbox option from the File menu. This will start the Mailbox 
Setup Wizard. If you want the new mailbox to be assigned to a new email name, you should add the new 
email name first.

If you subsequently want to change the details either of the default mailbox or of a mailbox you've
set up, you need to select the appropriate mailbox (eg. by picking it out from among the list of windows 
shown in the Window menu), then take the Alter mailbox option from the File menu.

This displays the Mailbox dialog, the 'pages' of which cover the different aspects of this mailbox that you 
can set. Simply make the changes you require to the details of the mailbox and then click on the OK 
button.

For more information about the Mailbox dialog and the aspects of the mailbox you can set, either click 
here
or press F1 to call up this Help file when you have the dialog on the screen.



Setting up a newsgroup

From time to time, you may feel the urge to set up a newsgroup to cover some topic that doesn't appear 
to be covered by any of the existing range of newsgroups.

This is not something that you do by calling up particular options within Turnpike. What is needed here is 
agreement from other users of the Usenet news service that there is indeed a need for the newsgroup 
you propose - and that is quite a long administrative procedure involving posting articles inviting 
responses to your proposal and counting up the votes in favour.

The place to look for information on this is in the news.groups newsgroup.



Setting up newsstands

The way you follow the discussions going on within Usenet news is by setting up newsstands containing 
the newsgroups you want to read.

You could just set up one newsstand covering all the newsgroups you want to follow, but you may find it 
useful to have different newsstands for different interests - for example, one covering newsgroups that 
you take for business purposes, another covering your recreational interests and a third covering 
humorous or other alternative newsgroups.

To set up a new newsstand, take the New newsstand option from the File menu.    This will start the 
Newsstand Setup Wizard.

If you subsequently want to change the details of a newsstand, you can either use the buttons shown at 
the bottom of the newsstand to Add and Remove newsgroups etc. or take the Alter newsstand option 
from the File menu to make other changes to the newsstand.

Click here for information about adding newsgroups to a newsstand
Here for information about the Name page of the Newsstand dialog
Or here if you want to know about other aspects of the Newsstand dialog.



Setting up tags

New tags are generally set up when you are picking out the tags to add to a message from the Tag 
Selection dialog, but they can also be set up from the Edit Email Tags dialog called up when you opt to 
edit your existing range of tags.

In either case, you click the New tag button included in the dialog then set the details of the new tag in 
the dialog that is then displayed.

Where the tag is for your own personal use (as it will be on a single-user system), you just have to type 
the tag name. But on a multi-user system, you may also need to set who should have access to mail that 
is tagged with this tag    - see Making access dependent on topic.



Setting up workgroups

**** Only relevant on shared systems ***

Workgroups are the Turnpike equivalent of an office or a department within a company.

By putting users together into a workgroup, you can arrange that:
* They all have 'permission' to carry out a particular range of administrative actions - by giving these 
permissions to the group (see Setting permissions)
* Mail that arrives using particular 'group' email names can be picked out and processed by any member 
of the group - by giving the group access to these names (see Group Mail)
* Mail on particular topics can be seen by any member of a workgroup - by tagging it with one of their 
'group' topic tags (see Making access dependent on topic)

Assuming you have Alter workgroups permission, you can set up workgroups by taking Configure from 
the File menu, then selecting Workgroups from the submenu that appears.

This displays the Administer Workgroups dialog which lists the workgroups that have been set up so far.
* To set up a new workgroup, click the Create button.
* To change an existing workgroup, select the workgroup from the list and click Edit.

In either case, this displays the Edit workgroup details dialog in which you can define the workgroup you 
require. This is mainly a matter of picking out the users you want in this workgroup and adding them to 
the Current members list, then selecting the actions members of this workgroup are to be allowed to carry
out by virtue of being a member of this group.



Setting where news and mail is stored

When Turnpike is installed, it automatically creates NEWS and MAIL directories alongside the Turnpike 
Connect program and sets up both Turnpike Connect and the main Turnpike program to use these 
directories.

If you run out of space on the current disk, and you have access to another disk, the answer may be to 
move either the NEWS directory or the MAIL directory (or perhaps both) to a different disk. (If you need to
move the whole of Turnpike to another machine or another system, click here.)

The first step is simply to use standard File Manager actions to move the directories to their new location. 
But before you do this, you should ensure that the Turnpike programs both on the host machine and on 
any other machine on your system are closed - to avoid confusion.

You will then need to record the new File Path information within both Turnpike and Turnpike Connect - 
and, if these files are accessed from other machines across a network, to let your colleagues know the 
new location of these files so that they too can record the new details in the copies of Turnpike they use.

There are two ways of recording these details. If the Sign-on dialog is displayed when the program is run, 
you simply need to click the Paths button in this dialog and then set the new path information in the File 
Paths dialog that's displayed. If the Sign-on dialog isn't displayed, you will need to edit the TURNPIKE.INI 
and the CONNECT.INI files in your Turnpike directory and record the new Newspath and Mailpath in the 
[PATHS] section of these files.



Signing on

If you are the sole user of your copy of Turnpike, loading either this main Turnpike program or the 
associated Connect program will normally take you straight into that program.

But if you share your system with other users or you have opted to protect your mail files against 
unauthorised access with a password, you or your system administrator will have opted to enable 
Turnpike's Sign-on dialog so that you specify:
* your Sign-on name;
* your Password (if any); and
* (through a subsidiary directory) the Paths to your personal Turnpike directory, and to where the news 
and mail files are stored - should you ever need to change this.

If you are the person who installed Turnpike, your sign-on name will be the email name you gave when 
you installed Turnpike. Moreover, this name will probably either be already filled in for you or available 
from the drop-down list associated with the Sign-on slot in this dialog - so you will probably just need to 
select the right sign-on name, type any password you've set and click OK.

If you weren't the person who installed Turnpike, you will probably have been told the sign-on name and 
password to use - though you can set a different password after you've signed-on. (Click here for further 
information on this.)

Turnpike automatically remembers the last sign-on name and file paths to be used, so that if you were the
last user, you just need to give any password that's required then click 'OK'. If you weren't the last user, 
you will need to type your sign-on name over the one that's shown, though if you've signed on before, you
should be able to select your sign-on name from the drop-down list associated with the Sign-on slot.



Sign-on name
The name by which an individual user is known to Turnpike. This name is usually also one of the user's 
email names, so the rules for this name are the same as those for an email name.



Signature menu

Change signature
Save signature as



Signature menu / Editor button: Change signature
Lets you replace the signature currently on the bottom of the message / article you are preparing by one 
of the other signatures that you have stored on disc.

For more information, see Signatures.

See also: Save signature as...



Signature menu: Save signature as
Lets you save the signature at the bottom of the message / article you are working on as a file on disc for 
later use.

For more information, see Signatures.

See also: Change signature



Signatures

Internet convention demands that you finish any message you send or article you post with a signature, 
which ideally should give your name, plus an address or phone number on which you can be contacted if,
for some reason, it is not possible to contact you via the Internet. Convention also suggests that this 
signature should be divided from the main part of the message by a line made up of - - followed by a 
space.

For this reason, Turnpike automatically adds a signature at the bottom of each mail message or news 
article you prepare. This is shown below the solid line that finishes the main text of the message - typically
in a different colour.

To start with, Turnpike inserts a standard form of signature for you, made up of - - (space) followed by 
whatever name you gave when it asked you for your full name, but you can set up whatever signature you
like. In particular, you can set up a range of signatures for use in different mailboxes and newsstands 
because ultimately what Turnpike inserts is the signature that has been recorded for the mailbox.

We would, however, recommend you to start all your signatures with '- - (space)' on a line of its own, 
because that will help other users of Turnpike you correspond with by allowing your signature to be 
automatically stripped from their replies.

The signature that Turnpike inserts into a message is just text. So the basic way of changing this 
signature is simply by editing it.

However, that just gives you a different signature in the message you are currently working on. To use this
signature across a number of different messages, you need to save it as a filename.sig file on your disk - 
by taking Save signature as from the Signature menu before you post the message: Turnpike will then 
display a File Selector for you to specify where you want this signature to be stored.

To start with, Turnpike suggests you save your new signature as standard.sig in your user directory. You 
should take this option if you expect to use this signature for most of your messages (unless of course 
you want to preserve the signature that you've previously stored as standard.sig) because mailboxes 
and newsstands are set up by default to use whatever signature is saved as your standard.sig.

If you intend the signature instead of your standard.sig in the messages / articles you write from a 
particular mailbox or newsstand, you should save it under a different filename.sig name - then select this 
file in the Signature slot of the User info page of the appropriate Mailbox or Newsstand dialog: see 
Setting up mailboxes or Setting up newsstands as appropriate.

If you only want to use the signature occasionally, you should still save it as a file on disk but you should 
leave the mailbox/newsstand set up to give you the signature you will normally use. When you want to 
use the special signature, you can replace the signature Turnpike has given you by the one you want by 
taking the Change signature option from the Signature menu and then picking out the file containing the 
signature you require.



Simply removing someone from the system

The basic way in which an 'ex-user' is simply removed from the system is by selecting their entry in the 
Configure Users dialog, then clicking the Remove button.

But first their mailboxes need to be cleared, so we suggest that the System Administrator should:

1. Give themself access to the person's mail files by taking Configure | Users from the File menu, 
selecting the entry for the ex-user, making a note of the number of the seat they occupied - then clicking 
the Edit button and setting a new password in the dialog that's displayed.

2. Log on as the ex-user and file or delete any mail in their mailboxes.

3. Log on again as themself, take Configure | Users from the File menu and select the entry for the ex-
user again, but this time click the Remove button to remove them from the system.

4. Rebuild the mailbase. This removes their personal tags and re-assigns any personal mail to the 
occupier of Seat #1 (which is probably the System Administrator).

5. Go into the USERxxx directory corresponding to the ex-user's seat, clear it of any files (Turnpike 
doesn't do this for you in case you want to retain any of these files) then delete the directory.

Note: It's not possible to remove either Seat #1 or the seat you are currently sitting at.



The Site ID is the 'serial number' of your copy of Turnpike.

The Site ID of any Evaluation copy of Turnpike is generated automatically. The Site ID for a full copy of 
Turnpike is to be found on the CD pack and you will have been asked to enter this the first time this full 
copy is run.

The Site ID can be inspected, and if necessary changed, from the Connect program - either by taking the
Site Key option from the Configure menu or by clicking the Site Key button on this program's sign-on 
dialog.



If you add extra features to your copy of Turnpike, for example extra 'seats' on a shared system, the 
change is recorded by entering a 'Site Key'.

The Site Key you need use and other information about this feature of Turnpike is supplied when you 
purchase the appropriate upgrade.

Note: When entering this key, you can use any combination of upper and lower case as any lower case 
characters will be automatically switched to upper case for you. You also don't need to worry whether 0 is 
a zero or the letter O, or 1 is the number one, a little l or a capital I: they're actually numbers but the 
letters will also be accepted.



The Site Secret is a code word that is used (together with the Site ID) to encrypt mail messages so that 
they can't be read by simply opening the mail files.

The Site Secret may be blank (ie. no characters) if you want, but then your mail messages are only 
encrypted with the Site ID which someone else could find out. With a specific string as your Site Secret, 
someone trying to read your mail files would need to know both your Site ID and your Site Secret.

You will probably only need to enter your Site Secret once - but you should keep a record of it (and your 
Site ID) in case you ever have to re-install your Turnpike system from scratch. If you don't use the same 
Site Secret again, you won't be able to read any of the mail messages that were received using the 
previous installation.

If you didn't keep a record of the original Site Secret, someone with administrator permission can set a 
new Site Secret from the Connect program - either by taking the Site Key option from the Configure 
menu or by clicking the Site Key button on that program's sign-on dialog.



Site Specific Details

The basic registration details about your site are the Site ID and any Site Key that has been set. You don't
need to know these details for everyday use of Turnpike but you may occasionally be asked to quote 
them and occasionally new details may need to be set eg. to record the addition of extra seats. If so, they 
may be displayed by taking the Site Key option from the Connect program Configure menu (or by 
clicking the Site Key button in the Connect program Sign-on dialog).

Note: The details can only be changed by someone with administrator permission - or by someone who 
can demonstrate that they know the Site Secret.



Smileys
Smileys are combinations of characters which when viewed with your head turned to the left (and with 
quite a lot of imagination) resemble faces.

The original smiley was simply :-) but as people were quick to realise, it is possible to represent a wide 
range of expressions by substituting different characters - particularly for the eyes and the mouth - while 
adding further characters allows you to represent headgear, bow ties etc. etc.

:-( sad :-o surprised

:-/ confused ;-) wink

Such a range of smileys have been developed that it is impossible to list them all. In any case, it is usually
fairly easy to work out what they are trying to represent.

See also Abbreviations.



Software Error nnn

"Software Error" followed by a number means that one of Turnpike's internal consistency checks has 
failed. This can happen if a file has been damaged due to the power being cut, or some other program 
crashing, while Connect is saving data. However, if the error occurs frequently it could suggest the 
machine has a problem with the reliable storage of data, either related to hardware (faults with RAM or 
the hard disk; an over-clocked processor) or to software (malfunctioning disk or memory utilities; perhaps 
a virus).

These errors are usually associated with either the news database or the address book. Special 
precautions are taken to minimise the risk of problems affecting the mail database.

The cure is to rebuild the affected database. (unless the error is reported to be in USERNEWS, in which 
case see the Notes below). Rebuilding a database recreates all the indexes and other secondary 
information, and discards any damaged data.

But before rebuilding the database, it is a good idea to run the Windows utility SCANDISK.
This will ensure your file and directory structure is valid.

After you have shut the Turnpike program and run Scandisk, start the Connect program and either rebuild
when you are prompted, or select Rebuild from the File menu.

Sometimes it is clear that you have a problem with your mail or news databases, but Turnpike reports an 
error before it has run long enough to give you a chance to do a database rebuild. To correct this, rename
the \turnpike\news\newsbase (or \turnpike\mail\mailbase) file to something else and then start Turnpike. 
The program will spot the missing file and offer to rebuild. Before accepting the offer, switch task (e.g. 
to File Manager or Windows Explorer) and rename the file back to its original name. Turnpike will then 
rebuild. If you don't rename the file back again, more information will be lost than necessary.

If the error is reported to be in the file USERNEWS then rebuilding the news database will not help. 
Instead, you need to delete the USERNEWS file. Note that this will lose information about which threads 
you have read and marked as interesting or uninteresting. Once again, use SCANDISK before running 
Turnpike again.



Sorting your Mail

Mail messages, whether delivered by the postman or by the Internet, are very much easier to handle once
they have been sorted into different categories - both when first delivered and when saved on disk.

Turnpike helps you to sort your mail in two main ways.

Firstly, it allows you to set up separate mailboxes for different types of mail.

Secondly, it provides ways of categorising mail messages on the basis of who they were written by or 
written to, or what they are about, and then lets you view just the mail messages that you have 
exchanged with a particular person or just the ones on particular topics.

Click here for more information on setting up additional mailboxes
Or here for information on tagging messages to categorise them.



Spamming
Posting a news article to a large number of newsgroups. Generally frowned upon.



A spoiler is a convention used in News articles to hide something that the author does not want people to
see immediately, such as the answer to a riddle. Some people just add lots of blank lines, so the text 
concerned is not immediately visible in the first screenful of text. However, if the convention of Control-L 
(linefeed) is used, newsreaders such as Turnpike can hide the text behind a button, thus:

Note that if you use this technique yourself, only a black line (without a button) appears in the outgoing 
article.

Note also that it is a Usenet convention, and cannot be used in Email.



This is the last page of the Newsstand Setup Wizard.

Here you can keep the suggested name for the new newsstand or type in another unique name.

You can move backwards and forwards through the wizard pages to check or change the details you 
have entered using the Back and Next buttons.

When you press Finish here the new newsstand will be created.

You can further customize or change the contents of the newsstand later if required, using the Alter, Add 
and Remove buttons at the bottom of the window or by taking the Alter newsstand option in the File 
menu.



On the first page of the Newsstand Setup Wizard you can add one or more newsgroups to the new 
newsstand.    (Or you can just leave the newsstand empty for the moment and add the newsgroups you 
require later.)

The top part of the page helps you select the newsgroups you want. As you pick each newsgroup out, this
is added to a list in the lower part of the page, so that you can see what you have picked out so far. (This 
lower part of the page also includes a Remove button to use if you decide you don't want a particular 
group after all.)

The Ratings button lets you call up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

You pick out the newsgroups you want, one by one from the list in the top part of the page. This list is 
initially set to show the groups which are currently subscribed to (ie. downloaded to your site) - but if you 
have News Administrator permission, you can switch it to show all the newsgroups available from your 
Access provider's news server by selecting the option you require to the right of the list.

If you know which hierarchy the newsgroup you require belongs to, the best way to pick this out is to start 
typing this in the Find slot at the top of the screen. The section shown in the box will automatically move 
to the appropriate part of the list, from where you can scroll until you spot the group you require.

If you just know the topic you are interested in, type *topic in the Find slot, then use the Find first and 
Find next buttons to work through all the newsgroups that have this topic in their title until you find the 
one you want. (Click here for further information on this.)

When you've found a group you want to add, click the Add button. The newsgroup is then added to the 
list of Additional newsgroups at the bottom of the screen.

Simply go on selecting newsgroups in this way until you have picked out all the ones you want.



On this page of the Newsstand Setup Wizard you supply the information to identify yourself when you 
reply to or followup news articles.

The details you can set are as follows:

Email name: Which of your email names should be used where your email address is quoted 

Name: The full name to be quoted

Signature: Which of the various signatures you've got saved on disk should be used. (Use the Browse 
button to select a different signature file if required.)



Standard conventions

A basic feature of messages and articles transmitted over the Internet is that these are written without 
exotic styling like Bold, Italic etc. - because there's no guarantee that the system receiving these 
messages will be able to interpret the styling instructions that are used.

However, the trouble with using plain text for messages is that it then isn't easy to get over to the reader 
where you are trying to emphasise something or where you are making a wry comment. So a number of 
conventions have grown up, of which the main ones are:

* Where you are giving the title of something, you start this with an Underline, finish it with an Underline 
and link all the words between by Underlines
* Where you simply want to emphasise something, you surround this with *s
* Where (and only where) you want to 'shout' something, you write this in CAPITAL LETTERS
* Where you have made a wry comment, you follow this with an appropriate smiley.

See also Abbreviations.



Starting a news thread

**** New Users click here ****

The way to start a new discussion within a newsgroup is to 'post' an article which starts a new news 
thread.

To do this, open the newsgroup on your screen (if it is not already open) then take the Start news thread 
option from the Article menu.

Turnpike then displays its Message Editor set up ready for you to post a new article.

The new article is automatically set up to have your standard signature at the bottom. It is also set up to 
be posted to the current newsgroup. So you simply need to:
* Type in the article you want to post
* Set the subject in the Subject slot at the top of the display
* Then click on the Post button.

The article is then placed in your Out tray, from where it can be opened and edited (or thrown away) any 
time up to the point that it is actually sent. Note: Even if you are already connected to your Access 
provider, the article will stay in the Out tray for at least a minute to give you a chance to change your mind
or edit it before it is sent.

Note: The article is set up to tell readers to post any follow-up articles to the same newsgroup and to give
your email address as the Reply address. If you need to set different details or you want to include either 
a list of keywords or a summary of the article in the header, click the Edit news header button and set the
details you require before you post the article.

(For information about using Turnpike's Message Editor, see Preparing News / Mail messages.)



Status bar
There is a Status bar displaying brief information at the bottom of several displays within Turnpike.

The Status bar at the bottom of the main Turnpike screen is used both to remind you how to call up this 
on-screen Help and to give a brief explanation of menu options as you select these.

The Status bar at the bottom of a newsstand is used to summarise the number of unread articles in the 
newsstand / newsgroup you are currently looking at, and the number of these which have been marked 
'Interesting'.

The Status bar at the bottom of a mailbox is used to show how many messages there are in this mailbox. 
(Similar information is shown by the Status bar at the bottom of Mail lists and at the bottom of the Out box
and the Waste basket when these are opened on the screen.)

A Status bar is also shown when you open a mail message on the screen. In this case, it is used to show 
who owns the message, what overall access rights have been set and what tags have been set. Click 
here for more information on this Status bar.



Stopping messages being sent

If you decide against sending a message or posting an article while you are preparing it, then you can 
send it to the Waste basket by clicking the Abandon button above the message.

If however you decide against sending a message after posting it or you want to make a change to it, the 
first thing to do is to try to pull it out of your Out tray before it is sent. If it has already gone, you will just 
have to follow your message up with a correction or an apology as appropriate - though with a news 
article, you also have the option of Cancelling the article.



Subscribing to mailing lists

To join (or to leave) a particular mailing list, you need to send a message to the list's administrator, telling 
him/her that you want to subscribe to (or 'unsubscribe' from) their list.

The standard way of doing this is by sending an email message to the mailing list's administration 
address. This will probably be similar to the mailing list's address but with a suffix like -request. (The 
administration address is deliberately different from the mailing list's to avoid your request being sent to 
everyone on the mailing list, rather than just to the administrator. Sending your request to everyone on the
list will just annoy them, so be careful to use the right address.)

However, rather than use a human administrator, a number of mailing lists use automated systems 
referred to as 'robots'. For example, several mailing lists use a 'listserv' robot to handle their subscription 
requests, while others use a 'Majordomo' robot. These robots require the subscription request to be given 
in a standard form. For example, the listserv robot requires you to send a message to listserv@mailing-
list-site, containing the single line: subscribe list-name your-name. Similarly, when you want to stop 
receiving mail from this mailing list, you just need to send the message unsubscribe list-name your-
name to this listserv address.

But if you have List Subscribe permission, you can get Turnpike to prepare and send these messages for 
you. Turnpike also arranges that the mail you receive from the mailing lists you subscribe to is handled 
within a special 'newsgroup'. Not only does this keep items of mail from the mailing list separate from your
other mail, but it also arranges to thread items that follow on from each other and to expire old items after 
a set time.

Click here for details of the steps to take.



Subscribing to newsgroups

To follow the discussions in a particular newsgroup, you firstly need to 'subscribe' to it - ie. have the 
articles that are contributed to this newsgroup downloaded to your disk. You also need to include the 
newsgroup in one of your newsstands.

To subscribe to a newsgroup, it has to be added to the list of newsgroup subscriptions displayed in the 
Newsgroup Subscriptions dialog. But assuming you have News Admin permission, all you actually need 
to do is add this newsgroup to one of your newsstands (see Adding newsgroups to a newsstand). If you 
add a newsgroup that isn't currently subscribed to a newsstand, this is automatically added to the overall 
list of newsgroup subscriptions which ultimately controls which newsgroups are subscribed to. (Indeed, if 
you want to abandon your subscription to a particular newsgroup, the way to do this is by removing it from
this overall list - see Cancelling your subscription to a newsgroup.)

On a shared system, however, the System Administrator may have decided not to allow individual users 
to pick out the newsgroups they want but instead to use the Newsgroup Subscriptions dialog to set up a 
list of subscribed newsgroups from which the users can pick. This dialog may also be used to set:
* How long the articles should remain on your system before being expired
* Whether the articles should be copied to your system in full or just browsed (see Download options for 
news)
* And who can follow the discussions in a particular newsgroup if you decide to restrict access to this 
newsgroup.

Note: New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks 
up articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, 
you can ask Turnpike to pick up a complete new list through the Configure Usenet News dialog in 
Turnpike Connect. This is particularly useful if you change the News server you use (eg. because you 
change Access provider) because not all News servers carry the same range of newsgroups.



Tag Selection Dialog

This dialog is used to choose a selection of one or more tags for one of three different purposes:

* To add tags to a particular message after clicking the Tags button at the bottom of the message window.

* To add tags to all the messages which arrive in a mailbox.    This may be done from the tags page of the 
Mailbox Dialog or the Mailbox Setup Wizard.

* To specify the tags required for messages to be included in a mail list. This may be done from the tags 
page of the Mail List Setup Wizard.

The top part of the Tag Selection dialog offers a list of the tags that have been set up so far, together with 
the option to set up new tags. The bottom part of the dialog is used to show a list of the tags that have 
been picked out to be applied to the current message.

Where suitable tags have already been set up, you just need to select the tags you require one by one in 
the top part of the dialog, then add them to the list at the bottom. (This can be done either by using the 
Add button or by double-clicking on the tag in the upper list.)

Where the tag you want hasn't been set up yet, you first need to click the New tag button and set up the 
new tag you want in the Make New Tag dialog that is then displayed.

If you are setting tags on a particular email message then when you return to the message, the tags 
you've selected will be shown alongside the Tags button on the status bar at the bottom of the message 
window.



Tagging messages

As well as looking at the new messages that have arrived in your mailboxes, there will be times when you
will want to look back over messages that you received in the past and have now filed away - and over 
the messages that you've written. Moreover as your store of messages sent and received grows, you will 
rapidly come to a point where you will want to be able to pick out mail according to what the message is 
about.

To enable you to do this, Turnpike lets you mark messages with one or more 'tags'. These tags are like 
the labels on folders within a conventional filing cabinet - and adding a tag to a mail message is like 
inserting the message into the corresponding folder. You simply mark each message with the tags 
corresponding to all the different headings under which you would like to be able to pick out this message.
(The analogy here is with putting copies into different folders - though there is no duplication of the 
message in this case.)

When you want to see the messages that have been exchanged on a particular topic, you ask Turnpike to
produce a 'mail list' for the corresponding tag. It then pulls out all the messages that have been marked 
with this tag - in much the same way as you might pull out a folder from a conventional filing cabinet.

Tags are principally added to messages as you read them, or in the case of messages you send, as you 
prepare these. In either case, you click the Tags button on the Status bar at the bottom of the message 
window and then select the tags you want to apply in the dialog that is displayed. (For details, see 
Tagging messages with their topic.)

You can also add tags by dragging messages (either individually or as a selection picked out together) to 
mail lists of messages with the required tags - and similarly, remove tags by dragging messages out of 
the corresponding mail list. The best time to use this technique is when you are tidying up a mailbox 
because you can both tag and file one or more messages in one action, simply by dragging them to the 
appropriate mail list. But you can also drag messages from one mail list to another (removing the tag(s) of
the first list and adding the tag(s) of the second) - or add tags by dragging messages from a list of 
messages exchanged with a particular person to the appropriate mail list.

Last but not least, if there's a tag (or tags) that you want to give to all the mail that goes through a 
particular mailbox, then you can arrange for these tags to be automatically added to each item of mail 
that's sent or received through the mailbox by recording the details of these tags on the Tags page of the 
appropriate Mailbox dialog (see Tagging messages through the mailbox). These tags are also used to tag 
any additional mail messages you import into Turnpike (see 'Importing mail and news').

Note: As well as setting the tags on the current message, Turnpike also arranges that any message sent 
in reply to this message will be given the same set of tags - so that this reply will be picked out alongside 
the original message in the mail lists you call up.



Tagging messages through the mailbox

Among the things you can define about a mailbox are one or more tags that you want automatically 
applied to any item of mail in this mailbox. If the mail that is put into a particular mailbox (or sent from this 
mailbox) naturally comes under the heading of any of the tags you use, you can save yourself the effort of
applying this tag to each piece of mail by making it part of the mailbox definition.

These tags will also be applied automatically to any mail that is imported through the mailbox (see 
'Importing mail and news').

The required tags need to be set on the 'Tags' page of the Mailbox dialog. So to record the tags you want 
for a particular mailbox, you need to select this mailbox, take the Alter mailbox option from the File menu
to call up the appropriate Mailbox dialog - then switch to the Tags page of this dialog.

The Tags page lists any tags that are currently applied. To add to this list (or remove tags from it), you 
need to click the Edit button alongside the list. This displays the same Tag Selection dialog that is used to
apply tags to individual articles. So to pick out the tags you want, you just need to select these in the 
upper part of this dialog and then add them one-by-one to the list in the lower part of the dialog.

Click here for further information about the Tags page of the Mailbox dialog
Or here for information about the Tag Selection dialog
Or press F1 to call up this Help file when you have the appropriate dialog on the screen.



Tagging messages with their topic

Tags are typically added to messages you receive as you read them, and to messages that you send as 
you prepare these.

In either case, you click the Tags button on the Status bar at the bottom of the message window. This 
displays a Tag Selection dialog from which to select the tags you want. The top part of this dialog offers a 
list of the tags that have been set up so far, together with the option to set up new tags. The bottom part 
of this dialog shows a list of the tags that have so far been picked out to be applied to the current 
message.

If the tags you want have already been set up, you just need to select these tags one by one in the top 
part of the dialog and 'Add' them to the list at the bottom. If the tag you want hasn't been set up yet, then 
you first need to click the New tag button and set up the new tag you want in the dialog that is then 
displayed.

When you return to the message, the tags you've selected will be shown alongside the Tags button on 
the status bar at the bottom of the message window.

You can also add (or remove) tags by dragging them into (or out of) mail lists of messages marked with 
the appropriate tag(s). For example, if Exhibition was one of your tags, you could add this tag to one or 
more messages by calling up a mail list of messages with Exhibition as one of their tags and then 
dragging the messages to this mail list either from a mailbox, from a list of correspondence called up via 
the Address book or from a mail list of messages marked with a different tag. In this last case, you would 
remove the existing tag and add the new tag - giving you a neat way of re-categorising messages, simply 
by dragging them from one mail list to another.

Dragging a message from a mailbox to a mail list also files the message, allowing you to both categorise 
messages and file them in one easy movement. Suppose, for example, that you wanted to categorise 
messages as either Project X, Project Y or Project Z. One way of doing this would be to set these up as 
tags, then call up a mail list for each of these tags, minimise these lists (so that they appear as icons) - 
then simply drag the messages to the appropriate icon for filing.

Click here for further information about the Tag Selection dialog
Or here for information about setting up a new tag
- or press F1 to call up this Help file when the appropriate dialog is on the screen

Note: You can also arrange for some tags to be set automatically depending on which mailbox an item of 
mail is placed in: see Tagging messages through the mailbox.



Tags
Tags are markers which can be added to an email message in order to let you pick out this message out 
alongside other messages on similar topics.

Each tag is like a label on a folder in a filing cabinet and tagging a message with a particular tag is like 
putting a copy of the message into the appropriate folder.

For more information, see Tagging messages.



Taking addresses from the Address book
To insert an address from the Address book into the mail message you are currently working on, simply 
click the Look up Address button on the Editor toolbar, select the Address book entry you require and 
then click the Select button to insert the email address from the selected entry into your message.

If there are any addresses already in the To: slot, the address you pick out can either be added to these 
addresses or it can replace them. A message will appear asking which you require.

Note: If you would like to check that you've selected the correct entry before you insert the address, 
select the entry as above but then click the View button. This displays the full details of the Address Book 
entry you've selected. If this is indeed the entry you want, you can then use the Select button within this 
second display to insert the required email address into your message.



When you want to tell Turnpike a name or a topic to look for among newsgroup names, subject lines, or 
address lines, you do this by using the 'wildcard' characters ? and * to tell it the pattern that the 
newsgroup names, subject lines etc. it picks out needs to match.

In this context, ? means match a single character while * means 'match any number of characters'.

In general, the combination of characters you give needs to tell Turnpike precisely the pattern it is to 
match. For example, to tell Turnpike to pick out messages sent from anyone@anycompany.com or 
anyone@anycompany.co.uk you need to tell it to match the address from which the message was sent 
against *anycompany*

However, where you want Turnpike to pick out a newsgroup name or a subject line containing a particular 
word or phrase (astrology, for example), you can specify this by just typing *astrology You don't need to 
type the final *. You can use multiple * characters. For example, *aut*ant could be used to pick out a 
newsgroup called alt.autos.antique.



The permissions

The different permissions that a user may be given are as follows:

Administrator Automatically given permission to Configure Users (ie. add new users, set other
users' sign-on details and permissions) and Rebuild datafiles

Connect Admin Allowed to alter the Host, Timezone, Mail Transfer, News Collection and Service
Access details recorded through the Configure menu in the Connect program. 
Also allowed to Configure the Toolbar in the Connect program and to make 
permanent changes to Call cost logging.

Dialling Admin Allowed to alter the Dial Settings dialog in the Connect program.

Email Admin Allowed to Configure Email Routeing - ie. to set how email is distributed to 
different users and who handles Dead Letter Mail

News Admin Allowed to Configure Newsgroups - ie. to select which newsgroups are 
subscribed to, to set how long articles remain on your disk before being expired 
and to restrict access to particular newsgroups.

Alter Users Allowed to Configure Users - ie. add new users, set other users' sign-on details 
and permissions.

Alter Workgroups Allowed to Configure Workgroups.

Alter Names Allowed to set up Email names for any user.

Add Email Names Allowed to set up Email names for themselves.

Connect to Net Allowed to run the Connect program and connect to your Access provider.

Keep articles Allowed to mark articles to be kept beyond their normal expiry time.

Kill articles Allowed to kill individual news articles and to set up Kill rules.

List Subscribe Allowed to set up mailing lists as pseudo-newsgroups available to any user.

Rebuild Files Allowed to rebuild the news database, the mail database or the address book as
required.

Ratings Admin Allowed to set the newsgroup ratings controlling which newsgroups can be seen
by different users.

Serve POP3 Allowed to access the mail in their Turnpike mailbox from outside their Turnpike 
system.



Threading
The process of working out how the different articles in a newsgroup follow on from each other is known 
as Threading.

Turnpike automatically threads each newsgroup before you go into it. You can also prompt it to re-thread 
the group that you are currently working in by clicking the Refresh button at the bottom of the newsstand.



For advice on any of the following, click on the appropriate entry:

Missing articles
Only headers were downloaded
Browse group contains full articles
'Software' errors
Fonts/colours not saved
Downloaded email not found
Email being deleted from the POP3 server

For advice on connection problems, consult the Troubleshooting section of Turnpike Connect's help file.



Turnpike tips
This is a sequence of useful (we hope) tips about using Turnpike, which may be displayed automatically 
whenever you load the Turnpike program. It can also be displayed by switching the Show Turnpike Tip 
option in the Help menu from unticked to ticked.



Unregistered Evaluation Version dialog

This dialog automatically appears whenever an Evaluation copy of Turnpike is run to advise when this 
time-limited copy of Turnpike will 'expire'.

(Separate dates are given for the main Turnpike program and the Connect program because the main 
Turnpike program continues to run for a few more days to give someone who doesn't wish to continue 
using Turnpike the opportunity to export any mail they've sent or received using Turnpike in a format that 
can be read by other Mail readers.)

The box at the bottom of the dialog is to tick when you have ordered a full copy of Turnpike.

Note: If the full copy hasn't arrived by the time this Evaluation version has expired, ring Technical Support
on 0181-371 1010 and ask for a 'Key' with which to extend the life of the Evaluation version.



Updating the list of newsgroups
New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks up 
articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, you 
can ask Turnpike to pick up a complete new list through the Configure Usenet News dialog in Turnpike 
Connect. This is particularly useful if you change the News server you use (eg. because you change 
Access provider) because not all News servers carry the same range of newsgroups.

For details of the steps to use, see 'Picking up a fresh newsgroup list' in the Connect book.



Upgrading to the latest version
If you have purchased a full copy of Turnpike you can upgrade to the latest version by downloading the 
appropriate file from:

ftp://ftp.demon.co.uk/pub/mirrors/turnpike/

View the !readme in this directory to see which file you need to fetch. In general, the latest version is 
identified as

nnissuex.exe

where nn is 16 (for Win3x and NT3.51) or 32 (for Win95 and NT4.0). An x indicates that the file that does 
not include a WWW browser.

Note: these files can only be used to upgrade a full copy of Turnpike. They cannot be used to upgrade an
Evaluation copy.

After you have downloaded the file, simply run it to install the upgrade - the installer will guide you through
the rest of the process. All your mailboxes, newsstands and other special settings that you have built up 
using the earlier version of the program will be automatically transferred to the new version.

Note: If you want to check which version of Turnpike you are currently using, take the 'About Turnpike' 
option from the Help menu.



'Usage of email name' dialog

This dialog is principally used to define a name you want to use as an additional email name (assuming 
you have the appropriate permission to do this). On a shared system, it is also used to specify which 
other users and/or workgroups can use this name.

It is displayed by clicking the Create or the Edit button within the Email names dialog.

The crucial parts of this dialog are:
* The Name slot - in which you type the Email name you are defining
* The Currently allow list - which records the users and workgroups who are allowed to use this email 
name

The 'Currently allow' list is set up by using the Add and Del buttons between the two lists to take names 
from the left-hand list, which is switched between lists of users and lists of workgroups by clicking the 
Individuals and Workgroups buttons above the list.



Useful newsgroups for new users
Your copy of Turnpike may be set up to automatically subscribe to a few newsgroups which are either 
useful to users of your particular Access provider or useful for new users to study - for example, a 
newsgroup like news.announce.newusers that typically contains a number of articles answering 
frequently asked questions (FAQs).

If you don't want to follow these, simply remove them both from the newsstand and (if you have News 
Admin permission) from the overall list of newsgroup subscriptions in the Newsgroup Subscriptions 
dialog.



User Information

The way you appear to the recipient of one of your messages is set by such things as the signature you 
use, the email name you quote in your address, the email address to which replies should be sent and the
organization you are seen to represent.

As you will probably want to present yourself differently in different types of message, Turnpike lets you 
record for each mailbox and newsstand the details of the signature, email name etc. that you want given 
in the messages / articles that you post.

To set this User Information, select the mailbox / newsstand, then 
either take the appropriate Alter mailbox / Alter newsstand option from the File menu
or click the right mouse button on the mailbox / newsstand and select Properties

and then set the details you require on the User Info page of the dialog that is displayed.

Click here for further information about this dialog
or press F1 to call up this Help file when you have the dialog on the screen.

Note: Any special email name or signature that you want to use must already be recorded for your 
system. You can't set up new names / signatures from within the Mailbox /Newsstand dialog.



Using Turnpike Help

Help on Turnpike can be called up in different ways:
* By clicking on a Help button included in the current display.
* By pressing the F1 key.
* By pressing Shift F1 and then clicking on the part of the screen you want information on

To see further information:

If you want further information about something that is underlined on the current Help page, either:
* Click on the underlined item, or
* Press the Tab key until the required item is highlighted and then press Enter.

To see information about any other aspect of the program, either click on the Contents button at the top of
the Help window and then click on the required entry in the Contents - or click on the Search button to 
search for Help on a particular topic.

To return to information you called up earlier:

To go back to the last page of information you were looking at, click on the Back button at the top of the 
Help window.

To go back to an earlier screen, select the History option offered at the top of the screen (in the Options 
menu in Windows 95) and then double-click on the required screen in the list that is displayed.

For a complete description of these features, either press F1 or select 'How to Use Help' from the 
Help menu in this window.

Note: This Help display can be moved, re-sized, closed etc. in the same way as any other window. 



Waste basket
Any mail messages that you delete are put into the Waste Basket on your Turnpike desktop (the icon for 
which then changes to show that there's something in it).

The messages themselves aren't actually deleted until you leave Turnpike - or until you open the Waste 
Basket and click the Empty button that's shown. If the mail you've deleted is mirrored from a POP3 
mailbox, the messages aren't normally even deleted then: such messages are generally only deleted the 
next time mail is collected from this mailbox. (You do, however, get the option of deleting these messages
from Turnpike to let you get rid of messages mirrored from POP mailboxes you have given up using.)

Up to the point the messages are actually deleted, any message you throw away by mistake can be 
recovered by openning the Waste basket on the screen and dragging the message to either a mailbox, 
the Mailroom view or some other mail list.

A quick way to empty the Waste basket is to right-click on it and then choose Empty.



Window menu

Cascade
Tile horizontal
Tile vertical
Arrange icons
Line up icons
Minimize all

List of windows



Window menu: Arrange icons
Arranges the icons used for any minimised Turnpike windows neatly along the bottom of the display.



Window menu: Cascade
Arranges the open Turnpike windows in a cascade one on top of the other, starting from the top left-hand 
corner of the main Turnpike screen area.

See also: Tile horizontal and Tile vertical



Window menu: Line up icons
Aligns the icons used for any minimised Turnpike Windows to a grid defined by your Windows System's 
Icon spacing.

Refer to your Windows documentation for information on setting this Icon spacing.



Window menu: List of windows
Lets you select and display the different Turnpike windows currently either open on the screen or shown 
minimised.



Window menu: Minimize All
Minimises all the windows currently open on your Turnpike display.



Window menu: Tile horizontal
Arranges the open Turnpike windows one above the next down the Turnpike screen area.

See also: Tile vertical and Cascade



Window menu: Tile vertical
Arranges the open Turnpike windows side-by-side across the Turnpike screen area.

See also: Tile horizontal and Cascade



Windows error

Consult your Windows documentation.



Workgroups
*** Only relevant on shared systems **

A workgroup is a group of users on a shared system any one of which can reply to, file etc. mail that 
arrives for this workgroup. They are particularly useful within a company where you could have different 
workgroups to handle such things as Sales enquiries or Customer Support enquiries.

When a piece of mail arrives for a workgroup, it appears in the In-tray of every member of the group but 
the moment any member reads it, it then becomes theirs to deal with and disappears from other 
members' In-trays.

Click here for information on setting up workgroups.






